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Бесплатные системы  

сквозного проектирования электроники 

Валентин Володин 

valvolodin@narod.ru 

 

Прошли уже те времена, когда для разработки топологии печатной платы конструктор 

вооружался листом бумаги, остро заточенным карандашом, резинкой и включал своё 

пространственное воображение. Дело это было сложным, утомительным и малопроизводи-

тельным. Не случайно, практически с момента создания, делались попытки приспособле-

ния компьютеров для решения конструкторских задач. В результате было создано 

множество Систем Автоматизированного Проектирования (САПР) или CAD (англ. Computer 

-Aided Design), ориентированных на решение различных задач  проектирования и 

конструирования. САПР, используемые для автоматизации проектирования электроники, 

зачастую сокращенно обозначают аббревиатурой EDA (EDA - Electronics Design Automa-

tion). Обычно система сквозного проектирования EDA включает в себя  редактор электри-

ческих схем и редактор печатных плат. В последнее время подобные системы всё чаще 

включают средства моделирования электрических схем, позволяющие исследовать работу 

электронного устройства ещё до того, как оно будет воплощено в "железе". 

Что касается электроники, то ещё в 80-х годах прошлого столетия, тогда ещё совет-

ским конструкторам, стала доступна прекрасная коммерческая САПР PCAD.   Данная САПР 

была настолько удачной, что на долгие годы стала своеобразным отраслевым стандартом. 

Несмотря на появление новых поколений САПР и операционных систем, "досовский" PCAD 

версий 4 ... 8.7 до сих пор активно используется во многих КБ. Это объясняется не только 

положительными качествами "досовского" PCAD-а, но и тем, что под него за долгие годы 

использования, был наработан большой объём документации, библиотек, а также оптими-

зирован процесс конструирования и производства. Для не обременённых подобным бага-

жом конструкторов на рынке предлагается огромное количество САПР, список которых 

постоянно пополняется. Современные САПР ещё в большей степени автоматизируют труд 

конструктора, позволяют совместную работу многих конструкторов, что гарантирует более 

качественные результаты за более короткий промежуток времени.  

Благодаря всё большему проникновению компьютеров в непрофессиональные сферы, 

а также использованию их для обучения, последние стали доступны большому количеству 

непрофессиональных конструкторов и студентов. Под непрофессиональными конструкто-

рами, в данном контексте, подразумеваются те, кто только эпизодически занимаются 

конструированием в связи со своей профессиональной деятельностью или хобби.  

Обычно непрофессионалы пытаются использовать те же самые САПР, что и профес-

сионалы. Но, не имея особого финансового дохода от своей деятельности, они не могут 

позволить себе честно купить дорогущую профессиональную САПР (обычно, стоимость 

профессиональных и поэтому коммерческих САПР редко опускается ниже 2000$ USA) и 

используют различные взломанные версии САПР, которые находятся в интернете. 

Понятно, что в этом случае приходиться мириться с неустойчивой работой такого програм-

много обеспечения, отсутствием технической поддержки, а также возможностью зараже-

ния компьютера вирусами. Кроме всего перечисленного, такое использование является 

попросту незаконным!   
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Не замыкаясь на моральном аспекте бесплатного использования коммерческого 

программного обеспечения, обратим внимание непрофессионалов на тот факт, что в том 

же интернете можно найти множество абсолютно бесплатных САПР, которым вполне под 

силу решить все проблемы непрофессионального разработчика. Немаловажно то, что 

бесплатные САПР обычно позволяют более быстрое освоение и меньший уровень профес-

сиональных знаний пользователя. Например, объём документации на основные коммер-

ческие САПР достигает тысяч страниц, в то время как полное описание многих бесплатных 

САПР может вполне уместиться в нескольких журнальных публикациях. Если Вы не зани-

маетесь конструированием постоянно, то лучше при случае пролистать несколько стра-

ниц, чем каждый раз штудировать толстенное руководство! 

Многое из вышесказанного касается и профессиональных разработчиков небольших 

развивающихся фирм, несущих на этапе становления большие издержки и поэтому также 

не имеющих возможности приобретения коммерческого программного обеспечения.  

 

 Сделаем небольшой обзор бесплатных программ, предназначенных для конструиро-

вания печатных плат.   В интернете присутствует, в основном, два типа подобных 

программ. С одной стороны, подобные программы создают различные компании, связан-

ные с производством печатных плат или продажей комплектующих, а с другой, - разра-

боткой подобных программ заняты любители или коллективы любителей.  

К разряду первых относится достаточно известные в любительской среде  программы 

Express PCB [http://www.expresspcb.com/], Pad2Pad [http://www.pad2pad.com/] и PCB 

Artist [http://www.4pcb.com/free-pcb-layout-software/index.html]. Как и многие программы 

подобного класса, Express PCB, Pad2Pad и PCB Artist созданы для продвижения услуг 

своих компаний и поэтому имеют разумные ограничения, заключающиеся в том, что на 

выходе мы получаем проект в некотором закрытом формате, который мы можем отправить 

только конкретному производителю печатных плат. И это не есть хорошо. Правда, 

отечественные любители редко в частном порядке заказывают на стороне печатные 

платы. Обычно подобные рисуются по старинке от руки или используют лазерно-утюжную 

технологию. А так как Express PCB, Pad2Pad и PCB Artist способны выводить результаты на 

печать, то порой этого уже достаточно для кустарного изготовления платы.  

 

Немного в стороне от вышеперечисленных программ стоит, появившаяся сравни-

тельно недавно, EDA  DesignSpark PCB. Программный пакет DesignSpark PCB

[http://www.designspark.com/] появился в июле 2010 года и был разработан компанией RS 

Components, штаб-квартира которой расположена в городе Корби (Великобритания). 

Данный программный пакет является абсолютно бесплатным. Для активизации программы 

требуется лишь несложная и бесплатная регистрация на сайте компании. При этом 

DesignSpark PCB не содержит никаких ограничений ни по количеству элементов схемы, ни 

по времени использования. В отличие от вышеперечисленных программ,  DesignSpark PCB 

не пытается привязать пользователей к конкретному производителю и генерирует 

выходные файлы в популярных производственных форматах Gerber, DXF, Excellon, IDF, 

LPKF. Эта программа выполнена на очень хорошем профессиональном уровне и включает 

в себя все необходимые компоненты, такие как схемный редактор и редактор печатных 

плат. В схемном редакторе, пользователь может легко рисовать схемы и связи. При этом, 

схема может содержать множество листов, связанных между собой в полный проект. 

Последний имеет функции автокомпоновки и автотрассировки. На данный момент 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

Бесплатные системы сквозного проектирования электроники 

http://www.expresspcb.com
http://www.pad2pad.com
http://www.4pcb.com/free-pcb-layout-software/index.html
http://www.designspark.com


существует большое интернет-сообщество пользователей этой программы, где каждый 

может найти поддержку по интересующим его вопросам. В DesignSpark PCB осуществлена 

поддержка популярных симуляторов, таких как LTSpice, LSSpice, TopSpice и TINA. 

Пользователи имеют возможность импортировать свои проекты из этих программ для 

создания печатных плат. Интерфейс программы включает в себя специализированный 

калькулятор, который позволяет рассчитывать ширину и сопротивление дорожек, 

оптимальную плотность тока и повышение температуры дорожки, а также сопротивления 

переходных отверстий. 

 

 

 

Рис. 1. Вид экрана программы DesignSpark PCB 
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Из числа бесплатных любительских программ наиболее известны gEDA, KiCad и 

FreePCB. Все эти программы на выходе выдают стандартный пакет документации, 

достаточный для заказа печатной платы у стороннего производителя.  

 

 

 

Рис. 2. Вид экрана программы  gEDA 

 

gEDA [http://www.gpleda.org/] распространяется по лицензии GNU GPL, но является 

достаточно мощным пакетом класса EDA с открытыми исходными текстами, предназначен-

ный для разработки электрических схем и печатных плат. Проект gEDA основал Алеш 

Гвезда (Ales Hvezda) в связи с отсутствием на тот момент такого программного 

обеспечения для ОС Linux/UNIX. В полном объёме gEDA работает под Linux, но некоторые 

программы, входящие в состав пакета, в настоящее время портированы под Windows. В 

настоящее время проект gEDA предлагает развитый комплект свободного программного 

обеспечения для проектирования электроники, включающий программы для схемотехни-

ческого проектирования, управления атрибутами, создания перечней элементов (BOM) и 

списков соединений в более чем двадцати форматах, аналогового и цифрового моделиро-

вания и проектирования топологии печатных плат. Программные средства, входящие в 

комплект, позволяют разрабатывать проекты профессионального качества низкой и 

средней степени сложности. Используя программы gEDA можно создавать печатные 

платы, имеющие до 8 слоёв (а скоро и больше), с неограниченным числом компонентов и 

соединений. Программы подходят для студентов, педагогов, любителей, консультантов, 

представителей малого бизнеса и даже больших корпораций. 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

Бесплатные системы сквозного проектирования электроники 

http://www.gpleda.org


 

 

Рис. 3. Вид экрана программы  KiCad 

 

KiCad [http://www.kicad-pcb.org/display/KICAD/KiCad+EDA+Software+Suite] распространяется по 

лицензии GNU GPL, но является достаточно мощным пакетом класса EDA с открытыми 

исходными текстами, предназначенный для разработки электрических схем и печатных 

плат. Основным разработчиком программы является Жан-Пьер Шарра (фр. Jean-Pierre 

Charras). Существуют версии  KiCad, рассчитанные для работы под управлением 

операционных систем GNU/Linux, Windows NT 5.x, FreeBSD и Solaris. Благодаря множеству 

своих приверженцев, KiCad регулярно развивается и скорей всего в ближайшее время 

превратится в вполне приличную EDA систему.  

Эта система хорошо документирована и имеет регулярно обновляемую страничку 

поддержки [http://kicad.sourceforge.net/wiki/index.php/RU:Main_Page].  

KiCad состоит из схемного редактора Eeschema, редактора печатных плат Pcbnew и 

Gerber просмотровщика Gerbview. Приятной неожиданностью является то, что в опциях 

программы предусмотрен русский язык, а так же имеется помощь на русском языке. 

Схемный редактор обеспечивает создание однолистовых и иерархических схем, контроль 

электрических правил (ERC), создание списка цепей (netlist) для pcbnew или Spice. 

Редактор печатных плат обеспечивает разработку плат, содержащих от 1 до 16 слоёв 

меди и до 12 технических слоев (шелкография, паяльная маска и т. п.), генерацию 

технологических файлов для изготовления печатных плат (Gerber-файлы для фотоплот-

теров, файлы сверловок и файлы размещения компонентов), печать слоёв в формате 

PostScript. Gerber просмотровщик позволяет просматривать Gerber-файлы. 
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Рис. 4. Вид экрана программы  FreePCB 

 

FreePCB [http://www.freepcb.com/] также  распространяется по лицензии GNU GPL. 

Заслуга создания программы FreePCB принадлежит одному человеку по имени Алан Райт 

(Allan Wright), который проживает в США. FreePCB, по существу, является только 

редактором плат. Однако существует возможность импорта списка цепей в формате PADS-

РСВ из любого стороннего схемного редактора. В качестве такового обычно используется 

редактор схем TinyCAD. Кроме этого, возможна прямая трансляция списка соединений из 

симулятора LTspice [http://www.linear.com/designtools/software/#LTspice]. FreePCB пока не 

имеет возможности вывода на печать, но для этой цели можно использовать любой бес-

платный Gerber просмотровщик, например ViewMate [http://www.pentalogix.com/viewmate.php] 

от PentaLogix (ранее Lavenir). Кроме этого, последняя версия программы позволяет 

экспорт топологии печатной платы в графические файлы PNG, которые можно 

просмотреть и распечатать в любом графическом редакторе (например, в Paint). Как ни 

странно, но узкая специализация программы идёт ей только на пользу, т.к. позволяет 

значительно сократить время освоения.  

FreePCB поддерживает до 16 слоев, позволяет работать как с дюймовыми, так и 

метрическими единицами измерения. Размер печатной платы может достигать 

1524x1524мм. FreePCB генерирует выходные  файлы в расширенном Gerber формате 

RS274X и файлы сверловки в формате Excellon. Эти стандартные CAM (Computer-aided 

manufacturing - автоматизированная система технологической подготовки производства) 

файлы являются необходимой и достаточной документацией для заказа печатных плат у 
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стороннего производителя. Программа регулярно обновляется, имеет обширную 

библиотеку корпусов, а так же хорошо документирована. По своему внешнему виду и 

стилю слегка напоминает старый добрый PCAD.   

 

На базе FreePCB можно создать связку  TinyCad + LTspice + FreePCB + ViewMate, 

которая представляет из себя бесплатную, но достаточно мощную систему сквозного 

проектирования электроники для непрофессионала. Несмотря на свою бесплатность, 

данная система сквозного проектирования может дать фору многим коммерческим EDA 

системам. Предложенную связку можно дополнить бесплатным он-лайн автотрассиров-

щиком FreeRouter [http://www.freerouting.net/] для связи с которым FreePCB имеет 

интерфейс, позволяющий двухсторонний импорт/экспорт файлов.  

Возможно, подобное строительство собственной системы EDA из готовых компонентов 

для многих окажется более привлекательным, нежели использование уже кем-то 

собранного пакета программ. В этом случае есть некоторая свобода предпочтений. 

 

И в заключении хочется сказать несколько слов о прекрасном редакторе схем 

TinyCAD. TinyCAD [http://sourceforge.net/apps/mediawiki/tinycad/index.php?title=TinyCAD] 

распространяется по лицензии GNU GPL и был разработан в 1994 году американским 

программистом Мэттом Пайном (Matt Pyne). В настоящее время эта программа работает в 

среде ОС Windows и предназначена для рисования и редактирования  иерархических 

электронных схем различной степени сложности. Помимо этого, программа позволяет 

добавлять в схему различные объекты аннотации: текст, линии, прямоугольники, эллипсы 

и дуги.  

TinyCAD имеет полный набор функций для проверки правил проектирования, перечня 

компонентов, генерации различных форматов списков соединений, совместимых со 

многими популярными программами разработки печатных плат, такими как FreePCB, 

KiCAD, Eagle SCR, ProteI, gEDA PCB и т.п. Совместно с программой поставляется более 40 

готовых библиотек символов. Кроме этого, TinyCAD имеет встроенный редактор 

библиотек, что облегчает добавление новых символов и редактирование старых. 

Предусмотрена функция копирования и вставки проекта прямо из TinyCAD в документы 

OpenOffice или Microsoft Office. 
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Рис. 5. Вид экрана программы  TinyCAD 
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Валентин  Володин:  моделирование силовой электроники 

Сейчас трудно назвать точную дату возникновения электроники как науки. Ещё в 1873 году 

британский учёный Фредерик Гутри открыл принцип действия электровакуумного выпрямителя. А 

через год, в 1874 году, германский учёный Карл Фердинанд Браун открыл принцип действия 

кристаллического (полупроводникового) выпрямителя. Свой выпрямитель на кристалле Карл 

Фердинанд Браун запатентовал в 1899 году. Принцип действия электровакуумного выпрямителя 

был повторно открыт предприимчивым американским изобретателем Томасом Эдисоном в 1880 

году. Эдисон, пытаясь увеличить срок службы своих ламп накаливания, ввёл в баллон лампы, из 

которого был откачан воздух, металлический электрод. Между этим электродом и нитью 

накаливания лампы подключалась цепочка, состоящая из гальванометра и электрической 

батареи. Когда плюс батареи подключался к металлическому электроду, гальванометр показывал 

небольшой ток. При смене полярности батареи ток прекращался, и стрелка гальванометра не 

откланялась. Т.е., по сути, эта лампа с дополнительным металлическим электродом была 

активным электронным прибором – выпрямителем. В 1883 году Эдисон запатентовал своё 

изобретение, но долгое время выпрямитель не находил своего применения. Только в 1904 году 

Джон Флемминг получил в Англии, а затем в США (1905 год) патент на использование 

выпрямителя для преобразования переменного тока в постоянный.  

Своё настоящее название диод получил только в 1919 году, когда его ввёл в оборот Вильям 

Генри Иклс. Слово диод было образовано из двух греческих корней  “di” — два и “odos” — путь, 

что, по сути, означает двухвыводной или двухэлектродный прибор. 

В 1906 году американец Ли де Форест ввёл в диод третий электрод – управляющую сетку, и 

таким образом создал триод. Триод уже был способен к обратному преобразованию постоянного 

тока в переменный. Инженеры за долгие годы на столько привыкли к названию этого 

электронного прибора, что даже первые транзисторы некоторое время назывались 

полупроводниковыми триодами. 

В 1908 году был изобретён ртутный выпрямитель (вентиль), который являлся первым 

газоразрядным  прибором. В 1928-1929 г.г. появился газотрон, а в 1931 году - тиратрон. 

Вплоть до 60-х годов 20-го века доминировали электровакуумные и газоразрядные 

электронные приборы использующие эффект электронной проводимости в вакууме и смешанной 

проводимости (электронной и ионной) в среде разреженных газов. Собственного использование 

электронного эффекта проводимости и дало название всему научному направлению – 

электроника. 

С появлением мощных электровакуумных и газоразрядных электронных приборов, электро-

ника нашла широкое применение в промышленности, где использовалась в целях повышения 

эффективности выработки и передачи электрической энергии, управления электроприводом, 

плавки и закалки металлов и т.п. Это дало начало новому направлению - силовой электронике, 

которую зачастую называют промышленной электроникой. Позже, в 60-70-х годах 20-го века, 

электровакуумные и газоразрядные приборы были практически повсеместно вытеснены более 

дешёвыми и эффективными полупроводниковыми электронными приборами.    

В настоящее время область применения силовой электроники значительно расширилась, и 

она прочно вошла в наш быт в виде мощных стабилизаторов напряжения, источников 

бесперебойного питания, инверторных сварочных источников, а также в составе бытовой техники 

и автоматики. Мощные полупроводниковые электронные приборы стали доступнее, а их цена 

значительно снизилась. Это обстоятельство в значительной мере подстегнуло интерес 

самодеятельных конструкторов к силовой электронике.   
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Авторский сайт Силовой Электроники

http://valvolodin.narod.ru изначально созда-

вался как информационный ресурс по схемо-

технике, а также технологии изготовления, 

наладки и ремонта источников сварочного тока. 

Однако за время его существования, стараниями 

автора и посетителей, сайт разросся и теперь 

его тематика охватывает не только вопросы, 

связанные с разработкой и постройкой 

сварочных источников, но и практически все 

аспекты силовой электроники. 

На сайте есть форум  http://valvol.ru ,  

на котором в реальном масштабе времени люби-

тели и профессионалы от силовой электроники 

обсуждают различные вопросы, связанные с 

проектированием и изготовлением устройств 

силовой электроники, обсуждают события в этой 

области, патенты, периодику, информацию с 

других форумов, выдвигают собственные идеи, 

проверяют их на практике путём проведения 

лабораторных испытаний или путём изготов-

ления реально работающих устройств. 

За время своего существования, эти сайт и форум создавали благоприятную среду общения 

между специалистами-электронщиками, что, безусловно, способствовало их профессиональному 

росту и информированности. 

Конструирование, изготовление и наладка устройств силовой электроники имеет свои 

специфические особенности. Например, авария источника питания и выход из строя его 

элементов происходит за тысячные, а порой и миллионные доли секунды, что практически не 

даёт шанса рассмотреть её причины и последовательность. В этом случае многих проблем можно 

избежать, если предварительно моделировать работу схемы источника. Моделирование позволяет 

проверять работу элементов источника питания в критических режимах, производить замеры, 

которые обычно проблематичны или даже не возможны на реальном устройстве. Моделирование 

позволяет уточнять и оптимизировать результаты предварительных расчётов, а порой 

экспериментально подбирать параметры элементов и режимы работы схемы. Все выше 

перечисленные и не перечисленные соображение делают моделирование кровно необходимым 

этапом конструирования устройств силовой электроники. 

В настоящее время любителю и профессионалу доступно большое количество программ для 

персонального компьютера, позволяющих производить моделирование работы электронных схем. 

Зачастую эти программы  используют различные базовые математические алгоритмы,  что даёт 

им определённые преимущества при моделировании определённого типа электронных устройств. 

Наибольшей популярностью пользуются программы, использующие SPICE (Simulation Program 

with Integrated Circuit Emphasis) алгоритм моделирования процессов протекающих в  электронных 

схемах. Алгоритм SPICE, разработанный в конце 70-х годов в университете Беркли (Калифорния), 

де-факто стал стандартом для разрабатываемых и уже эксплуатируемых в настоящее время 
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коммерческих систем схемотехнического моделирования для персонального компьютера. К таким 

системам относятся:  

• HSPICE (фирма “MetaSoftware”); 

• PSpice (“Microsim”); 

• MicroCap (“Spectrum Software”): 

• Circuit Maker (“The Virtual Elektronics Lab”); 

• Dr. Spice; 

• ViewSpice (“Deutsch Research”) и другие.  

Кроме этого, коллективами энтузиастов, а также компаниями производителями электронных 

комплектующих, с целью продвижения собственной продукции, были созданы различные 

бесплатные SPICE симуляторы, которые зачастую практически ни чем не уступают своим 

коммерческим собратьям. Особенно популярность в последнее время завоевали симуляторы 

LTspice, Tina-TI, Quic и т.п.. Однако, симулятор LTspice от корпорации Linear Technology, пожалуй, 

имеет наибольшую популярность среди любителей и профессионалов.  

Симулятор LTspice IV можно бесплатно скачать с сайта корпорации Linear Technology 

http://www.linear.com/designtools/software/#LTspice. Программа может работать под управлением 

ОС: 

• Windows 98;  

• Windows 2000; 

• Windows NT4.0; 

• Windows Me; 

• Windows XP; 

• Windows 7; 

• Windows 8; 

• Linux RedHat 8.0 с WINE версии 20030219.  

Несмотря на свою бесплатность программа является настоящим и полноценным SPICE-

симулятором, позволяет моделировать аналогово-цифровые схемы, имеет дружественный 

интерфейс и обеспечивает вполне приличную скорость моделирования. Кроме этого имеется 

отличный (правда англоязычный) встроенный Help http://www.linear.com/software/scad3.pdf, 

который является прекрасным и лучшим руководством. В интернете существует достаточно много 

ресурсов, где обсуждается и поддерживается эта прекрасная программа: 

http://tech.groups.yahoo.com/group/LTspice/, http://valvol.ru/topic36.html. 

Программа «заточена» для анализа процессов, происходящих в импульсных источниках 

питания. Однако, благодаря своим особенностям, программа снискала большую популярность и 

среди аудиофилов. При наличии подключения к Интернету программа регулярно обновляется. 

Программа достаточно универсальна и позволяет создавать новые библиотечные элементы, 

редактировать схемные решения, производить моделирование и просматривать его результаты. В 

программе имеется встроенная библиотека моделей большинства микросхем DC/DC 

преобразователей, выпускаемых корпорацией Linear Technology. Однако библиотека моделей 

может пополняться самостоятельно собственными моделями и моделями от производителей 

электронных компонентов. Во многом эта работа уже проделана фанатами LTspice. Например, 

основной набор моделей можно найти на домашней страничке Андрея Кадатч 

http://forest2.homeip.net/Electronics/extra.rar или http://valvolodin.narod.ru/soft/extra.rar, где надо 

скачать архив EXTRA. В архиве находятся библиотека моделей транзисторов, диодов, тиристоров, 

симисторов и т.д. от ведущих мировых производителей. Там же находится подробная инструкция 

по установке этой библиотеки.   
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Краткое руководство по симулятору LTspice было опубликовано в книгах                

В.Я. Володина:  

1. Современные сварочные аппараты своими руками. Санкт-Петербург: Издательство Наука и 

Техника, 2008 год. 

2. LTspice: компьютерное моделирование электронных схем. Санкт-Петербург: Издательство БХВ-

Петербург, 2010 год. 

3. Создаем современные сварочные аппараты. Москва: Издательство ДМК пресс, 2011 год. 

 

                      
 

Конкретные примеры использования симулятора LTspice были опубликованы          

в статьях В.Я. Володина:  

1. Моделирование сложных электромагнитных компонентов при помощи SPICE-симулятора 

LTspice/SwCAD III. Журнал Компоненты и Технологии №4 за 2008 год. 

2. Способ контроля одностороннего подмагничивания трансформатора преобразователя 

напряжения. Журнал Силовая электроника №2 за 2009 год. 

3. Пополнение библиотеки схемных элементов симулятора LTspice. Создание модели ШИМ-

контроллера TL494. Журнал Компоненты и технологии №4 за 2009 год. 

4. Гистерезисная модель нелинейной индуктивности симулятора LTspice. Журнал Силовая 

электроника №1 за 2010 год. 

5. Моделирование индуктивностей с порошковыми сердечниками при помощи симулятора LTspice. 

Журнал Силовая электроника №2 за 2010 год. 

6. Создание моделей электромагнитных компонентов по результатам эксперимента. Журнал 

Силовая электроника №3 за 2011 год. 

7. Расчёт нерассеивающего демпфера DC/AC-преобразователя. Журнал Силовая электроника №4 

за 2011 год. 
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FreePCB – áåñïëàòíàÿ ïðîãðàììà
äëÿ ïðîôåññèîíàëüíîé ðàçðàáîòêè
ïå÷àòíûõ ïëàò

! Çàëèâêà ïîëèãîíîâ.FreePCB – áåñïëàòíàÿ ïðîãðàììà ñ îòêðû-
!òûì èñõîäíûì êîäîì, ïðåäíàçíà÷åííàÿ äëÿ Ðåäàêòîð è Ìàñòåð äëÿ ñîçäàíèÿ è ìîäè-

ðåäàêòèðîâàíèÿ ïå÷àòíûõ ïëàò. Ïðè ñîçäàíèè ôèêàöèè ïîñàäî÷íûõ ìåñò êîìïîíåíòîâ
ïðîãðàììû ñòàâèëàñü çàäà÷à ñäåëàòü åå ìàê-

!Èìïîðò ñïèñêà ñîåäèíåíèé èç ñèìóëÿòî-
ñèìàëüíî ïðîñòîé â èçó÷åíèè è èñïîëüçîâà-

ðà LTspiceíèè, íî ñïîñîáíîé îáåñïå÷èòü ïðîôåññèî-
íàëüíîå êà÷åñòâî ðàçðàáîòêè. Ñàìà 
FreePCB ðàññ÷èòàíà òîëüêî íà ðó÷-
íóþ ðàçâîäêó ïëàò, îäíàêî ïîçâîëÿåò 
èñïîëüçîâàòü äîñòóïíûé â ñåòè 
àâòîòðàññèðîâùèê FreeRouting.

Âîò íåêîòîðûå îñîáåííîñòè ïðî-
ãðàììû:

!Îïåðàöèîííàÿ ñðåäà – Microsoft 
Windows.

!Ïîääåðæêà îò 1 äî 16 ñëîåâ

!Ìàêñèìàëüíûé ðàçìåð ïå÷àò-
íûé ïëàòû 1524´1524 ìì.

!Â áîëüøèíñòâå ôóíêöèé äîïóñ-
òèìî èñïîëüçîâàíèå êàê äþéìî-
âûõ, òàê è ìåòðè÷åñêèõ åäèíèö 
èçìåðåíèÿ (mils èëè ìì).

!Áèáëèîòåêè êîðïóñîâ, ëþáåçíî 
ïðåäîñòàâëÿåìûå êîìïàíèÿìè 
Design International, PCB Matrix è 
IPC.

Ñêðèíøîò íåáîëüøîé ïå÷àòíîé ïëàòû, ñîçäàííîé â ñðåäå 
FreePCB
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!Èìïîðò/ýêñïîðò ñïèñêîâ öåïåé â PADS- Áûâàåò, åñëè ðóêè âñåãî äâå. Âåñü ïðîåêò 
PCB. FreePCB, ñ ìîìåíòà åãî çàðîæäåíèÿ äî íàñòî-

ÿùåãî âðåìåíè, äåðæèòñÿ íà òàëàíòå è ýíòóçè-!Ýêñïîðò ôàéëîâ òîïîëîãèè â ðàñøèðåí-
àçìå îäíîãî åäèíñòâåííîãî ÷åëîâåêà ïî èìåíè íûé ôîðìàò Gerber (RS274X) è ôàéëîâ 
Àëàí Ðàéò (Allan Wright), ñïèñîê óâëå÷åíèé ñâåðëåíèÿ â ôîðìàò Excellon.
êîòîðîãî, ê òîìó æå, íå èñ÷åðïûâàåòñÿ ðàçðà-

!Ïðîâåðêà ñîáëþäåíèÿ ïðîåêòíûõ íîðì.
áîòêîé ÑÀÏÐ ïå÷àòíûõ ïëàò.

!Àâòîñîõðàíåíèå.

Ïåðâàÿ «æèâàÿ» âåðñèÿ ïðîãðàììû ïîä 
íîìåðîì 1.001 áûëà âûïóùåíà â ìàðòå 2005 ã., 
íî ïî íàñòîÿùåìó ðàáîòîñïîñîáíîé ñ÷èòàåòñÿ 
âåðñèÿ 1.2, ïîÿâèâøàÿñÿ ïÿòü ìåñÿöåâ ñïóñòÿ. 
Ïîñëåäíèå îáíîâëåíèå òåêóùåé âåðñèè 1.359 
äàòèðîâàíî äåêàáðåì 2011 ã.

FreePCB èçâåñòíà ó íàñ äîñòàòî÷íî õîðî-
øî, âî âñÿêîì ñëó÷àå, ìíîãèå â Ðîññèè íàñëû-
øàíû îá ýòîé ïðîãðàììå, âîêðóã êîòîðîé äàæå 
îáðàçîâàëîñü îïðåäåëåííîå ñîîáùåñòâî 
ïîëüçîâàòåëåé. Íî íè â êàêîå ñðàâíåíèå íå 
èäåò ïîïóëÿðíîñòü, êîòîðóþ FreePCB çàâîå-
âàëà çà ïðåäåëàìè íàøåé ñòðàíû, ïðåæäå 
âñåãî â ÑØÀ, ãäå îíà, ñîáñòâåííî, è ðîäèëàñü, 
è â Èíäèè.

Àëàí óâëåêàåòñÿ èçîáðåòåíèåì ýëåêòðî-
Â ïîääåðæêå è ðàçâèòèè FreePCB ó÷àñòâó-

ííûõ ñàìîäåëîê è ïåðåäàåò ñâîé îïûò ñûíó, 
åò ìíîæåñòâî ñàìûõ ðàçíûõ ëþäåé, îò øêîëü-
íèêîâ äî ñåäûõ âåòåðàíîâ ðàäèîëþáèò-
åëüñòâà. Îíè ïðèñûëàþò ñâîè çàìå÷àíèÿ, ðåêî-
ìåíäàöèè ïî óñòðàíåíèþ îøèáîê è ïðîãðàì-
ìíûå êîäû. Ïîñëåäíÿÿ âåðñèÿ ðóêîâîäñòâà 
ïîëüçîâàòåëÿ òàêæå íàïèñàíà ïîêëîííèêîì è 
ïîëüçîâàòåëåì FreePCB.

Âîçìîæíî, ïîñëåäíèé ôàêò ó êîãî-òî âûçî-
âåò íåäîóìåíèå. Êàê æå òàê? Ëþáîé íîâûé 
ïðîäóêò äîëæåí ñîïðîâîæäàòüñÿ íîâûì åãî 
îïèñàíèåì. Ïîëó÷àåòñÿ, ó ðàçðàáîò÷èêà íå 
õâàòàåò ñîáñòâåííûõ ðóê, ÷òîáû èñïðàâèòü 
äîêóìåíòàöèþ ïîñëå äîðàáîòêè ïðîãðàììû? 
Òàê æå íå äîëæíî áûòü, ïîäîáíîãî ïðîñòî íå 
áûâàåò.

Àëàí Ðàéò ñ ìàòåðüþ, æåíîé è ñûíîì â Âèêòî-
ðèè, ñòîëèöå Áðèòàíñêîé Êîëóìáèè (Êàíàäà)

Àëàí âîçëå ëûñîãî êàðòîííîãî ïèñàòåëÿ â Âåíå-
öèè (Èòàëèÿ)
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Àëàí î÷åíü ëþáèò ïóòåøåñòâîâàòü, è îáúå-
õàë ïîë ìèðà â êîìïàíèè ñåìüè èëè äðóçåé, íî 

íåîäíîêðàòíî ó÷àñòâîâàâøåìó â åæåãîäíîì 
ìåæäóíàðîäíîì òåõíîëîãè÷åñêîì êîíêóðñå 

êàòàòüñÿ íà ãîðíûõ ëûæàõ ïðåäïî÷èòàåò ñðåäè
êðàñèâåéøèõ ïåéçàæåé îçåðà Òàõî, ó ñåáÿ íà
ðîäèíå, â ÑØÀ.

Â 17 ëåò Àëàí ïîëó÷èë ëèöåíçèþ ïèëîòà,
îäíàêî ñåë çà øòóðâàë ëèøü ñïóñòÿ 25 ëåò, äëÿ
÷åãî åìó ïðèøëîñü ïðîéòè êóðñ ïîâûøåíèÿ
êâàëèôèêàöèè. Ïåðâûå ñàìîñòîÿòåëüíûå
ïîëåòû Àëàí ñîâåðøèë íà íåáîëüøîì ñòàðîì
ñàìîëåòå Citabria.

ñîçäàòåëåé ðîáîòîòåõíèêè FIRST Robotics. Íà 
îäíîì èç êîíêóðñîâ Àëàí ïîçíàêîìèëñÿ ñî 
Ñòèâåíîì Âîçíÿêîì, áûâøèì ïàðòíåðîì Ñòè-
âà Äæîáñà è ñîîñíîâàòåëåì Apple, â ëåãåíäàð-
íîì ãàðàæå êîòîðîãî áûëè ñîáðàíû èõ ïåðâûå 
êîìïüþòåðû.

Îçåðî Òàõî

Êàòàíèå ñ äðóãîì íà ãîðíûõ ëûæàõ âîçëå îçåðà 
Òàõî

Åäèíñòâåííûé íà÷àëüíèê Àëàíà Ðàéòà ïî èìåíè
Äóíêàí â ñâîåì ëþáèìîì áóìàæíîì ïàêåòå

Òåïåðü Àëàí ëåòàåò íà RV-4

Ïåðâûå ïîëåòû Àëàí ñîâåðøèë íà íåáîëüøîì
ñàìîëåòå Citabria

À íåäàâíî, â ñêëàä÷èíó ñ îòñòàâíûì ïèëî-
òîì ÂÂÑ ÑØÀ èç Ñèýòëà, Àëàí ïðèîáðåë êîì-
ïëåêò äëÿ ñàìîñòîÿòåëüíîé ïîñòðîéêè ñàìî-
ëåòà, è òåïåðü ïåðåñåë íà íîâåíüêèé RV-4.

ÐàäèîËîöìàí – ìàé 2012
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1. Введение 

FreePCB является бесплатной, с открытыми исходными кодами, программой редактора печатных плат (PCB) 
под Windows, которую я начал писать, потому что был недоволен имеющимися к настоящему времени бесплатными
или дешевыми PCB редакторами. Те, которые я пробовал, были либо непригодны по ограничениям выводов и слоёв, 
либо имели большое количество багов, либо были трудными в использовании. В конце концов, я решил, что любой
идиот может написать лучше и стал тем идиотом, который это сделал! 

Это руководство пользователя содержит главы описывающие процесс разработки PCB и интерфейс пользователя
программы FreePCB , а также учебник, который проводит пользователя через процесс создания PCB из схемы и файла
списка соединений (netlist). В процессе изложения описывается большая часть основных особенностей программы
FreePCB. 

FreePCB написана для Microsoft Windows, но может быть запущена под Linux, с использованием Wine, или на
компьютерах Macintosh, с использованием VirtualPC. Исходный код охраняется авторским правом, но выпущен под
открытое лицензионное соглашение GNU (версия 2 или более поздняя). Условия этого соглашения можно посмотреть

здесь  http://ru.wikipedia.org/wiki/GNU_General_Public_License
Если у Вас есть вопросы относительно FreePCB, пожалуйста, сначала просмотрите форум www.freepcb.com.  
Для тех кто хочет связаться со мной напрямую, мой адрес электронной почты allan@freepcb.com 
Благодарю за использование FreePCB. 

Примечание от переводчика:  

В данном руководстве описывается бесплатная программа FreePCB, которая позволяет проектировать
печатные платы. Благодаря своей простоте и высокой функциональности, FreePCB завоевала высокую
популярность в США, а также в Индии. Уже длительное время эта программа, установленная на домашнем
компьютере, помогает и мне разрабатывать печатные платы для различных электронных самоделок.  
К сожалению, эта прекрасная программа практически не известна русскоязычной аудитории и отсутствие

русской документации играет здесь не малую роль. Чтобы восполнить этот пробел, я решил перевести на русский
язык руководство этой программы, написанное её автором. Представляю на Ваш суд то, что у меня получилось. При
переводе данного руководства я не ставил своей целью получения некого литературного шедевра (каким впрочем не
является и сам оригинал). А руководствовался целью создания, на основе оригинала, сносно читаемого руководства, 
позволяющего быстро и в достаточно мере освоить программу FreePCB. 
Соответственно, при переводе руководства возникли некоторые сложности с переводом тех или иных терминов. 

С одной стороны эти термины как-бы требовалось привести в соответствие с ГОСТ-ами, а с другой стороны, в
среде профессиональных разработчиков уже давно прижились и используются англоязычные термины. Последнее
обстоятельство является реальным фактом, который нельзя не учитывать. Ведь, в конце концов, практически все
программы проектирования печатных плат имеют интерфейс на английском языке. И поэтому излишнее
"напирание" с альтернативной интерфейсу терминологией будет всего лишь усложнять понимание документации и
увеличивать уровень тавтологии.  
Для большей ясности, привожу таблицу связи некоторых терминов интерфейса программы и их синонимов в

переведённой документации: 

В интерфейсе Пояснение В переводе 

footprint Посадочное место, включающее контактные площадки и контур
корпуса компонента 

футпринт 

part Корпус компонента на печатной плате корпус 

pin Вывод штыревого или SMT компонента штыревой вывод или
вывод 

ratline Эластичная ("резиновая") связь между двумя точками одной цепи ratline (решил
оставить как есть) 

net Именованная электрическая цепь цепь 

vertex Точка излома линии (дорожки, контура платы, полигона и т.д.)  излом 

via Переходное отверстие переход или
переходное отверстие 

 
С уважением, 
Валентин Володин 

http://ru.wikipedia.org/wiki/GNU_General_Public_License
www.freepcb.com


FreePCB.  Руководство пользователя 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

2. История изменений  

2.1 Что нового в версии 1.4 

Вот новые особенности, которые были добавлены в программу, начиная с версии 1.2: 
� Добавлены функции для импорта и экспорта файлов в\из WEB автотрассировщик FreeRoute. 
� Пунк меню Project > Options теперь позволяет переименовывать проект, изменить заданную по умолчанию

библиотечную папку, а также изменять число слоев. 
� Авто сохранение улучшено так, чтобы автоматически сохраненные файлы хранились в подпапке проектной папки. 

Возрастающие имена этих файлов генерируются автоматически. 
� Изменился формат Gerber с 2.6 на 2.4.  
� Добавлена функция группового копирования/вставки. Группу можно сохранить как проектный файл и проектный

файл можно вставить как группу в другой проект. 
� Теперь трассы могут иметь ветви.  
� Добавлена новая функция Tools > Check Traces, которая улучшает трассировку, комбинируя коллинеарные

сегменты и устраняет сегменты нулевой длины. 
� Трассировка из точек вне сетки улучшена, с тем чтобы "dogleg (излом соединительной линии)" сегменты

трассировки создавались по сетке в один шаг. 
� Ширина трасс и переходных отверстий может теперь изменяться независимо в Project > Nets. 
� Можно изменять позиционное обозначение компонента при помощи пункта меню Edit > Part . 
� Добавлена функция изменения слоя Change Layer для полигонов. 
� Редактирование полигонов улучшено. Вырезы в полигонах теперь могут содержать другие полигоны. 
� В редакторе футпринтов, при изменении параметров одного вывода, можно применять замену к другим выводам. 
� Gerber файлы теперь включают маски пасты. 
� Gerber файлы и файл сверловки теперь генерируются данными панели. 
� Плата теперь может содержать несколько контуров. 

2.2 Что нового в версии 1.2  
Вот новые особенности, которые были добавлены начиная с версии 1.0: 
� При прокладке ratline (связи), можно завершить трассу на любом выводе, трассировкой в вывод. Вы можете также

делать это с обрубленными трассами. 
� Пункт меню View > Show part... позволяет выбрать компонент в проекте через позиционное обозначение, а затем

центрируете окно на нём. 
� Футпринт теперь может содержать текст шелкографии. 
� Поддерживаются овальные, восьмиугольные и закруглённый квадратные контактные площадки. 
� Функциональная кнопка и меню списка слоёв теперь "кликабельны" 
� Расширены несколько меню клика правой кнопки мышки. 
� Футпринт может содержать SMT площадки на обоих сторонах платы. Эта характеристика добавлена главным

образом для краевых коннекторов. 
� Добавлены опции в пункте меню File > Import Netlist , позволяющие ручной выбор компонентов, футпринтов и

соединений, которые уже существуют в проекте. 
� Лист "последних файлов" теперь работает должным образом. 
� Можно обменивать соединение выводов, выбрав один вывод и, удерживая кнопку "s", выбрать другой вывод. 
� Можно создать контур в слоях маски пайки (для примера, устранять "дамбы" маски пайки между штифтами края

коннектора). 
� Добавлен инструмент Check connectivity (проверка соединений) в меню Tools. Также, возможен контроль правил

дизайна, сигнализирующий об ошибках соединений.  
� В полигоны могут быть добавлены вырезы.  
� Инструмент Move Origin , позволяющий перемещать начало координат, добавлен в меню Tools.  
� Всю трассу можно выделить, удерживая клавишу "t" и нажав на сегмент или излом. Всё соединение может быть

выделено, удерживанием клавиши "n" и нажатием на сегмент, излом или вывод. 
� Функция "Change layer" добавляется, когда выбран сегмент или трасса.  
� Изменяя ширину трассы соединения в Project > Nets... диалоге, можно применить новую ширину к существующим

трассам. 
� Контактные площадки выводных компонентов теперь формируются на каждом слое меди. Слой "through-hole 

(отверстие вывода)" заменён слоем "drilled hole (просверленное отверстие)". 
� Большинство элементов может быть перемещено с клавишами курсора.  
� Можно выбрать группу элементов (таких как компоненты, трассы, полигоны, и т.д.) нарисовав прямоугольник

мышкой. Затем вся группа может быть перемещена с помощью мышки или клавишами курсора. 
� Добавлены опции к диалогу File > Generate CAM files... , где таким образом можно выбирать независимое

использование теплового барьера для площадок и переходных отверстий, а также независимо создавать открытые
области в паяльной маске для площадок переходных отверстий. 

� Было добавлено меню "Selection mask", где, таким образом, стало возможно управлять типами элементов, которые
могут быть выбраны мышью. 

� При перемещении элементов, в строке состояния отображается относительное расстояние.  
� В меню Help есть элемент, который показывает список горячих клавиш. 
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3. Установка FreePCB 

В конце концов, FreePCB обзаведётся хорошим инсталлятором, но пока процедуру установки необходимо делать
вручную. Вот инструкции 

� Загрузите последнюю версию программного обеспечения с www.freepcb.com. Это может быть файл в
форме архива zip с названием freepcb_1000_bin.zip, исполняемый файл самоустанавливающегося архива с
названием freepcb_1000_src.exe или полный файл инсталлятора, такой как freepcb_1000_setup.exe. 

� Установите программное обеспечение в папку на Вашем жестком диске. Например, в папку C:\FreePCB или 
C:\Program Files\FreePCB. Эта папка должна содержать подпапки, как показано на рисунке: 

� Подпапка bin содержит исполняемый файл FreePCB.exe самой программы, файл конфигурации default.cfg, 
задающий конфигурацию по умолчанию, и несколько других файлов.  

� Подпапка doc содержит документацию (главным образом это Руководство пользователя). 
� Подпапка lib  содержит основные библиотеки футпринтов.  
� Подпапка lib_contrib  содержит библиотеки футпринтов внесенные другими пользователями. 
� Подпапка lib_extra содержит редко используемые библиотеки футпринтов.  
� Подпапка projects содержит папки для каждого проекта PCB.  
� Подпапка src содержит исходный код программы FreePCB. 

� Если Вы использовали инсталлятор, то в процессе установки Вам предложат создать ярлык на рабочем столе, 
чтобы запустить FreePCB. Если Вы использовали один из архивов, то придётся создать ярлык вручную. Для
этого откройте папку .\FreePCB\bin в Windows Explorer и перетащите файл FreePCB.exe на рабочий стол
правой кнопкой мышки. После этого появиться выпадающее меню в котором необходимо выбрать опцию 
"Создать ярлык". 

www.freepcb.com
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4. Краткий обзор процесса проектирования PCB 

Это - краткий обзор процесса проектирования PCB, с объяснениями некоторых терминов, которых имеют особое
значение в FreePCB. Эти термины выделены жирным шрифтом.  

4.1 Схема  

Большинство проектов PCB начинаются со схемы Schematic Diagram, которая показывает компоненты Devices, 
используемые в проекте, и соединения Connections между ними. У каждого компонента в схеме есть позиционное
обозначение Reference Designator, такое как "U1" или "R3". Точки подключения компонентов  называют выводами
или штырями Pins, даже в том случае, когда они фактически имеют не штыревую конструкцию, как винтовые
зажимы, например. В общем и конечном счёте печатная плата PCB должна содержать компоненты соединённые
точно так, как показано на схеме. Если проектировщик производит изменения в схеме размещения PCB, которые
создают несоответствия между PCB и схемой, схема должна быть скорректирована Back-Annotated, чтобы отразить
изменения.  

4.2 Определение корпусов, упаковочной информации и названий выводов 

Первым шагом в проектирование PCB из схемы является  выбор физического корпуса Part для каждого компонента в
схеме. Спецификация корпуса, по крайней мере, должна включать упаковочную информацию - упаковку Package и
схему расположения выводов Pinout для корпуса. Как только корпуса и упаковочная информация  были выбраны, 
необходимо возвратиться к схеме и назначить название выводов Pin 
Names. Название должно быть назначено для каждой вывода в проекте, даже в корпусах, которые имеют
взаимозаменяемые выводы, такие как резисторы.  
Названия выводов обычно содержат числа, но также могут содержать буквы. Если используются буквы, то требуется, 
чтобы они предшествовали любым числам. Например, "12", "A", "SOURCE" и "A23" являются допустимыми
названиями выводов, в то время как "1A" и "A1A" нет. Другие символы кроме букв и чисел не допускаются.  
Идентификатор упаковки Package Identifier является строкой, такой, например, как "DIP16", которая идентифицирует
упаковку и определяет какой футпринт Footprint  используется для корпуса. Футпринт включает медные контактные
площадки Pads к которым припаиваются выводы компонентов, а так же графические элементы, такие как контур
корпуса Part Outline и текстовая строка Text String для позиционного обозначения.  

4.3 Список корпусов Partlist 

Partlist , это список всех корпусов проекта, с их позиционными обозначениями и идентификаторами упаковки. 
Пример списка корпусов показан ниже: 

Позиционное обозначение Идентификатор упаковки 

U1 DIP14 

R1 RES_1/4W_AXIAL 

C1 CHIP_0805 
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4.4 Список соединений 

Соединение Net определяет выводы компонентов, которые соединены вместе линиями на схеме. Каждый вывод в
соединении идентифицирована текстовой строкой, состоящей из позиционного обозначения корпуса, содержащего
данный вывод, символ "." и название вывода. Например, вывод 8 корпуса U5 был бы "U5.8". У каждого соединения
должно быть уникальное имя, которое может быть выразительным и описательным, или просто отличительным. 
Перечень выводов в соединении называется списком выводов Pin List .  
Список соединений Netlist является списком всех соединений в проекте, с их списками выводов. Типовой список
соединений показан ниже: 

Имя соединения Список выводов 

VCC U1.14, R1.1, C1.1, Q1.C 

GND U1.7, C1.2, Q1.E 

$$1234 U1.1, R1.2, U1.2, Q1.B 

 
4.5 Создание файлов списка соединений 

Если схема была создана схемным редактором, список корпусов и список соединений могут быть автоматически
записаны в файл списка соединений Netlist File. Большинство схемных редакторов позволяют генерировать файлы
списка соединений в нескольких форматах. Вы должны выбрать формат "PADS-PCB", который распознаётся
программой FreePCB. Файл списка соединений в этом формате показан ниже. Распечатка в значительной степени
очевидна. 

*PADS-PCB*  
*PARTS*  
U1 DIP14  
R1 RES_1/4W_AXIAL  
C1 C0805  

*NETS*  
*SIGNAL* GND 
U1.7 C1.2  

*SIGNAL* $1234  
U1.1 R1.2 U1.2  

Если Вы работаете с напечатанной или нарисованной от руки схемой, то придётся сделать файл списка соединений
вручную. Это довольно легко, хотя может стать утомительным на большом проекте. Я обычно делаю фотокопию
схемы. Затем начинаю делать файл списка соединений, используя редактора текста. По мере пополнения списка
корпусов, я подсвечиваю желтым фломастером на схеме позиционное обозначение каждого добавляемого
компонента. Затем назначаю названия соединениям и выводам (если они уже не указаны на схеме), и делаю список
соединений. Для каждого соединения я использую желтый маркер и отмечаю каждое подключение, по мере
пополнения списка выводов. После завершения процедуры, каждый компонент и каждое подключение на схеме
должны быть закрашены жёлтым цветом. Тогда, я распечатываю файл списка соединений и проверяю его построчно. 
Поскольку идёт проверка, я снова подсвечиваю компоненты и подключения в схеме, но на сей раз красным
фломастером, удостоверяясь, что каждый компонент и каждое подключение учтены. Я делал весьма большие файлы
списка соединений этим путем без ошибок. 
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4.6 Импорт файла списка соединений в FreePCB  

Когда файл списка соединений будет готов, можно импортировать его в FreePCB, чтобы запустить Ваш проект. 
FreePCB попытается найти футпринт соответствующий идентификатору упаковки для каждого корпуса. Если это
завершится неудачно, можно назначить футпринты вручную или возвратиться и отредактировать список соединений. 
Все футпринты будут помещены в левом нижнем углу области проекта PCB. Затем FreePCB загружает соединения из
списка соединений, разрывая каждое соединение в последовательность подключений между ближайшими выводами. 
Они появятся как розовые линии между ножками, обычно называемые Ratlines (лини или просто связи). Если Вы
перемещаете корпуса, то эти связи будут перемещаться, растягиваться или сжиматься вместе с ними.  

4.7 Добавление корпусов и соединений "На лету"  

В качестве альтернативы, Вы можете создать проект в FreePCB без файла списка соединений при использовании  
методики редактирования "на лету". Начиная с пустого проекта, добавьте каждый корпус, соединение и подключение, 
используя пункты меню Modify  и Add. Вы будете опрошены относительно позиционных обозначений и   названий
соединений по мере необходимости. Это работает разумно хорошо для маленьких проектов, но я предпочитаю
создавать файл списка соединений как описано выше.  

4.8 Размещение корпусов  

Следующим шагом является размещение Place корпусов на плате, двигая и вращая их по мере необходимости. После
того, как Вы переместите корпус, FreePCB автоматически переназначит связи каждого соединения, подключенного к
корпусу, минимизируя их полную длину. Использование сетки Snap Grid делает выравнивание компонентов более
простым.  

4.9 Разводка дорожек (Трассировка)  

Когда корпуса размещены, можно приступить к разводке. Это обычно самая сложная часть процесса проектирования
PCB, отнимающая много времени. Каждое подключение должно быть преобразовано в медную дорожку Trace, 
состоящую из множественных прямолинейных сегментов Segments. Точки, где сегменты объединены называются
изломами Vertices. Все сегменты могут размещаться на одном том же медном слое Layer или могут быть на
различных слоях, и в этом случае они будут подключены через переходный отверстия (переходы) Vias. FreePCB 
поддерживает только сквозные переходы и не поддерживает слепых или скрытых переходов. Дорожки могут
содержать ответвления Branches к альтернативным выводам, помимо оригинальных конечных точек дорожки. Можно
создавать полигоны Copper Areas, которые могут быть полезными для создания обширных областей разводки
питания  и земли. Для подключения площадок SMT к полигонам можно использовать обрубленные дорожки Stub 
Traces. Сетка излома полезна для выравнивания дорожек. Вы можете также установить угол излома Snap Angle, 
который вынуждает сегменты дорожки ориентироваться под различными углами (обычно 45º).  

4.10 Добавить текст  

Текстовая строка может быть добавлены для примечаний, исправления чисел, объявлений об авторском праве и т.д. 
Текстовая строка размещаться в слое шелкографии.  

4.11 Файлы прорисовки и сверления  

Прорисовки каждого слоя, могут быть экспортированы в виде гербер файлов Gerber Files, которые используются для
создания фотошаблонов Photoplots для изготовления печатной платы. FreePCB может также генерировать файлы
сверловки Drill Files , которые определяют все отверстия, которые будут просверлены в плате. Так как FreePCB не
имеет встроенного просмотрщика гербер файлов, то для просмотра Ваших гербер-файлов Вы можете использовать
бесплатный гербер просмотрщик Gerber Viewer, такой как ViewMateот PentaLogix, и сделать проверочную
прорисовку Check Plots на принтере Windows. Для приверженцев утюжно-лазерной технологии этого будет уже
достаточно. Желающие получить печатные платы фабричного исполнения могут послать свои гербер-файлы и файл
сверловки в компанию изготовления PCB PCB Fabrication Company (вместе с некоторым количеством денег Money). 
Они в течении нескольких дней выполнят Ваш заказ и пришлют назад законченные платы. Ведь это круто! 
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5. Размещение PCB  

5.1 Копия экрана 

Копия экрана FreePCB показана ниже. 

Основные элементы окна:  
1. Строка меню, содержащая меню File, Edit, View, Project, Tools, Add и Help  
2. Панель задач (непосредственно ниже строки меню), с 8 иллюстрированными кнопками и 5 выпадающими меню для
установки единиц измерения Units (mil или мм), интервалов сетки видимости Visible, размещения Placement и 
трассировки Routing, и угла излома Angle (в градусах).  
3. Список слоёв на левой стороне клиентской области, с окошками рядом с каждым слоем, показывающими его цвет и
видимость.  
4. Выбор маски, ниже списка слоёв, с полями, чтобы разрешить/запретить выбор различных элементов.  
5. Окно размещения, где показана PCB.  
6. Меню функциональных клавиш ниже списка слоёв и окна размещения, показывает доступные команды
функциональных клавиш.  
7. Строка состояния в нижней части окна.  

Эти элементы описаны более подробно в следующих разделах. 
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5.2 Меню  

В строке меню доступны следующие меню: 
♦ File

• New — создать новый проект PCB (быстрая клавиша = Ctrl-N) 
• Open... - открыть файл проекта PCB ( быстрая клавиша = Ctrl-O) 
• Save — сохранить файл проекта PCB ( быстрая клавиша = Ctrl-S) 
• Save As... - сохранить файл проекта PCB под новым именем 
• Close — закрыть проект 
• Import netlist... - импорт файла списка соединений 
• Export netlist... - экспорт файла списка соединений 
• Convert library... - конвертировать библиотеку футпринтов из формата Ivex в формат FreePCB 
• Generate CAM files... - генерировать гербер файлы и файл сверловки 
• Open Footprint Editor... - перейти из редактора PCB в редактор футпринтов 
• Export .dsn file... - Экспортировать файл дизайна в автотрассировщик 
• Import .ses file... - импортировать файл сессии из автотрассировщика 
• Print... - (пока не осуществлено) 
• Print Preview - (пока не осуществлено) 
• Print Setup... - (пока не осуществлено) 
• Exit — закрыть приложение 

♦ Edit
• Undo — отменить последнюю операцию ( быстрая клавиша = Ctrl-Z) 
• Cut — сохранить в буфер обмена и удалить (доступно только для групп) 
• Copy — сохранить в буфер обмена (доступно только для групп) 
• Paste — вставить из буфера обмена (доступно только для групп) 
• Save group to file... - сохранить группу как файл проекта 
• Paste group from file... - вставить файл проекта как группу 

♦ View
� Show board outline — изменить масштаб, чтобы отобразить всю плату 
� Show all — изменить масштаб, чтобы отобразить все элементы размещения (сокращённо=Home) 
� Show part... - открыть диалог для выбора компонента 
� Layers... - открыть диалог просмотр/редактирование слоёв 
� Show log... - показать лог окна 

♦ Project
• Options — открыть диалог Опции Проекта для редактирования 
• Parts... - открыть диалог Смотреть/Редактировать корпуса для редактирования списка корпусов 
• Nets... - открыть диалог Смотреть/Редактировать соединения для редактирования списка соединений  

♦ Tools
• Move origin — переместить оригин системы координат в новую позицию 
• Footprint Wizard — открыть Мастер футпринта для создания нового футпринта 
• Footprint Editor — открыть редактор футпринта для создания или редактирования футпринта 
• Check parts and nets — Проверить проект на внутренние ошибки базы данных 
• Check traces — проверить и очистить дорожки 
• Check connectivity — проверить проект на неполные подключения списка соединений 
• Check Copper Areas — проверка полигинов, объединить если нужно 
• Design Rule Check — Проверить согласованность с правилами проекта и показать ошибки 
• Clear DRC Errors — Очистить символы для всех ошибок DRC 
• FreeRoute autorouter... - запустить on-line автотрассировщик FreeRoute  

 
♦ Add

• Board Outline — добавить контур платы 
• Part — добавить новый корпус 
• Net - (пока не осуществлено) 
• Copper Area — добавить полигон 
• Text — добавить строку текста 
• Solder Mask Cutout — добавить контур в слое паяльной маски 
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♦ Help
• User Guide – показать это руководство пользователя 
• FreePCB Website – посетить вебсайт FreePCB 
• FreeRouting Website – посетить доступ к on-line трассировщику FreeRoute  
• Keyboard shortcuts – показать список быстрых клавиш 
• About FreePCB... – показать информацию о программе FreePCB 

5.3 Панель задач  

Панель задач показана ниже: 

 

Она содержит 8 иллюстрированных кнопок, которые являются ярлыками для следующих пунктов меню: 
 New
 Open
 Save
 Cut
 Copy
 Paste
 Print
 About

Они сопровождаются 5 раскрывающимися меню для установки единиц измерения и сетки, используемых в FreePCB. 
Это: 
 Units – выбрать mils или mm для измерений размеров 
 Visible – установить интервал прямоугольного массива точек в окне размещения, как видимые ссылки 
 Placement – установить сетку для размещения корпусов, текста и т.п. 
 Routing – установить сетку для разводки дорожек и прорисовки полигонов 
 Angle – установить угол излома (в градусах) для разводки дорожек, прорисовки границ платы и полигонов 

Заданные по умолчанию данные для раскрывающихся меню (кроме меню Angle) находятся в файле default.cfg, в
папке, которая содержит FreePCB.exe. Когда проект создан, они копируются в секцию опций проектного файла. Они
могут быть изменены при помощи любого текстового редактора, например таким, как Блокнот.  

5.4 Строка состояния  

Строка состояния (находится в нижней части окна FreePCB) показана далее: 
 

Она содержит следующие элементы: 

� Подсказку (“Ready”), которая изменяется, если курсор помещается поверх различных элементов
пользовательского интерфейса 

� X и Y координаты курсора в mils или мм 
� Информация об элементе, который выбран (если выбран). В примере выше, корпус U1 был выбран. Его

позиционное обозначение, футпринт, позиция, угол и сторона отображены. 
� Текущий трассируемый слой (“Top”) 
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5.5 Список слоёв и маска выбора 

Это два вертикальных списка в окне FreePCB, слева от области размещения.  

5.5.1 Список слоёв  

Это - список всех слоёв рисования используемых в проекте. Рядом с названием каждого слоя
маленький квадрат, показывающий цвет слоя. Если уровень был сделан невидимым, квадрат
будет белым с "X" через него (таким как "inner 1" и "inner 2" в примере). Вы можете
переключить каждый слой от видимого до невидимого, нажимая на квадрат.  
Слой активный для трассировки ("top copper" в примере ниже) будет идентифицирован
стрелкой - указателем. Вы можете изменить активный уровень трассировки, нажимая
числовую клавишу на клавиатуре (то есть клавиши с "1" до "8"), или кликая на названии слоя в
списке. Активный слой трассировки будет всегда отображаться поверх других слоёв в окне
размещения. 

Цвет каждого слоя можно изменить. Для изменения цвета слоя выбираем
Layers в меню View, которое вызывает  диалог View/Edit Layers, показанный 
ниже. Нажмите на кнопки в столбце Edit, чтобы изменить цвета. Вы можете
также изменить видимость слоёв в этом диалоге. 

5.5.2 Маска выбора 

Элементы в размещении можно выбрать для редактирования, кликнув по ним или нарисовав
вокруг них прямоугольник мышкой. Так как элементы могут наложиться друг друга, то иногда
бывает трудно выбрать точно тот элемент, который Вам нужен. В этом случае можно
использовать маску выбора, чтобы позволить или отключить выбор различных типов элемента. 
Маска состоит из списка типов, с цветным блоком рядом с каждым. Зеленый блок означает, что
тип элемента может быть выбран, в то время как красный блок означает, что этот элемент не
может быть выбран. Можно переключать состояние каждого блока, нажимая на него. 
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5.6 Функциональные клавиши и контекстное меню 

Большинство программ рисования Windows используют процедуру "кликнуть-тащить" мышкой для редактирования. 
Это означает удерживание в нажатом состоянии левую кнопки мышки при её перемещении. Можно, например, 
изменить размеры элемента кликнув по нему, что влечёт за собой появление блока выбора с "захватами", которые
можно затем кликнуть и перетащить, чтобы увеличить или уменьшить элемент. Конечные точки линии могут быть
перетащены щелчком к новой позиции, и т.д., и т.п.  
Однако, клик-перемещение не работает достаточно хорошо для трассировки дорожек, что является самой
долговременной частью трассировки PCB. Дорожки - в основном ломаные линии, состоят из множества
подключенных линий сегментов. Размещение каждого сегмента требует отдельного щелчка мыши, который
подразумевает, что сегменты нужно перетащить, не удерживая в нажатом состоянии кнопку мыши.  
Кроме того, пока трассируются дорожки или размещаются корпуса, полезно иметь возможность панорамирования и
изменения масштаба изображения, которое мне нравится делать с использованием прокрутки на мыши. Согласитесь, 
очень трудно использовать прокрутку, одновременно удерживая кнопку мыши.  
Поэтому FreePCB использует немного другой подход. Элемент выбирается, если кликнуть по нему. После этого
элемент подсвечивается, что указывает на то, что он был выбран, и в строке состояния появляется описание элемента. 
Теперь операция редактирования может быть выполнена после нажатия соответствующей функциональной клавиши
на клавиатуре. Операции, назначенные на каждую функциональную клавишу, перечислены в нижней части окна
FreePCB. Этот список контекстно-зависим, и изменится, в зависимости от того, какой элемент был выбран. Например, 
ниже показано меню, соответствующее моменты, когда выбран корпус. 
 

Если операция потребует перемещения, то это будет возможным после нажатия функциональной клавиши. Операция
обычно заканчивается нажатием левой кнопки мышки, или может быть отменена нажатием правой кнопки мыши. 
Пока делается перемещение, функциональные клавиши остаются активными, так, чтобы могли быть выполнены
дополнительные операции. Например, во время перемещения корпуса, нажатие F3 позволит вращать его, в то время
как нажатие F2 позволит переместить его на противоположную сторону платы. Этот стиль пользовательского
интерфейса требует, чтобы Вы держали левую руку на клавиатуре, а правой работали с мышкой, редактируя
(предполагается, что Вы правша). Во времена DOS многие CAD программы использовали подобный стиль, а
некоторые еще продолжают использовать. Если у Вас есть сомнение относительно скорости и эффективности подхода
"левая рука на клавиатуре, а правая с мышкой", тогда проведите несколько минут, наблюдая за кем-то, кто играет в
одну из популярных игр, таких как Doom, Quake, Unreal Tournament, Half-life, Tribes, и т.д. Они все используют
именно этот стиль пользовательского интерфейса. А трассировка PCB обычно является более простой операцией, чем
обстрел неистовствующих нацистских мутантов, наседающих со всех сторон!  
Назначение операций редактирования функциональным клавишам является не полностью произвольным, как может
показаться сначала. Так как пальцы левой руки обычно лежат на клавишах F1-F4, то они используются для первичных
операций редактирования. F4 (под указательным пальцем) используется для самой общей операции на выбранном
элементе (такой, как перемещение корпуса), в то время как F2-F3 используются для менее общих операций. F1 часто
используется, чтобы вызвать своего рода диалог, позволяющий редактировать свойства выбранного элемента. 
Клавиши F5-F8 обычно используются для удаления или перетрассировки, так как они требуют движения рукой, что
уменьшает вероятность их случайного нажатия. Клавиша F9 зарезервирована для того, чтобы повторно вычислить
ratlines. Это расположение очевидно оптимизировано для пользователей, которые в основном используют правую
руку (как я). Я предполагаю добавить опцию "left-handed (левша)" в будущем.  

Если Вы предпочтете не использовать функциональные клавиши, то щелкая правой кнопкой
можно вызвать более традиционное меню Windows, показано ниже. Это так называемое
"меню контекста", и его информационное наполнения изменяется, в зависимости от того, 
какой элемент выбран. Меню контекста не доступно, в то время как Вы перетаскиваете
элемент мышкой, таким образом функциональные клавиши всё равно должны
использоваться, чтобы выполнить операции во время перемещения. 
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5.7 Панорамирование и изменение масштаба изображения  

Имейте в виду, что в окне FreePCB нет никаких линеек прокрутки. Использование полосы прокрутки для
панорамирования не очень практично для программы размещения PCB, так как вынуждает часто выполнять
панорамирование, направляя дорожки или перемещая корпуса. Это неэффективно, так как вынуждает сдвигать курсор
из рабочей области к линейки прокрутки.  
Поэтому, панорамирование и изменение масштаба изображения в FreePCB выполнено или клавишами клавиатуры или
(предпочтительно) путём прокрутки мышки. Для панорамирования, переместите курсор в пункт на PCB, который
будет новым центром изображения, и надавите клавишу пробел или прокрутите колёсико мышки на один щелчёк в
любом направлении. Изображение повторно центрируется на позиции курсора. Чтобы увеличить изображение, 
нажмите клавишу "Page Up" или прокрутите вперёд колёсико мышки более чем на один щелчёк. Чтобы уменьшить
изображение, нажмите "Page Down" или прокрутите назад колёсико мышки. Если у Вас нет мышки с колёсиком, я
рекомендовал бы её приобрести.  
Вы можете отобразить всю схему PCB, используя View->Show board outline элемент меню. Вы можете показать все
элементы в проекте (которые могут находится за пределами PCB), выбрав View->Show all, или нажав клавишу 
"Home". Вы можете выбрать корпус и панорамироваться к его местоположению, используя View->Show part...

5.8 Проекты  

В FreePCB, печатные платы упоминаются как проекты. Вся информация, описывающая проект, хранится в
единственном текстовом файле с расширением .fpc, который обычно сохраняется в папке с тем же самым названием
как проект. Например, проект под названием "Motor" будет сохранен в файле Motor.fpc , расположенной в папке
C:\FreePCB\projects\Motor  
Новый проект создаётся с помощью File > New. Это пункт меню начнет Project Options диалог, который показан 
ниже. 

Имейте в виду, что большинство полей диалога уже заполнено. 
Эти настройки по умолчанию взяты из файла, названного
default.cfg, который должен быть расположен в той же самой
папке как и приложение FreePCB.exe. Если Вы не хотите
использовать значения по умолчанию для своего проекта, Вы
можете изменить их в диалоге. Если Вы хотели бы изменить
значения по умолчанию для всех будущих проектов, можете
отредактировать файл defaults.cfg любым редактором текста. 
Формат этого файла описан в разделе 8: Форматы файлов. 
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Каждое поле в диалоге объяснено ниже: 

 Name: Это - название проекта, которое не должно содержать пробелов или любые символы, которые недопустимы
в имени файла. 
 Project Folder: Это - папка, где будет сохранён Ваш файл проекта. Уже заполнен путь заданной по умолчанию
родительской папки для новых проектов. Поскольку Вы вводите имя своего проекта в поле Name, каждый символ 
будет автоматически добавлен к пути. Например, если Вы введете "Motor" в поле Name, то поле Project Folder
станет "..\projects\Motor". Если Вы хотите использовать другую папку проекта, можете отменить значение по
умолчанию, введя новый путь непосредственно в поле Project Folder. 

� Примечание: Заданный по умолчанию путь начинается ".. \", указывая на то, что это - относительный путь. 
Фактически, это местоположение расположенное относительно приложения FreePCB.exe. Если Вы
выполнили заданную по умолчанию инсталляцию в C:\FreePCB, приложение будет в C:\FreePCB\bin, и
проектные папки будут в C:\FreePCB\projects. Если Вы устанавливали FreePCB где-то в другом месте, 
заданный по умолчанию путь будет все еще работать пока \bin, и \projects находятся в той же самой папке. В
противном случае Вы можете редактировать default.cfg файл. Например, когда я работаю над исходным
текстом FreePCB, я выполняю приложение из E:\allan\SVNwork\FreePCB\Debug, но я все еще хочу создавать
свои проекты в C:\FreePCB\projects. Поэтому, в E:\allan\SVNwork\FreePCB\Debug\default.cfg, я изменил
строку  
parent_folder: "..\projects \" 
на 
parent_folder: "C:\FreePCB\projects \" 

 Library Folder: Это - путь к папке, которая содержит файлы библиотеки футпринтов для FreePCB. Путь по
умолчанию задан относительно папки приложения, но это может быть изменено в диалоге, если необходимо, и
значение по умолчанию будет изменено в default.cfg так же, как для Project Folder (см. примечание выше). 
 Number of copper layers: Это - число слоев меди на PCB, между 1 и 8. 
 Default trace and via widths (mils): Это значение по умолчанию для ширины дорожки, диаметра площадки
переходов и диаметра отверстия переходов. Они могут быть отменены позже для специфических дорожек и
соединений. 
 Menu of trace and via widths: Это - список ширины дорожек и переходов, который предложен как меню, если вы
модифицируете ширину конкретной части дорожки или соединения. Вы не ограничены этими значениями, но  удобно
иметь их в меню, и это уменьшает шанс ошибки. Вы можете использовать кнопку Add, чтобы добавить новые данные
в список. Если Вы выбираете элемент, Вы можете использовать кнопку Delete, чтобы удалить его или кнопку Edit, 
чтобы изменить.
 Autosave: Разрешение Автосохранения заставляет FreePCB автоматически сохранять проектный файл каждые
несколько минут.  
Когда Вы удовлетворены своими данными, кликните OK. Проектная папка будет создана, если она уже не  
существует (однако, родительская папка должна существовать, или Вы получите сообщение об ошибках). Проектный
файл не будет записан в папку, пока Вы не нажмете Save в меню File. Я обычно немедленно делаю это после того, 
как создал новый проект.  
Между прочим, Name проекта используется, чтобы создать названия для проектного файла и заданной по умолчанию
проектной папки. После этого FreePCB использует название проектного файла как название проекта. Вы можете
переименовать проектный файл, или использовать Save As из меню File, чтобы сохранить проект под другим
названием. Вы можете найти полезным сохранять несколько различных версий Вашего проекта в проектной папке, 
под различными названиями. Например, Вы можете экспериментировать с некоторыми новыми идеями в проекте, но
хотите вернуться назад к более ранней версии, если эксперименты не удадутся.  
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Как упомянуто выше, Вы можете изменить значения по умолчанию для новых проектов, редактируя default.cfg файл в
прикладной папке. Формат для этого файла описан в Секции 8: Форматы файлов, и у Вас не должно быть никакой
проблемы, выясняя, как изменить это (но сохранить копию на всякий случай). Вы можете также редактировать
проектный файл, если Вам хочется. Это - более сложный файл, с секциями, описывающими проектные опции, 
футпринты, корпуса, соединения, текстовые строки, и т.д. Секция опций очень похожа на default.cfg файл. Вы скорей
всего не захотите возиться слишком много с другими секциями. 

Как только проект создан, он может быть закрыт, 
сохранен и открыт с использованием обычных
выборов из меню File.  
После того, как проект был создан, проектные опции
можно отредактировать, выбирая Options... в меню
Project. Это возвратит диалог Project Options. Вы 
можете произвести изменения в любом из
позволенных полей, и сохранить их, нажав OK. 
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5.9 Элементы PCB  

5.9.1 Отдельные элементы  

Представление PCB в окне размещения состоит из различных элементов, которые перечислены в этой части. 
Отметьте, что большинство из них может быть выбрано, путём нажатия на них. Как только элемент был выбран, с ним
могут быть выполнены операции, через нажатие функциональной клавиши или кликнув правой кнопкой мыши и
сделав выбор из контекстного меню. Если операция вовлекает перемещение элемента, функциональные клавиши
могут иногда использоваться, чтобы выполнить дополнительные операции, пока происходит перемещение.  
Элементы PCB перечислены ниже, наряду с их связанными операциями функциональной клавиши. 

� Origin : Это - символ, который идентифицирует начало системы координат PCB (то есть пункт, где X = 0 и Y 
= 0). Это похоже на перекрестие с маленьким кружком в его центре. Он всегда видим, и не может быть
выбран. Но может быть перемещён с использованием Tools > Move origin.  

� Visible grid : Точки в регулярно распределённом массиве, используемые для визуальной привязки. Интервал
точек устанавливается при помощи выпадающих меню в панели задач. 

� Board outline: Это - замкнутая ломаная линия, состоя из ряда точек (углы), со линиями между ними. Стороны
могут быть прямыми линиями или дугами. Углы и стороны являются выбираемыми, и могут быть
отредактированы следующим образом: 

o Corner:  
� F1 (Set Position) - появляется диалог, который позволяет Вам явно редактировать координаты 

X и Y. 
� F4 (Move Corner) – начинает перетаскивание угла курсором.  
� F5 (Delete Corner) - удаляет угол.  
� F8 (Delete Outline) - удаляет контурную линию платы. 

o Side:  
� F1 (Straight Line) - делает сторону прямой линией.  
� F2 (Arc CW) - делает сторону дугой, рисуя её по часовой стрелке.  
� F3 (Arc CCW) - делает сторону дугой, рисуя её против часовой стрелки. 
� F4 (Add Corner) - вставляет угол в сторону, и начинает его перетаскивание.  
� F8 (Delete Outline) - удаляет контурную линию. 

� Part footprint ( футпринт корпуса): Это - составной символ, состоящий из ряда медных контактных
площадок, границы корпуса, текстовой строки для позиционного обозначения корпуса, и возможно других
текстовых строк. Весь футприн, одиночная контактная площадка или позиционное обозначение могут быть
выбраны для редактирования. 

o Entire footprint ( весь футпринт):  
� F1 (Edit Part ) - появляется диалог, позволяющий редактировать свойства корпуса.  
� F2 (Edit Footprint) - переключает на окно Footprint Editor, с футпринтом корпуса уже

импортированным для редактирования. 
� F3 (Glue/Unglue Part) - "Склеенный" корпус нельзя переместить, не "расклеивая" его.  
� F4 (Move Part) - запускают перетаскивание футпринта, чтобы переместить его. 

• Пока перетаскивается:  
o F2 – перебрасывает корпус с одной стороны платы на другой.  
o F3 - вращает корпус на 90º по часовой стрелке.  

� F8 (Delete Part) - удаляют корпус с PCB и списка корпусов.  
� F9 (Recalc. Ratlines) - переназначает ratlines для всех соединений, которые соединены с

корпусом,  для минимизации их длины. 
o Pad: 

� F1(Set net) - появляется диалог, чтобы назначить контактную площадку соединению.  
� F3 (Start Stub) - запускает перетаскивать нового обрубка дорожки.  
� F4 (Connect Pin) – начать перетаскивать ratline к другой контактной площадке. 
� F9 (Recalc. Ratlines) - переназначает ratlines для соединения, которое подключено к этой

контактной площадке для минимизации  длины. 
o Reference designator text (текст позиционного обозначения): 

� F1 (Set Size) - появляется диалог, который позволяет Вам изменить размер и направление
текстовой строки. 

� F4 (Move Ref Text) - запускает перетаскивание текстовой строки, чтобы переместить её.  
• Пока перетаскивается:  

o F3 (Rotate Ref Text) - вращает текстовую строку на 90º по часовой стрелке. 
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� Trace (дорожка): Это - ломаная линия, представляющая соединение между двумя контактными площадками. 
Она состоит из одного или больше прямолинейных сегментов с изломами между сегментами. Сегменты могут
быть разведенными (то есть физически существующими на медном уровне) или неразведёнными. 
Неразведённые сегменты называют ratlines. 

o Ratline: Это - линия, представляющая собой неразведённый сегмент дорожки.  
� F1 (Set Width) - выскакивает диалог, который позволяет Вам устанавливать  ширину дорожки

и перехода для сегмента, дорожки или соединения.  
� F3 (Lock/Unlock Connect) — создание блокированной ratline, которая не может быть

уничтожена операцией "Recalc.Ratlines".  
� F4 (Route Segment) - начинает перетаскивать конечную точку разводимого сегмента,  чтобы

заменить ratline.  
• Пока перетаскивается:  

o F4 (Законченный Сегмент) - расширяет направленный сегмент, на который 
перетаскивают конечная точка ratline. 

� F5 (Change Pin) - изменяет вывод, к которому подключена ratline.  
� F6 (Unroute trace) – Отменить разводку любых разведённых сегментов в дорожке.  
� F8 (Delete Connect) – удалить подключение (от стартового до конечного вывода) из

соединения.  
� F9 (Recalc.Ratlines) - переназначают ratlines для соединения, для минимизации длины. 

o Segment: Это - строка, представляющая разведённый сегмент дорожки.  
� F1 (Set Width) - появляется диалог, который позволяет Вам устанавливать ширину дорожки

или соединения.  
� F2 (Change Layer) - изменяет слой сегмента.  
� F4 (Add Vertex) - вставляет излом в сегмент и запускает его перемещение.  
� F5 (Unroute Segment) – отменить разводку сегмента, преобразовав его в ratline.  
� F6 (Unroute Trace) – отменить разводку дорожки, преобразовав её в ratline.  
� F8 (Delete Connect) - удаляет подключение (от начальной до конечной точки) от соединения.  
� F9 (Recalc. Ratlines) - переназначает ratlines для сети, чтобы минимизировать их длину. 

o Vertex(Излом): Это есть точка соединения двух сегментов, или сегмента и ratline. Если оба сегмента 
разведены на различных слоях, то в изломе будет переходное отверстие.  

� F1 (Set Width) - появляется диалог, который позволяет Вам явно редактировать координаты 
X и Y. 

� F3 (Connect Pin) - запускает перетаскивание ratline, чтобы подключить излом к выводу для
дорожки ответвления.  

� F4 (Move Vertex) – начинает перетаскивание излома, чтобы переместить её.  
� F6 (Unroute Trace) – Отменить разводку дорожки.  
� F7 (Delete Vertex) – удалить излом, отменить разводку смежных сегментов.  
� F8 (Delete Connect) - удалить подключение (от первого до последнего вывода).  
� F9 (Recalc. Ratlines) - переназначить ratlines для соединения, чтобы минимизировать их

длину. 
� Branch Trace: Ответвление является дорожкой между изломом дорожки и выводом. Функции для ratlines, 

сегментов и изломов те же самые, как для обычной дорожки. 
� Stub Trace: Обрубленная трасса начинается на контактной площадке, но не заканчивается на контактной

площадке. Она обычно заканчивается переходом, который используется, чтобы подключить трассу с
полигоном на другом слое. Она может содержать ratlines, сегменты и изломы как обычная дорожка, но
последний сегмент и последний излом обрабатываются особенно. 

o End Segment: Последний разведённый сегмент.  
� F1 (Set Width) - вызывает диалог, который позволяет Вам устанавливать изменение ширины

дорожки и перехода дорожки или соединения. 
� F2 (Change Layer) – изменяет слой сегмента.  
� F4 (Add Vertex) - вставляет излом в сегмент и запускает его перетаскивание.  
� F5 (Unroute Segment) – отменить разводку сегмента, преобразовав его в ratline.  
� F6 (Unroute Trace) – отменить разводку дорожки, преобразовав её в ratline.  
� F7 (Delete Segment) – удалить сегмент.  
� F8 (Delete Connect) – удалить обрубленную трассу целиком.  
� F9 (Recalc. Ratlines) - переназначить ratlines для соединения, чтобы минимизировать их

длину.  
o End Vertex: Последний излом (то есть оконечная точка обрубленной дорожки).  

� F1 (Set Position) - вызывает диалог, который позволяет Вам явно редактировать координаты
излома X и Y. 

� F2 (Add Segment) – запустить перетаскивание нового сегмента, чтобы расширить
обрубленную дорожку.  

� F3 (Add/Delete Via) – добавить или удалить переход в конце обрубленной дорожки.  
� F4 (Move Vertex) – начать перемещение конечного излома.  
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� F5 (Add/Delete Via) - добавить/удалить переход.  
� F7 (Delete Vertex) - удалить излом.  
� F8 (Delete Connerct) – удалить целиком обрубленную дорожку.  
� F9 (Recalc. Ratlines) - переназначить ratlines для соединения, чтобы минимизировать их

длину. 

� Copper Area: Это замкнутая ломаная линия, которая определяет область сплошной или перфорированной  
меди на одном из медных слоёв. Используется для создания земли, охлаждения и т.д. Эта линия состоит из
ряда углов со сторонами между углами. Область заполняется диагональной штриховкой. Обратите, что этот
шаблон штриховки предназначен только для визуальной идентификации области и не представляет
фактический медный шаблон, который будет применен к PCB. Область также может содержать вырезы
(cutouts), которые являются "отверстиями" в полигоне. Вырезы редактируются так же как полигоны.  

o Corner:  
� F1 (Set Position) - вызывает диалог, чтобы установить угловую позицию явно.  
� F4 (Move Corner) - запускает перетаскивание угла, чтобы переместить его.  
� F5 (Delete Corner) - удаляет угол.  
� F7 (Add Cutout) - запускает прорисовку выреза в полигоне.  
� F8 (Delete Area) - удаляет всю область. 

o Side:  
� F1 (Straight line) - если сторона есть дуга, преобразовать в прямую линию.  
� F2 (Arc (CW)) - преобразовать сторону в дугу, образуемую по часовой стрелке.  
� F3 (Arc (CCW)) - преобразовать сторону в дугу, образуемую против часовой стрелки. 
� F4 (Add Corner) - добавить новый угол и запустить его перетаскивание.  
� F7 (Add Cutout) - запускает прорисовку выреза в полигоне.  
� F8 (Delete Area) - удалить весь полигон. 
� Text String: Это - строка алфавитно-цифровых символов, используемых для того, чтобы

добавлять пометки, объявления об авторском праве и т.д. Строка может быть помещена на
шелкографии или медном слое. 

o F1 (Edit Text) - появляется диалог, чтобы редактировать строку и ее свойства, такие как размер и
ширина штриха. 

o F4 (Move Text) - запускает перетаскивание строки, чтобы переместить её.  
o F8 (Delete Text) - удалить всю строку. 

� Solder Mask Cutout: Это - замкнутая ломаная линия, которая определяет вырез в слое маски припоя. 
o Corner:  

� F1 (Set Position) - появляется диалог, позволяющий явно установить позицию угла.  
� F4 (Move Corner) - запускает перетаскивание угла, чтобы переместить его.  
� F5 (Delete Corner) - удаляет угол.  
� F8 (Delete Area) - удалить вырез полностью. 

o Side:  
� F1 (Straight Line) - делает сторону прямой линией.  
� F2 (Arc CW) - делает сторону дугой формированной по часовой стрелке.  
� F3 (Arc CCW) - делает сторону дугой формированной против часовой стрелки.  
� F4 (Add Corner) - добавляет новый угол и запускает его перетаскивание.  
� F8 (Delete Area) – удалить вырез полностью. 
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5.9.2 Группы элементов  

Группы элементов могут быть выбраны рисованием прямоугольника вокруг них с помощью мышки. Все элементы в
группе будут подсвечены. Отдельные элементы могут быть добавлены в группе или удалены из неё путём нажатия на
них с удержанной клавишей CTRL. Операции, которые могут быть выполнены на группах: 

� F4 (Move Group) – начинает перемещение группы 
� F8 (Delete Group) - удаляет группу из проекта  
� ctrl-C – копирует группу в буфер обмена 
� ctrl-X – копирует группу в буфер обмена и удаляет её из проекта 

5.9.3 Перемещение элементов или групп клавишами курсора  

Когда элемент или группа выбраны, Вы можете переместить их мышкой, выбирая операцию перемещения  
функциональными клавишами или меню контекста. Большинство элементов и групп могут также быть перемещены, 
нажатием клавиш курсора на клавиатуре. Нажатие клавиши курсора переместит элемент или группу на расстояние, 
равное текущему шагу размещения или трассировки, в зависимости от выбранного элемента. Меньшие движения
могут быть сделаны, путем удерживания клавиши SHIFT и нажатия клавиши курсора, что переместит элемент на 1 mil 
или 0.01 MMS, в зависимости от используемых модулей.  

5.10 Контур платы (Board Outline) 

Контур платы представляет границу PCB. В FreePCB контур состоит из замкнутой ломаной линии (closed polyline)
(или полигона polygon) состоящей из 3 или более сторон, с углами между сторонами. Стороны могут быть
сегментами прямой линии или дугами arcs. Дуга - один квадрант эллипса, главная ось которого параллельна или x или 
y. Преимущество использования этого ограниченного определения дуги состоит в том, что дуга полностью
определена позицией ее оконечных точек и направлением, которое может быть по часовой стрелке или против
часовой стрелки. Типовой вид платы, состоящей из 10 углов и 10 сторон, показан ниже. Заметьте, что две из сторон - 
дуги.  
В проекте может быть больше одного контура платы. 
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Контур платы можно создать выбрав Add > Board Outline. После этого курсор превратится в перекрестие. Поместите
стартовый угол левым кликом мышки. Затем Вы обнаружите "резиновую" линию, которая тянется за курсором. 
Повторным левым кликом мышки отметьте второй угол, и создавайте вторую сторону методом "резиновой" линии. 
Продолжайте, пока не отметите последний угол, а затем щелкните правой кнопкой мыши, чтобы замкнуть ломаную
линию, отодвигая сторону к стартовому углу.  
Рисуя Вы можете изменить стиль (style) текущей стороны от прямой линии до дуги при использовании
соответствующих функциональных клавиш (F1 для прямой линии, F2 для дуги по часовой стрелке и F3 для дуги
против часовой стрелки). Стиль, который Вы выбираете, останется в силе, пока Вы не измените его. Отметьте, что
дуги становятся прямыми линиями, если оконечные точки являются вертикальными или горизонтальными. 
Размещение углов будет управляться сеткой размещения, которая должна быть установлена в соответствующее
значение прежде, чем начать рисовать контур платы. Размещение будет также управляться углом излома. Если угол
излома будет 45º, то дуги будут квадрантами круга.  
Как только контур платы будет создан, Вы сможете редактировать его следующими способами: 

� Вы можете снова установить угол, кликнув по нему, чтобы выбрать новое значение. Маленький белый
квадрат появится вокруг угла, указывая, что он был выбран, и строка состояния, укажет, какой угол был
выбран. Тогда нажмите F4 ("Move Corner (Перемещение Угла)"), чтобы запустить перетаскивание угла к
новой позиции. 

Или нажмите F1 ("Set Position (Установка позиции)"), чтобы появился диалог, 
который позволит Вам устанавливать позицию угла явно, как показано ниже: 

  

� Вы можете добавить угол, нажимая на сторону, чтобы выбрать её. Сторона побелеет, указывая что была
выбрана. Тогда нажмите F4 ("Add Corner (Добавить Угол)") добавьте новый угол, с "резиновыми" сторонами
к смежным углам. Левым кликом, разместите его. Это работает только с прямыми сторонами, а не с дугами. 
Поэтому дугу сначала нужно преобразовать в прямую линию (см. ниже). 

� Вы можете удалить угол, выбрав его и нажав F5 ("Delete Corner (Удалить Угол)"). Угол исчезнет, и смежные
стороны будут заменены одной стороной между смежными углами. 

� Вы можете изменить стиль стороны, выбрав её и затем нажав F1 (Straight Line (Прямая линия)), F2 ( ("Arc CW 
(Дуга по часовой стрелке)") или F3 ("Arc CCW (дуга против часовой стрелки)"). 

� Вся контурная линия платы может быть удалена, выбором любой стороны или угла, и нажатием F8 ("Delete 
Outline (Удалить контур)"). 
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5.11 Корпуса 

5.11.1 Анатомия корпусов 

Каждая PCB включает один или более корпусов. Каждый корпус содержит следующие элементы: 
• Reference designator (позиционное обозначение), такое как "U1" - которое обычно назначается в схеме и

должно быть уникальными. 
• Package identifier (идентификатор упаковки), такой как "DIP14" – корпуса имеют различные физические

упаковки и проектировщик PCB должен знать, какая упаковка будет использоваться для каждой корпуса, 
потому что это определит футпринт footprint  корпуса в PCB. 

• Pins (выводы) - электрические выводы корпуса. Выводы идентифицируются названием (обычно является
числом), которое приложено к позиционному обозначению, такое как "U1.4" для четвертого вывода в корпусе
U1. Путь наименования выводов будет зависеть от корпуса. Все выводы должны иметь уникальные названия
даже в случае их взаимозаменяемости, как у  резистора, например. 

• Mounting holes – Монтажные отверстия могут использоваться для крепления корпуса к PCB. Крепление, 
такое как винт может требовать отверстия или корпус может иметь встроенные крепления, такие как PressFIT 
(прессованная посадка) или паянные наконечники. Монтажные отверстия могут быть изолированными, или
могут иметь контактную площадку и быть покрыты металлом. Зачастую используются монтажные отверстия
покрытый металлом, что позволяет сделать подключение электрической цепи, такой как заземление экрана
соединителя, к корпусу. Поэтому, FreePCB обрабатывает все установочные отверстия как выводы. Для
названия монтажных выводов обычно используют числа, которые выше чем числа, используемые для
обычных выводов. Например, 9-ти выводной соединитель D-SUB с 2 монтажными отверстиями имел бы
монтажные вывода под номером 10 и 11. 

• Footprint - Это шаблон медных контактных площадок и других элементов, которые станут частью PCB 
размещения.  

Фактически, когда мы используем термин "корпус" во время схемы компоновки PCB, мы обычно подразумеваем
отпечаток корпуса - футпринт, потому что это - то, с чем мы работаем в схеме компоновки. Фактический корпус
— это электронный компонент, который будет припаян к футпринту, когда PCB будет транслирована. 
Футпринты имеют следующие элементы: 

• Pads (контактные площадки) - Это медные элементы, к которым подпаиваются выводы. Существует два
типа:  

o  Контактные площадки с отверстием (Through-hole pads) имеют отверстия, через которые проходят 
ножки штыревых компонентов перед пайкой. Для контактной площадки с отверстием  на
многослойной плате обычно имеются площадки на каждом медном слое, которые, соединённые
вместе, образуют сплошную металлизацию отверстия. Такое расположение называют стеком
контактных площадок (padstack). Контактные площадки с отверстием обычно бывают круглыми или
квадратными. Квадратная контактная площадка обычно используется для 1-го вывода, а круглые
площадки для остальных. 

o Площадки для поверхностного монтажа (Surface-mount pads) не имеют отверстия, и находятся
только на одном уровне. Однако, они все еще представлены стеком контактных площадок,  хотя это
довольно простой стек, только с одной площадкой. Площадки SMT почти всегда являются  
прямоугольными. 

• Контур корпуса (part outline) - Это графическое представление корпуса на слое шелкографии.  
• Позиционное обозначение (reference text) - Это текстовая строка для позиционного обозначения на слое 

шелкографии.  
• Другой текст (other text) - Текстовые строки, такие как номера выводов, и т.д. Может быть добавлен к слою 

шелкографии.  
• Прямоугольник выбора (selection rectangle) - невидим, пока корпус не выбран и показан в цветном слое 

выбора (обычно белый), когда корпус выбран. Это определяет границу корпуса в целях выбора. 
• Начало координат (origin )- Это невидимая точка, которая служит началом координат для внутренней системы 

координат футпринта. Когда футпринт будет создан, позиция каждого элемента будет определена
относительно начала координат. Когда футпринт перетаскивается во время редактирования, он будет
"прикреплен (attached)" к курсору в начале координат. Когда позиция корпуса отображена в строке состояния
или в диалогах, это - фактически позиция начала координат. Центр вывода 1 часто используется как начало
координат. 
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Некоторые типичные футпринты показаны ниже. 

На копии экрана выше, U1 является IC в 20-ти выводной DIP упаковке, имеющей контактные площадки с
отверстиями. Корпус (или компонент) размещён с верхней  стороны платы и, таким образом, элементы шелкографии
футпринта находятся в верхнем слое шелкографии. Корпус был выбран для редактирования, таким образом этот
выбранный  прямоугольник видим. Так как верхний медный слой является активным слоем разводки, его верхние
площадки показаны в цвете верхнего медного слоя.  
U2 является IC в 20-ти выводном корпусе PLCC для поверхностного монтажа и также распложена на верхней стороне
платы. Контактные площадки показаны в цвете для верхнего медного слоя. C10 является SMD конденсатором в
миниатюрной упаковке. R12 является SMD резистором в отличной миниатюрной упаковке, на нижней (сторона паек) 
стороне PCB. Его контактные площадки показаны в цвете нижнего медного слоя, и его элементы шелкографии
находятся на нижнем слое шелкографии. Кроме того, его позиционное обозначение отображается зеркально, так, 
чтобы его можно было прочесть с нижней стороны платы.  
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5.11.2 Список корпусов (Partlist)  

В FreePCB, все корпуса в проекте содержатся в структуре данных, названной partlist , который пуст, когда проект
начинает создаваться. Обычно, корпуса добавляются к partlist в процессе импорта списка соединений (netlist file) из
редактора схемы. Это будет рассмотрено в  Разделе 5.14: Импортирование Файлов Списка соединений. Вы можете
смотреть или редактировать partlist, пункт выбрав Parts... из меню Project, который вызывает диалог View/Edit Part 
List, как показано ниже.  

Для каждого корпуса в проекте указано позиционное обозначение, упаковка и футпринт. Отдельные корпуса можно
выбрать из списка, кликая по ним, или несколько корпусов можно выбрать, кликая по ним, удерживая клавишу CTRL. 
Partlist можно редактировать, используя кнопки Add New Part, Edit Selection и Delete
Selection(s). Они будут описаны в следующих разделах.  
Важное примечание: Вы должны быть внимательными, изменяя partlist, по двум причинам. 

• Если Вы работаете из схемы, редактирование partlist может ввести несоответствия между схемой и PCB. Это
не должно быть проблемой, если Вы только назначаете футпринты, но может внести большую путаницу, если
Вы будете добавлять и удалять корпуса, или изменять позиционные обозначения. Если Вы действительно
производите какие-нибудь подобные изменения, Вы должны отразить их обратно в схему (back-annotate). 

• Как только Вы нажимаете OK в диалоге View/Edit Part List, изменения, которые Вы производили, не могут 
быть уничтожены функцией Undo от меню Edit. Поэтому, желательно сохранить копию своего проекта 
заранее. 
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5.11.3 Редактирование корпусов (Editing Parts) 

Корпуса могут быть добавлены, удалены или изменены при помощи диалога View/Edit Part List (показано выше) или 
окна размещения, используя методы, описанные ниже. 

• Новые корпуса могут быть добавлены к partlist, используя или выбор Part из меню Add, или кнопку Add New 
Part в диалоге View/Edit Part List. Любой метод вызывает Add/Edit Part диалог, показанный ниже 
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o Новый корпус создаётся путем ввода позиционного обозначения в поле Reference и выбором
футпринта из древовидного списка, занимающего левую сторону диалога. Это дерево содержит
список всех файлов в выбранной библиотечной папке. Вы можете изменить библиотечные папки, 
используя кнопку Browse... Есть также вход для "локального кэша (local cache)", который содержит
все футпринты, которые уже загружены в проект. Вы можете развернуть библиотеку, нажимая
символ "+", расположенный рядом с её названием. В примере выше, развернута библиотека
C:\FreePCB\lib\sm_plcc.fpl. Футпринт "LCC-24" выбран и показан в области окна предварительного
просмотра. Его имя автоматически введено в поле Footprint диалога. В качестве альтернативы, Вы
можете только ввести название футпринта непосредственно в это поле. 

o Если радиокнопка в области Position установлена на канал Drag to position, Вы сможете вручную
позиционировать новый корпус, после того, как нажмете OK. Если Вам необходимо позиционировать
компонент явно, установите радиокнопку на канал Set и поля X, Y, Angle и Side в области Position. 
Тогда, после нажатия OK, новый корпус будет помещен в позицию, которую Вы предварительно
установили. Если Вы выберете Offboard, то корпус будет помещен слева от начала координат 
(origin). 

• Корпуса могут быть удалены или отредактированы из окна размещения, выбирая их, и используя
функциональную клавишу или контекстное меню. С выбранным корпусом доступны следующие пункты
меню: 

o F1 ("Edit Part")  - вызывает диалог Add/Edit Part, который показан ранее, за исключением того, что
поля Reference и Footprint в нём уже заполнены. Вы можете использовать этот диалог, чтобы
изменить футпринт или позицию корпуса.  

o F3 ("Glue Part")  - "приклеивает (glues)" корпус на месте так, чтобы он не мог быть случайно
перемещенным. Для корпуса, которая уже приклеен, эта команда изменяется так, чтобы "Отклеить
корпус (Unglue Part)".  

o F4 ("Move Part")  – это обычно используемая команда. Она инициализирует перемещение корпуса с
курсором. Затем левым кликом можно закрепить корпус в новой позиции. Во время перемещения
следующие функциональные клавиши являются активными: 

� F2 ("Change Side") – переключает компонент из верхней стороны в нижнюю, или наоборот  
� F3 ("Rotate Part")  - выполняет 90º вращение корпуса по часовой стрелке 

o F8 ("Delete part")  - удаляет корпус из partlist. Предварительно Вас спросят, желаете ли Вы также 
удалить все ссылки на корпус из списка соединений. Выберите вариант "Да", если Вы не собираетесь
вернуть эти корпуса обратно в более позднее время.  

o F9 ("Recalc. Ratlines") - повторно вычисляет ratlines для всех соединений, подключенных с
корпусом, чтобы минимизировать их длину. По умолчанию, эта команда выполняется автоматически
каждый раз, когда корпус перемещен.  

o Корпуса также могут быть удалены или отредактированы с помощью диалога View/Edit Part List, 
следующим образом. 

o Вы можете удалить один или более корпусов из списка, кликая по ним (для множественного выбора 
нужно удерживать в нажатом состоянии клавишу CTRL), а затем нажав кнопку Delete Selection(s). 
Ссылки на корпус(а) не будут удалены из списка соединений.  

o Единственный корпус может быть отредактирован, используя кнопку Edit Selection, которая 
вызывает диалог Add/Edit Part, показанный ранее. Главная причина для использования диалога
View/Edit Part List состоит в том, чтобы сразу редактировать корпус и назначить ему отсутствующий
футпринт, вместо того, чтобы выбирать его в окне размещения и использовать меню
функциональных клавиш. Корпус без футпринта не может быть отображен и, соответственно, не
может быть выбрана в окне размещения. Эта ситуация часто возникает, при импортировании файлы
списка соединений, как говорилось в Разделе 5.14: Импортирование Файлов Списка соединений. 
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5.11.4 Перемещение или изменение размеров позиционного обозначения  

Позиционное обозначение для корпуса можно переместить, выбрав
его и нажав F4 ("Move Ref Tex"). Затем Вы можете перетащить его
к новой позиции. Во время перемещения позиционное обозначение
можно вращать на 90º по часовой стрелке, нажимая F3 ("Rotate Ref 
Text").  
Вы можете изменить размер текстовой строки, выбрав её и нажав
F1 ("Set Size"). Это вызывает диалог, показанный ниже. Вы можете
изменить высоту и штриховую ширину символа. Если Вы выберете
Use default for height, то штриховая ширина будет автоматически
установлена в 1/10 высоты. 

5.11.5 Создание невидимого позиционного обозначения  

Если Вы устанавливаете символьную высоту позиционного текста к "0", позиционное обозначение станет невидимым. 
Чтобы сделать его снова видимым, выберите корпус и щелкните правой кнопкой мыши, затем выберите Set Ref. Text 
Size из меню контекста, которое появится. Затем установите символьную высоту в ненулевое значение.  
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5.12 Монтажные отверстия  

Монтажные отверстия используются, чтобы прикрепить PCB к внешней структуре, такой как скобка или корпус. В
FreePCB монтажное отверстие есть корпус, который состоит из единственного выводного отверстия. Padstack для
вывода ножки может включать площадки, которые можно использовать для подключения монтажного отверстия к
соединению, точно так же как любой другой штыревой вывод. Фактическое отверстие в padstack будет показано в
цвете для слоя сверловки. Если у монтажного отверстия есть площадки, то они будут показаны в цвете для их медного
слоя.  
Так как монтажное отверстие является корпусом, оно может быть добавлено в partlist как любой другой корпус. Оно
может быть включено в файл списка соединений, или его можно добавить, используя пункты меню Add > Part или
Project > Parts.... Некоторые монтажные отверстия различных размеров включены в библиотечный файл
th_mounting_hole.fpl.  
Примеры монтажных отверстий показаны ниже. H5 не имеет контактной площадки, в то время как у H6 есть круглая
площадка, а у H7 квадратная площадка. 

Используя мышь для выбора монтажного отверстия, Вы можете выбрать или корпус или вывод (контактную
площадку). Если Вы хотите переместить отверстие, то выбирайте корпус. Если хотите добавить подключение к
соединению, то выбирайте вывод. Прямоугольники выбора для корпуса и вывода - почти одинакового размера. Так
как у вывода есть приоритет, то первым будет выбран он. Чтобы выбрать корпус, вы должны щёлкнуть ещё раз. Что
именно выбрано в данный момент можно определить по внешнему виду прямоугольника выбора и содержимому
строки состояния. Ниже, на левом изображении показана выбранная контактная площадка вывода H6. На правом
изображении показан выбранный корпус для H6, после повторного щелчка. 

Выбрана площадка                                                                                    Выбран корпус 

Выбор позиционного обозначения для монтажного отверстия может оказаться трудным, если оно наложится на
площадку или отверстие для вывода. В этом случае нажатие мышки будет выбирать либо вывод, либо корпус. Чтобы
обойти это, можно при помощи маски выбора отключить выбор корпусов и/или вывода.  
Так как в позиционном обозначении монтажного отверстия нет большой необходимости, Вы можете сделать его
невидимыми, выбирая его и используя F1 ("Set Size"), чтобы обнулить высоту символов. Вы можете также установить
высоту символа, выбирая корпус и используя пункт Set Ref. Text Size из меню правой кнопки мыши. Это же меню
позволит Вам сделать позиционное обозначение видимым, если Вы того захотите. 
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5.13 Соединения, Ratlines и Разводка  

5.13.1 Соединения 

Соединение устанавливает ножки, которые будут соединены вместе на PCB. У каждого соединения должно быть
уникальное имя. Эти имя может быть описательным (таким как "GND" или "video_in") или просто отличительным
(таким как "N06744"). В FreePCB название соединения ограничено по длине 40-ка символами, и может содержать
специальные символы. Каждый вывод в соединении идентифицирован строкой, состоящей из позиционного
обозначения корпуса, содержащего вывод, символа "." и имени вывода.  
Соединения обычно читаются из файла списка соединений, который также включает список корпусов проекта (см. 
Раздел 5.14: Импортирование Файлов Списка соединений). Два примера связей показаны ниже.  
Name: N00834 
Pins: U2.4 JP1.9  

Name: GND 
Pins: U2.7 C2.2 U3.3 C1.2 U1.19 Y1.4 JP5.3 JP4.10  
JP4.4 R2.2 C4.2 JP1.10 JP1.5 R1.2 C3.2 U1.8  
JP6.2 JP3.3 JP2.3 JP3.10 JP3.4 JP3.6 JP3.8 JP2.10  
JP2.8 JP2.2 JP2.4 JP2.6 JP3.2  

5.13.2 Список соединений  

В FreePCB, вся информация о
соединениях хранится в
структуре данных, названной
списком соединений. Этот
список можно просмотреть и
изменить, выбирая Nets из
меню Project. Это вызывает
диалог View/Edit Netlist. 
Этот диалог содержит список
всех связей в проекте. Для
каждой связи показано название
Name, число подключенных
выводов Pins,  заданная по
умолчанию ширина дорожки
Width , ширина площадки Via 
W и диаметр отверстия Hole
переходов.  
Переключатель рядом с каждым
названием определяет
видимость соединения. Если
блок видимости не выбран, то
ratlines для этого соединения не
будут отображены в окне
размещения. Это полезно, когда
Вы работаете с определеным
соединением и не желаете
отвлекаться на другие ratlines. 
Кнопка Make all 
visible/invisible позволяет
одновременно 

включить/выключить видимость всех соединений. 
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В примере выше, ширина дорожек и переходов для большинства связей установлены в нуль. Это указывает, что по
умолчанию должны использоваться проектные значения. Ширина для VCC и GND была установлена в ненулевое
значение, которые будут использоваться для дорожек в этих соединениях. Ширину можно изменить, выбрав одну или
более связей, и кликнув по кнопке Change widths. Это вызыает следующий диалог, который позволяет 
устанавливать новые значения ширины. 

Вы можете выполнить более обширное редактирование одиночного соединения, выбрав его и нажимая кнопку Edit в
области Single net selected, которая вызывает окно: 

 
Здесь Вы можете изменить имя, видимость и ширину соединения, а также добавить или удалить выводы. 
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5.13.3 Ratlines  

Обычно, цепи можно соединить последовательностью трасс, где каждая трасса соединяет два вывода. Для любого
соединения, содержащего больше чем 2 вывода, будет несколько способов, которыми эти выводы можно соединить. 
Например, цепь, включающую выводы U1.1, U2.2 и U3.3, может соединить как: 

(U1.1 к U2.2) и (U2.2 к U3.3) ИЛИ  
(U1.1 к U3.3) и (U2.2 к U3.3) ИЛИ  
(U1.1 к U3.3) и (U1.1 к U2.2) 

Для каждого цепи FreePCB автоматически генерирует ряд подключений, которые пытаются минимизировать  полное
расстояние между подключенными выводами. Эти подключения показаны как ratlines между выводами. Пример двух
цепей, подключающих три корпуса, показан ниже. 

После большинства операций редактирования FreePCB повторно вычисляет ratlines для каждого затронутого
соединения. Это является самым очевидным, когда Вы перемещаете корпуса или добавляете медные области. 
Например, перемещение D1 вправо заставляет подключения изменяться, как показано ниже. 

Чтобы развести цепь, можно выбрать каждую ratline и трассировать её как дорожку. В качестве альтернативы, можно
игнорировать ratlines и развести трассы от ножки до ножки, используя обрубленные дорожки stub traces. Вы можете
также использовать дорожки ответвления branching traces. Каждый из этих методов описан более подробно ниже.  
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5.13.4 Изменение Ratlines  

Большую часть времени, Вы будете использовать ratlines, который вычисляет FreePCB. Однако, могут быть ситуации, 
когда Вы хотели бы иметь больше контроля над ratlines. FreePCB обеспечивает несколько опций редактирования для
ratlines: 

� ratline можно блокировать, выбрав её, и нажав клавишу F3 ("Lock Connect"). Внешний вид ratline при этом не
изменится, но "L" в её описании на строке состояния будет показывать, что подключение блокировано. 
Блокированное подключение не будет удалено, когда FreePCB повторно вычислит ratlines. Блокированное
подключение можно разблокировать выбрав его и нажав клавишу F3 ("Unlock Connect"). 

� Подключение можно добавить к соединению, выбрав площадку для стартового вывода подключения, и нажав
клавишу F4 ("Connect Pin"). Затем вы можете протянуть ratline к другому выводу на той же самой цепи. 
Обычно необходимо блокировать ratline после добавления, иначе это подключение, скорей всего, будет
удалено программой в следующий раз, после повторного вычисления ratlines. Таким же образом можно
сделать подключение к неназначенному выводу, когда новый вывод добавляется к цепи. 

� ratline можно удалить из цепи, выбрав её, и нажав F7 ("Delete Connect"). Если ratline блокирована, Вам будет
предложено разблокировать её. Если Вы удалите ratline и не замените это, добавляя и блокируя другую, то
эта, скорей всего, появится вновь в следующий раз, когда ratlines будут повторно вычислены. 

� ratlines для каждого соединения обычно повторно вычисляются после каждой операции редактирования, 
которая затрагивает соединение. Исключением являются те операции, которые непосредственно изменяют
ratlines, такие как описанные выше. Чтобы вынудить FreePCB восстановить ratlines, нажмите F8 ("Recalc. 
Ratlines"). Область видимости этой команды зависит от того, кокой элемент был выбран, когда Вы нажали F8: 
� Если ничто не было выбрано, ratlines будут восстановлены для каждого соединения в проекте. 
� Если корпус был выбран, ratlines будут восстановлены для каждого соединения, прикрепленного к

корпусу. 
� Если вывод, ratline, или дорожка были выбраны, ratlines будут восстановлены для соединения, 

прикрепленного к тому выводу, ratline или дорожке. 
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5.13.5 Разводка с Ratlines  

Этот метод состоит из преобразования ratlines в медные дорожки. Дорожки состоят из одного или более
прямолинейных сегментов, подключенных вместе с изломом в их точках подключения. Если два смежных сегмента
будут на различных слоях, то переход будет помещен в излом между ними.  
Чтобы начать разводку, выберите ratline, нажимая на неё. Она изменит свой цвет на цвет выбора, указывая, что была
выбрана. Затем нажмите клавишу F4 ("Route Segment"). Это позволит начать сегмент дорожки от ближайшего к
курсору, на момент нажатия F4, вывода. Изображение ниже показывает сегмент, начатый от вывода 1 компонента JP6.  

Обратите внимание, что сегмент находится на верхнем
медном слое, потому что это слой был активным на
момент начала разводки. Вы можете изменить активный
слой, нажимая одну из цифровых клавиш от "1" до "8", 
которые представляют доступные слои в порядке от
верхнего до нижнего. Например, для платы с четырьмя
слоями, "1" выберет верхний медный слой, "2" выберет
внутренний 1 слой, "3" выберет внутренний 2 слой, и 
"4" выберет нижний слой меди. Если Вы, во время
разводки, измените слой, то это приведёт к
немедленному переключению на новый активный
уровень. Во время разводки сегмента действует сетка
трассировки Routing Grid . Если стартовая точка для
сегмента будет на сетке трассировки, то угол излома 
Snap Angle также будет действовать. 

Левый клик поместит излом в позицию курсора, 
закончит первый сегмент в изломе и инициализирует
разводку второго сегмента от излома, как показано на
следующем изображении. Мы также переключили слои, 
нажав числовую клавишу "4", так, чтобы новый сегмент
дорожки был перенесён на нижний слой меди. 
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Левый-клик еще раз, чтобы поместить следующий излом и
запустить разводку следующего сегмента. Таким образом Вы
можете развести дорожку, состоящую из подключенных
многих сегментов на многих слоях. Изображение слева
показывает нашу завершенную разводку дорожки с
несколькими сегментами на различных слоях и с 2-мя
переходами. 

Чтобы закончить дорожку, нажмите клавишу F4 ("Complete 
Segment"), разведя последний сегмент. Сегмент будет
автоматически доведён до конечного вывода дорожки. В
качестве альтернативы, Вы можете поместить курсор на
последнем выводе и сделать левый клик. Полученная
окончательная трасса показана слева. 

В процессе разводке дорожки, Вы можете щелкнуть правой кнопкой мыши, чтобы прекратить разводку прежде, чем
дорожка будет закончена. Неразведённая часть цепи будет показана как ratline между последним изломом и конечным
выводом. Вы можете закончить дорожку и позже, выбрав ratline, разводить её с любого конца. У дорожки может быть
множественные неразведённых частей, как показано ниже. 

Вы можете изменить конечный вывод частично неразведённой дорожки, выбрав ratline и нажав клавишу F5 ("Change 
Pin"), a затем просто протянуть ratline к другому выводу той же цепи. 

5.13.6 Удаление 
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5.13.7 Разводка обрубленных дорожек (Stub Traces) 

Помимо дорожек, соединяющих выводы компонентов, FreePCB поддерживает обрубленные дорожки. Это дорожки, 
которые начинаются на выводе одного компонента, но не заканчиваются на выводе другого. Вместо этого они просто
обрываются или завершаются переходным отверстием (Via). Обрубленные дорожки используются главным образом
для подключения выводов SMT к медным полигонам, которые будут описаны в Разделе 5.15: Полигоны. Чтобы
создать обрубленную дорожку, выбираем стартовый вывод и нажимаем клавишу F3 ("Start Stub"), чтобы запустить
рисование сегмента дорожки. Сегмент будет формироваться в текущем активном слое, если вывод, будучи выводом
SMT, не расположен в другом слое. В последнем случае активный слой автоматически изменится на слой вывода
SMT. При помощи левого-клика разместим излом дорожки. Если требуется более более одного сегмента добавьте
дополнительный излом. Обрубленная дорожка, завершается щелчком правой кнопки мыши. Дорожка закончится и в
её конец автоматически будет добавлено переходное отверстие. Если Вам не нужно переходное отверстие, то
выберите его и нажмите F3 ("Delete Via"). Если переход подключается к медному полигону на той же стороне платы, 
где расположен стартовый вывод, будет сформирован тепловой барьер соединения площадки переходного отверстия и
медной области. Пример обрубленной дорожки, подключающей вывод компонента к медному полигону, показан
ниже. Тепловой барьер представлен символом "X", расположенный поверх переходного отверстия и имеющий цвет
ratline. 

Обрубленные дорожки могут также использоваться для разводки между выводами компонентов. Для этого начните  
разводку обрубленной дорожки как описано выше. И вместо того, чтобы закончить дорожку, щелкая правой кнопкой
мыши, направьте дорожку к выводу, который принадлежит той же цепи или не принадлежит ни какой цепи. Когда Вы
поместите оконечную точку сегмента дорожки где-то на конечном выводе, обрубленная дорожка будет автоматически
преобразована в нормальную дорожку между выводами. Это может быть очень полезно, если Вы проектируете PCB 
"на лету", без списка соединений. 
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5.13.8 Разводка ответвления от дорожки (Branching Trace) 

Как только дорожка создана, Вы можете добавить к ней ответвление, которое соединит существующую дорожку с
другими выводами одной цепи. На рисунке, показанном ниже, изображена основная дорожка между выводами с
обоих концов JP3 и ответвление между средним выводом и изломо (vertex) в основной дорожке. 

Есть два способа добавить ответвление к дорожке. Это можно сделать выбрав излом в дорожке и нажав клавишу F3 
("Connect PIN"). Затем протянуть ratline от излома до вывода, который Вы хотите подключить, и развести дорожку как
обычно. Второй способ предполагает разведение обрубленной дорожки от вывода до излома существующей дорожки.  
Обратите внимание, что нет никаких видимых различий между основной дорожкой и дорожкой ответвления. Однако, 
различия будут в некоторых операциях редактирования. Например, если Вы удалите дорожку ответвления, то
основная дорожка останется. Однако, если Вы удалите основную дорожку, то исчезнут обе дорожки. Вы должны
помнить это, когда создаёте дорожку ответвления, которую хотели бы изменить позже.  
Вы можете отличать независимые сегменты и изломы на основной дорожке или ответвлении, выбирая их и смотря на
строку состояния. Основная дорожка между выводами будет описан как дорожка (trace), в то время как дорожка
ответвления будет описан как переход (branch). Излом, к которому подключено ответвление, называют "целевым
изломо (tee-vertex)". Если Вы выберете целевой излом, то отображение строки состояния закончится параметром, 
таким как ("T1234"), где "T" указывает, что целевой излом и "1234" является идентификатором для цели. Дорожки
ответвления, которые соединяются с этой целью, покажут тот же самый параметр в строке состояния.  
Помимо дорожек между выводами компонентов, ответвления могут быть добавлены к обрубленным дорожкам и даже
к другим дорожкам ответвления.  

5.13.9 Переходы (Vias) 

Переходные отверстия или попросту переходы используются, чтобы соединить медные элементы на различных слоях. 
В FreePCB они считаются частью дорожки, и могут появиться только в изломе дорожки. Переходы могут быть
вынужденными forced или невынужденный unforcsd. Невынужденный переход генерируется автоматически, во
время разводки дорожки. Это будет происходить всякий раз, когда появится необходимость подключить сегменты
дорожки на разных слоях. Если дорожку изменить таким образом, что необходимость в переходе отпадет, то переход
автоматически будет удален. Обычно, именно такое поведение является более естественным. Однако, бывают
моменты, когда хотелось бы оставить переходное отверстие между смежными сегментами дорожки, которые
находятся на одноименном слое. Например, Вы хотели бы, с помощью перехода, подключить дорожку к медному
полигону. В этом случае, можно "вызвать" переход, выбрав соответствующий излом и нажав клавишу "f". 
Вынужденный переход не будет удаляться автоматически. Тип перехода можно определить выбрав его и посмотрев
на строку состояния, которая покажет ("F") для вынужденного перехода. Вынужденный переход можно сделать
невынужденным, нажав клавишу "u". Имейте в виду, что переходы, которые созданы автоматически в конце
обрубленных дорожек, вынужденные по умолчанию.  
Когда переходы созданы, значения по умолчанию будут использоваться для диаметров контактных площадок и
отверстий. Это будут значения установленные по умолчанию для цепи или, если эти значения не были определенны, 
будут использоваться проектные значения по  умолчанию. Размеры площадки и отверстия для переходов могут быть
изменены с помощью диалога Set Trace and/or Via Widths, который описан в следующем разделе. 
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5.13.10 Изменение дорожек 

Дорожку можно изменить, выбрав её сегменты, изломы или ratlines и используя команды функциональных клавиш. 
Вы можете выбрать всю дорожку, кликнув по её сегменту или излому и удерживая клавишу "t". Вы можете выбрать
всю цепь, кликнув по сегменту, излому или выводу компонента и удерживая клавишу "n".  
Вот описания команд функциональных клавиш: 

� С выбранной ratline: 
� F1 (Set Width) — появляется диалог Set Trace and Via Widths, который описан ниже. 
� F3 (Lock/Unlock Connect) - блокирует или разблокирует ratline. Блокированная ratline не может быть

удалена опрерацией "Recalc. Ratlines". 
� F4 (Route Segment) — начинает разводку дорожки, которая заменяет ratline. 
� F5 (Change Pin) - доступно только если у Вас есть выбранная ratline цепи с частично разведённой

дорожкой. Эта клавиша позволяет вывод с которым соединяется ratline. 
� F7 (Delete Connect) - удаляет подключение из цепи.  
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для цепи, чтобы минимизировать их длину. 

� Пока разводится сегмент:  
� F4 (Complete Segment) - доводит сегмент до конечной точке ratline и прекращает разводку. 

� С выбранным медным сегментом: 
� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже. 
� F2 (Change Layer) — вызывает диалог, который позволяет Вам изменять слой сегмента, дорожки или

соединения.  
� F5 (Unroute Segment) — отменяет разводку сегмента, превращая его в ratline. 
� F6 (Unroute Trace) — отменяет разводку дорожки, превращая её в ratline. 
� F7 (Delete Connect) - удаляет подключение из цепи. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для цепи, чтобы минимизировать их длину. 

� С выбранным изломом: 
� F1 (Set Position) — вызывает диалог, который позволяет явно редактировать координаты X и Y излома.  
� F4 (Move Vertex) — позволяет перемещение излома.  
� F5 (Delete Vertex) — удаляет излом, отменяя разводку смежных сегментов и преобразуя их в ratline.  
� F6 (Unroute Trace) — отменяет разводку дорожки, преобразуя её в ratline.  
� F7 (Delete Connect) - удаляет подключение из цепи.  
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для цепи, чтобы минимизировать их длину. 

�  С выбранным конечным изломо обрубленной дорожки: 
� F1 (Set position) — вызывает диалог, который позволяет явно редактировать координаты X и Y излома.  
� F2 (Add Segment) — стартует разводку нового сегмента от излома.  
� F3 (Add/Delete Via) - добавляет переход, или удаляет тот, который уже присутствует.  
� F4 (Move Vertex) — позволяет перемещение излома.  
� F5 (Delete Vertex) - удаляет излом, отменяет разводку смежных сегментов, преобразуя их в ratline.  
� F7 (Delete Connect) - удаляет всю обрубленную дорожку. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минимизировать их длину. 
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� С полностью выбранной дорожкой: 
� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже. 
� F2 (Change Layer) — вызывает диалог, который позволяет Вам изменять слой дорожки или соединения. 
� F6 (Unroute Trace) — отменяет разводку всей дорожки, преобразуя её в ratline. 
� F7 (Delete Connect) - удаляет подключение из цепи. 
� F8 (Recalc. Ratlines) - повторно вычисляет ratlines для соединения, чтобы минимизировать их длину. 

�  С полностью выбранной цепью: 
� F1 (Set Width) — вызывает диалог Set Trace and Via Widths, который описан ниже.  
� F2 (Change Layer) - вызывает диалог, который позволяет Вам изменять слой цепи.  
� F3 (Edit Net) - добавляет переход, или удаляют тот, который уже присутствует.  
� F8 (Recalc. Ratlines) - повторно вычисляют ratlines для соединения, чтобы минимизировать их длину. 

Ниже показан диалог Set Trace and Via Widths, который вызывается, нажатием клавиши F1 в присутствии
выбранной цепи, дорожки, сегмента или излома. 

Этот диалог позволяет изменять размеры дорожки и перехода для сегмента, дорожки или цепи. Вы можете также
установить новые размеры, принятые по умолчанию для цепи так, чтобы они использовались для любой будущей
разводимой цепи. 

5.13.11 Смена выводов (Swapping Pins) 

Вы можете поменять выводы в одном корпусе, выбрав один из них, удерживая клавишу "s", и нажав на другой вывод. 
После этого всплывёт окно, в котором Вы должны будете подтвердить обмен или отказаться от него. 
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5.14 Импорт Файлов Списка соединений  

5.14.1 Файлы Списка соединений  

После создания нового проекта, необходимо добавить в него корпуса и соединения путём импорта файла списка
соединений. Этот файл обычно генерируется схемным редактором, но, в случае необходимости, может быть создан
вручную. Типовой файл списка соединений показан ниже. Этот файл будет использоваться позже в учебнике (см. 
Раздел 7: Учебник). В данном случае, этот файл был сгенерирован в формате PADS-PCB схемным редактором Orcad 
Capture. Этот формат стандартный и поэтому большинство схемных редакторов его поддерживают. Но самое важное, 
что программа FreePCB может его читать. 

*PADS-PCB*  
*PART*  
C1 CHIP_D  
C2 C1206  
C3 CHIP_B  
C4 CHIP_B  
D1 CHIP_B  
JP1 5X2HDR-100  
JP2 5X2HDR-100  
JP3 5X2HDR-100  
JP4 5X2HDR-100  
JP5 3X2HDR-100  
JP6 1X2HDR-100  
R1 C1206  
R2 C1206  
R3 C1206  
U1 28DIP300  
U2 dip14  
U3 К - 220  
Y1 8DIP300  

*NET*  
*SIGNAL* N00834  
U2.4 JP1.9  
*SIGNAL* GND  
U2.7 C2.2 U3.3 C1.2 U1.19 Y1.4 JP5.3 JP4.10  
JP4.4 R2.2 C4.2 JP1.10 JP1.5 R1.2 C3.2 U1.8  
JP6.2 JP3.3 JP2.3 JP3.10 JP3.4 JP3.6 JP3.8 JP2.10  
JP2.8 JP2.2 JP2.4 JP2.6 JP3.2  
*SIGNAL* N01846  
Y1.5 U1.9  
*SIGNAL* VCC  
U2.14 Y1.8 JP5.2 U3.2 C1.1 U1.20 JP1.8 JP1.3  
*SIGNAL* N02621  
U2.6 U1.21  
*SIGNAL* N02594  
U2.3 U1.22  
*SIGNAL* N02122  
JP2.1 U1.18  
*SIGNAL* N01526  
JP4.6 U1.15  
*SIGNAL* N01538  
JP4.8 U1.14  
*SIGNAL* N02277  
U1.17 JP3.1  
*SIGNAL* N00797  
JP1.4 U2.1  
*SIGNAL* N00534  

D1.1 JP6.1  
*SIGNAL* N01300  
U1.27 JP5.5  
*SIGNAL* N01342  
U1.28 JP5.4  
*SIGNAL* N01384  
JP5.1 U1.1  
*SIGNAL* N00809  
U2.5 JP1.7 U1.23  
*SIGNAL* N03791  
C3.1 R1.1 JP2.7 U1.3  
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*SIGNAL* N01292  
U2.2 U1.24 JP1.2  
*SIGNAL* N03798  
C4.1 R2.1 JP3.7 U1.2  
*SIGNAL* N04614  
U1.13 JP3.5  
*SIGNAL* N04589  
JP2.5 U1.12  
*SIGNAL* N06956  
C2.1 U3.1 R3.2  
*SIGNAL* N07325  
R3.1 D1.2  
*END*  
 
Распечатка достаточно очевидна. В секции файла *PART* присутствует строка для каждого корпуса, содержащая
позиционное обозначение (такое как "U1") и идентификатор упаковки (такой как "28DIP300"). В секции файла *NET* 
перечислены цепи, где каждая цепь начинается с ключевого слова *SIGNAL*, сопровождаемого названием цепи. В
следующей строке перечисляются все ножки подключенные к данной цепи.  
Для того, чтобы программа FreePCB правильно назначила футпринты, идентификатор упаковки для каждого корпуса
должен соответствовать футпринту в одной из библиотек FreePCB. Скорей всего, идентификаторы упавки должны
быть назначены Вами в явном виде. Чтобы сделать это, существует три способа:  

1. В схемном редакторе, назначить идентификатор упаковки как атрибут для каждого корпуса, используя
идентификаторы упаковки соответствующие футпринтам FreePCB. Затем необходимо экспортировать список
соединений и импортировать его в FreePCB.  

2. Экспортировать список соединений, отредактировать его при помощи текстового редактора, а затем
импортировать его в FreePCB.  

3. Экспортировать список соединений, импортировать его в FreePCB, а затем установить любые неправильные
или недостающие футпринты средствами FreePCB.  

 
Используйте первый способ, если Вы предполагаете вносить изменения в схему после начала разводки платы и
желаете импортировать эти изменения в FreePCB.  
 
Важное примечание: Чтобы программа FreePCB обнаружила футпринты, на которые ссылаются в файле списка
соединений, библиотеки, содержащие эти футпринты, должны находиться в заданной по умолчанию библиотечной
папке проекта (обычно..\lib). Если Вы используете футпринты из библиотек в других папках, таких как ..\lib_contrib 
или ..\lib_extra, необходимо переместить их библиотеки в ..\lib прежде, чем будет импортировн файл списка
соединений. Если Вы забыли это почему-то сделать, то всегда можно назначить футпринты позже, используя диалог
Project > Parts...
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5.14.2 Импорт файла списка соединений в проект  

Импортируем файл списка соединений, выбрав File > Import netlist.... Это вызовет следующий диалог. 

Выберите файл списка соединений, перемещаясь к правильной папке (в случае необходимости) и кликнув по имени
файла. Я обычно перемещаю или копирую файл списка соединений в проектную папку прежде, чем импортировать
его, но это не обязательно. Используя выбор в области Import , можно импортировать из файла либо корпуса, либо
цепи, либо и то и другое. В области Format можно выбрать формат файла (хотя в настоящее время поддерживается
только формат PADS-PCB). После того, как настройки сделаны, нажмите OK. 
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Если Вы импортируете файл списка соединений в пустой проект, без существующих корпусов или соединений, то
файл немедленно загрузится. Иначе, появится диалог Import Options, как показано ниже. 

Этот диалог определяет, как FreePCB обрабатывает конфликты, которые могут возникнуть при импорте файла списка
соединений в проект, который уже содержит корпуса и/или соединения. Эта ситуация обычно возникает, когда Вы
используете схемный редактор. Например, предположим, что после импорта начального списка соединений и
разводки некоторых цепей или всей платы, Вы произвели некоторые изменения в схеме и желаете импортировать те
изменения. С показанными настройками по умолчанию, любые корпуса, футпринты или цепи, который не
соответствует новому файлу списка соединений, будут изменены или удалены и проект будет точно соответствовать
файлу списка соединений. Обычно это наиболее желательный сценарий. 
Однако, предположим, что Вы добавили к проекту некоторые элементы (например, монтажные отверстия), которые
отсутствуют в файле списка соединений, и подключили их к каким-то цепям. В этом случае, скорей всего, захотите
выбрать For parts in project but not in netlist file : Keep parts and connections to nets (Для корпусов в проекте, но
не в списке соединений : Сохранить корпуса и подключения к цепям) с тем, чтобы не потерять эти корпуса и 
соединения. Или, если Вы изменили некоторые из футпринтов после импорта списка соединений, то, скорей всего, 
захотите выбрать For parts with different footprints in project and netlist file : Keep footprints (Для корпусов с
различными футпринтами в проекте и файле списка соединений : Сохранить футпринты) с тем, чтобы не 
вернуться назад к прежним футпринтам после импорта. Если Вы добавили цепи и желаете сохранить их, то, скорей
всего, захотите выбрать For nets in project that are not in netlist file : Keep nets (Для цепей в проекте, 
отсутствующих в файле списка соединений : Сохранить цепи). 
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При использовании этих опций надо быть очень внимательными, поскольку они могут вызвать неожиданные
результаты. Например, если неосторожно поменяете имя цепи в схемном редакторе, а затем импортировать список
соединений с опцией Keep nets, то в результате получим две цепи с различными названиями, где все выводы, за
исключением принадлежащих старой цепи, будут включены в новое соединение. Кроме того, будет утеряна вся
разводка новой цепи (см. примечание ниже). Или, если Вы изменили позиционное обозначение компонента в схемном
редакторе, и выбрали одну из опций Keep parts, то завершите операцию с двумя корпусами, вместо одного.  
Последние три опции в диалоге (Retain traces(Сохранить дорожки), Retain stubs(Сохранить обрубки), Retain 
areas(Сохранить области)), определяют, попытается ли FreePCB, анализируя списки выводов, сохранить
разведённые дорожки и медные области, имена соединений которых изменились в файле списка соединений. 
Как только Вы выбрали Import Options и кликнули OK, файл списка соединений загрузится, и все новые корпуса
будут помещены в окно размещения, слева от начала координат. Чтобы увидеть их, можно выделить All Parts в меню
View (или нажать клавишу "Home"). В результате окно размещения изменится так, чтобы сделать все компоненты
видимыми, как показано ниже. 
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Если FreePCB не сможет сопоставить один из идентификаторов упаковки с футприном из его библиотек, то появится
следующее сообщение. 

В этом случае необходимо проверить partlist, выбрав Parts... из меню Project. Это вызовет диалог View/Edit Part List, 
показанный ниже. 
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Имейте в виду, что футпринт U2, показанный как "??????", показывает, что программа FreePCB не смогла обнаружить
футпринт с идентификатором "dip14". Чтобы выбрать футпринт для корпуса, необходимо выделить его и нажать
кнопку Edit Selection, которая вызывает диалог Add/Edit Part, показанный ниже. 
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Вы можете назначить футпринт для U2, последовательно просматривая библиотечные файлы, пока не найдёте
нужный и затем, кликнуть по нему, скопировать название в поле Footprint диалога, как показано ниже. Если  название
футпринта известно, то его можно ввести непосредственно. 

Теперь футпринт для U2 будет появится в окне размещения, помещенный в любую позицию, установленную в
диалоге (X = 0, Y = 0 в примере выше). 

5.14.3 Экспорт файлов списка соединений  
Вы можете экспортировать файл списка соединений из проекта, используя пункт меню File > Export netlist.... В 
созданном таким образом файле, каждому компоненту будет сопоставлен футпринт, используемый в проекте. 
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5.15 Полигоны (Copper Areas) 

Для подключений на печатной плате, помимо дорожек, могут использоваться полигоны (обширные области меди). 
Они обычно используются для разводки цепей питания и земли, если те могут занять весь слой платы. В FreePCB для
всех полигонов должны быть назначены соответствующие цепи.  
Контур полигона рисуется замкнутой ломанной линией, подобно тому как рисуется граница платы. Полигон может
отображаться простой контурной линией, контурной линией с внутренней штриховкой, или контурная линия с
небольшой штриховки вдоль ее внутреннего края. Эти шаблоны штриховки используются только для визуализации, 
поскольку фактически на плате полигон будет выполнен из сплошной меди. FreePCB автоматически создаст зазоры
вокруг любых площадок или дорожек, которые проходят через медную область в том же самом слое. Однако, эти
зазоры не будут отображены, но будут созданы в файлах Gerber.  
Чтобы создать новый полигон, выберите Copper Area из меню Add. В результате появится следующий диалог. 

Выберите цепь, соответствующую полигону, в строке Net из
раскрывающегося меню или напечатайте это имя непосредственно. 
Выберите слой из списка Layer. Выберите шаблон штриховки Hatch 
pattern. Затем нажмите OK, чтобы начать рисование полигона. Курсор
изменится на перекрестие и будет перемещаться по сетке разводки
Routing Grid . Переместите курсор в желаемую позицию стартового угла
полигона и левым кликом разместите его. Теперь можно рисовать контур
полигона ломанной линией. Подобно контурной линии платы, при
помощи функциональных клавиш, контурная линия полигона может быть
выполнена в виде прямой или образовываться дугой по часовой или
против часовой стрелки. Продолжите левые клики мышкой, чтобы
разместить остальные углы полигона, и правым кликом мышки
завершите формирование контурной линии. После этого область
полигона заполнится диагональным шаблоном штриховки, что сделает
его более видимым. 

Пример маленького полигона на 1-ом
внутреннем слое. Этот полигон был
назначен цепи земли и  использует
полный шаблон штриховки. 
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Контур созданного полигона можно отредактировать выбирая его углы или стороны и используя меню
функциональных клавиш. Это делается подобно редактированию контура платы, описанному ранее в Разделе 5.10: 
Контур платы. Шаблон штриховки можно изменить, выбрав любую сторону полигона. Затем щелкнуть по ней правой
кнопкой мыши, вызываем контекстное меню в котором выбираем пункт Edit Area Params .  
Подключения между корпусами и медными областями могут быть сделаны двумя путями: 

� Контактные площадки, которые находятся в области полигона, могут подключатся к нему с использованием
теплового барьера. Тепловой барьер будет размещен автоматически для выводов той же самой цепи. Барьер
выглядит как символ "X", имеющий цвет ratline и наложенный на контактную площадку вывода. 

� Площадки SMT или площадки штыревых компонентов, которые не проходят через полигон, могут быть
подключены к нему с использованием обрубленных дорожек, которые заканчиваются с переходом. Тепловой
барьер будет автоматически генерироваться для переходного отверстия.  

Для иллюстрации, 4 корпуса
размещены в области полигона из
предыдущего примера. Здесь мы
видим цепь GND, к которой также
подключен полигон.  
Имейте в виду, что штырьки Y1.4, 
JP2.2, JP2.3, JP2.4, JP2.6, JP2.8, JP2.10 
были все автоматически подключены
к полигону с тепловым барьером. 

Чтобы подключить R1.1 и C1.2, мы
будем использовать обрубленные
дорожки. Они были добавлены ниже. 
Отметьте, что переходы на концах
заглушек были подключены с
тепловым барьером. Теперь вся цепь
GND была подключена, используя
полигон. 

Шаблон штриховки полигона предназначен только для его визуализации, чтобы показать его расположение и не
заслонять другие особенности рисунка платы. При генерации Gerber-файлов, полигоны будут залиты сплошной
медью с зазорами для любых не подключенных к полигону контактных площадок и дорожек. Далее в руководстве Вы
будете использовать полигоны, чтобы создать плоскости питания и земли, которые занимают полностью отдельные
слои PCB. 
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5.15.1 Вырезы в полигоне  

Иногда полезно "вырезать (cut out)" часть полигона. Это может быть сделано для того, чтобы создать открытую
область в полигоне или для изменения его контура. Чтобы создать вырез, выберите сторону или угол полигона и
нажмите F6 (Add Cutout). Затем нарисуйте вырез так же, как рисовали бы новый полигон. Изображение ниже
показывает наш полигон с вырезом вокруг Y1 и JP2. 

Полигоны могут быть размещены в вырезах других полигонов.  

5.16 Текст  
Текстовые строки могут быть добавлены в слой шелкографии или в
медные слои PCB. Они полезны для того, чтобы показывать некую
информацию, такую как разные пометки, номер версии, объявления
об авторском праве, и т.п.  
Добавим текстовую строку к PCB, выбирая Text из меню Add. 
Появится следующее диалоговое окно.  

Введите желаемую текстовую строку в поле Text:. Пробел и
большинство специальных символов позволены. Используйте
другие поля, чтобы установить слой (Layer), высоту символа
(Uppercase height) и ширину штриха (Line width). Высота символа
касается максимальной высоте символа, не считая подстрочных
элементов. Заданная по умолчанию ширина штриха составляет 10% 
высоты символа. Установка флажка Mirror image позволяет
получить зеркальное отображение текста, так, чтобы он мог
читаться на нижнем слое меди меди или нижнем слое шелкографии. 
Если Вы оставите выбранной кнопку Drag to position, то сможете
перетаскивать текст, после того как нажмете OK. Иначе, можно
явно установить позицию и угол наклона текстовой строки. 
Позиция строки определяется её левым нижним углом (не включая
подстрочных элементов). 
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5.17 Вырезы в паяльной маске (Solder Mask Cutouts) 

Паяльная маска Solder mask является покрытием, которое применено к печатной плате, чтобы препятствовать не
нужному прилипанию припоя. Это не является действительно необходимым для плат паяемых вручную, но является
существенным для плат, которые паяют автоматически, используя ванну припоя или технологию обратной волны. В
CAM процессе предполагается, что паяльная маска является "слоем" PCB, и описана Gerber-файлом, так же как
медные слои или слои шелкографии. Обычно имеются верхняя и нижняя маски припоя, с отдельными Gerber-файлами
для каждой.  
В паяльной маске должны быть сделаны вырезы для площадок, так как они требуют припоя. FreePCB создает эти
вырезы автоматически в Gerber-файлах для уровней паяльной маски, используя зазор, определенный в CAM диалоге.  
Иногда может появиться необходимость создания дополнительных вырезов в паяльной маске. Например, у торцевых
разъемов платы должно быть открытие вокруг них, чтобы предотвратить "перемычки" маски припоя между
площадками соединителя. Или, Вы могли бы хотеть иметь область пустой меди для экранирования или охлаждения. В
FreePCB эти открытия упоминаются как вырезы cutouts. Вы можете добавить вырезы в слое паяльной маски
используя Add > Solder Mask Cutout. Это вызывает следующий диалог:  

Вы должны выбрать верхний или нижний слоя паяльной маски и
шаблон штриховки hatch pattern. После нажатия OK Вы можете
рисовать контур выреза в виде замкнутой ломанной линии, так же
как контур платы или полигона. Вырез отображается в цвете для "top 
sm cutout" или "bot sm cutout" слоя из списка слоёв. 

Пример выреза в паяльной маске вокруг торцевого разъёма показан ниже. 

Для двустороннего торцевого разъема вырезы должны быть
сделаны на обоих верхнем и нижнем слоях паяльной маски. 
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5.18 Группы  

Помимо манипулирования отдельными элементами PCB, Вы можете также выполнить операции на группах groups  
элементов. Группа может содержать любые элементы PCB. Чтобы выбрать группу элементов, кликните левой
кнопкой мышки и, не отпуская левую кнопку, перемещайте её так, чтобы прямоугольник выбора охватил их. Они
будут подсвечены, как показано в скриншоте ниже: 

К группе выбранных, отдельные элементы могут быть добавлены или удалены, кликая по ним с нажатой клавишей
"ctrl". Маска выбора может быть полезной в процессе этого. Следующие операции могут быть выполнены на группах: 

� Move — Чтобы переместить группу, нажмите F4 ("Move Group"). Группа элементов исчезнет из окна проекта, 
и Вы будете перетаскивать представление схемы группы. Используйте левый клик, чтобы поместить группу в
новую позицию. 

� Delete - Нажмите клавишу "Delete" или F8 ("Delete Group"), чтобы удалить группу из проекта. Имейте в виду, 
что некоторые элементы группы не могут быть удалены. В общем, элементы полигона, такие как контур
платы, медные области, и т.д. будут удалены только в том случае, если весь полигон был включен в группу. 
Для сегментов дорожки будет просто отменена трассировка.  

� Copy - Чтобы скопировать группу в буфер обмена, используйте ctrl-C или выберите Edit > Copy. Не все 
элементы могут быть скопированы. Элементы полигона будут скопированы, если только весь полигон будет
включен в группу. Дорожки будут скопированы, если только корпус(ы), содержащие выводы, к которыми те
подключены, будут также скопированы.  

� Cut - Для этой функции, используйте ctrl-X или выберите Edit > Cut. Это всего лишь комбинация операций 
Copy и Delete. 

� Paste - После того, как группа была скопирована в буфер обмена, она может быть вставлена в проект
нажатием комбинации ctrl-V или выбором Edit > Paste. Вставка является сложной операцией, потому что
элементы в группе, вероятно, придется переименовать прежде, чем они будут добавлены к проекту, чтобы
избежать конфликтов с существующими названиями. Диалог Paste Group появится, как показано ниже. Для
корпусов в группе (Group parts) есть опция переименования их или опция многократно использовать
оригинальные позиционные обозначения. Для цепей (Group nets) есть выбор переименования или
объединения их с существующими цепями, имеющими то же название в проекте. 
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� Save to file — Используйте Edit > Save to File..., чтобы сохранить группу как проектный файл. Этот файл
может быть открыт для редактирования или вставлен в другой проект (см. ниже).  

� Paste from file — Используйте Edit > Paste from File..., чтобы вставить проектный файл в текущий проект
как группу. Диалог Paste Group появится, как показано выше. 

Имея некоторый творческий потенциал Вы можете найти широкое использование для групповых операций в Ваших
проектах. Например, чтобы отменить трассировку дорожек в проекте, установите маску выбора для выбора дорожек, 
выделите все дорожки в проекте и нажмите "Delete". 
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5.19 Проверка правил проекта (Design Rule Checking) 

В идеальном мире, печатная плата всегда изготовляется точно так, как определено в Gerber-файлах и сверловки. В
реальной жизни, конечно же, это не так. Из-за неточности процесса травления, медные области могут оказаться
немного большими или меньшими чем указано. Слои многослойных плат, скорей всего, не выстроются точно в
линию, а размер и позиция отверстий могут измениться из-за производственных допусков. В практических терминах
это означает, что существуют требования минимальной ширины дорожки, размеров площадки и зазоров между
дорожками и/или отверстиями. Эти требования называют правилами проектирования Design Rules и изменяют в
зависимости от производственного процесса.  
Изготовитель PCB должен обеспечить правила проектирования для каждого процесса, который он предлагает. 
Например, правила проекта, зарегистрированные в Интернете для дешевых процессов Advanced Circuits, показаны
ниже: 

Minimum trace width  
Минимальная ширина дорожки  

0.008 inch (0.2032 мм) 

Minimum clearance between copper features  
Минимальный зазор между медью 

0.008 inch (0.2032 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.014 inch (0.3556 мм) 

Minimum annular ring width (pins)  
Минимальная ширина дужки для круглой контактной площадки вывода 

0.007 inch (0.1778 мм) 

Minimum annular ring width (vias)  
Минимальная ширина дужки для круглой контактной площадки перехода 

0.005 inch (0.127 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.008 inch (0.2032 мм) 

 
Правила проекта для дешевых процессов PCB Express: 

Minimum trace width  
Минимальная ширина дорожки  

0.007 inch (0.1778 мм) 

Minimum clearance between copper features  
Минимальный зазор между медью 

0.007 inch (0.1778 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.020 inch (0.508 мм) 

Minimum space between pads (using solder mask clearance of 0.004 inch)  
Минимальное пространство между площадками (используя маску припоя с зазором 
0.1016 мм) 

0.013 inch (0.3302 мм) 

Minimum annular ring width (pads and vias)  
Минимальная ширина дужки для круглой контактной площадки 

0.0085 inch (0.2159 мм) 

Minimum clearance from inner layer holes to copper 
Минимальный зазор между медью внутреннего слоя и отверстием 

0.0175 inch (0.4445 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.007 inch (0.1778 мм) 

 
Если Вы делаете плату самостоятельно, Вы должны будете определить свои собственные правила проекта. 
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FreePCB имеет контроль правил проектирования Design Rule Checker, который проверяет Ваш проект на
соответствие установленным правилам проектирования. Выбор Tools > Design Rule Check вызывает следующий
диалог: 

Переключатель Show unrouted connections as errors позволяет Вам обрабатывать ошибки подключения как ошибки
DRC. Другие поля в диалоге объяснены ниже: 

trace width Минимально допустимая ширина дорожки 

pad to pad Минимальное расстояние между краями площадок, находящихся в разных цепях 

pad to trace Минимальное расстояние между краем площадки и дорожкой, находящихся в разных
цепях 

trace to trace Минимальное расстояние между краями дорожек, находящихся в разных цепях 

hole to pad or trace Минимальное расстояние от края отверстия до площадке или дорожке другой цепи 

hole to hole Минимальное расстояние от края отверстия до края другого отверстия 

annular ring (pins) Минимальная ширина меди окружающей отверстия для круглой контактной
площадки вывода 

annular ring (vias) Минимальная ширина меди окружающей отверстия для переходного отверстия 

board edge to any copper Минимальный зазор между любой медью и краем платы 

board edge to hole Минимальный зазор между краем отверстия и краем платы 

copper area to copper area Минимальный зазор между областями меди 
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Вы должны заполнить эти поля для правил проекта, которые Вы используете. Если изготовитель PCB не указывает
значений для некоторых полей, Вы должны будете предположить их разумное значение. Например, параметры
настройки, которые я использовал бы для Advanced Circuits, показаны ниже: 

Установки для trace width, pad to pad, pad to trace, trace to trace, 
annular ring (pins), annular ring (vias), board edge to any copper, 
hole to pad or trace и copper area to copper area были взяты из
правил проектирования, зарегистрированных в Интернете. Поскольку
там не было правил для hole to pad or trace, hole to hole или board 
edge to hole, я использовал 25 mils, который похожи на разумное
значение. В случае необходимости, я могу уточнить это у
производителя PCB. 
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В качестве примера, давайте проверим проект, показанный ниже, который содержит множественные намеренные
нарушения. 

Чтобы проверить проект, выберем Tools > Design Rule Check и установим правила проектирования указанные
выше. Кликнув Check запускаем проверку и получаем следующий диалог, который перечисляет все нарушения. 
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Когда Вы закроете диалог Design Rule Check, каждое нарушение будет обозначено в окне схемы размещения
маленьким кольцом в цвете для ошибок DRC, как показано ниже.  

Эти маленькие кольца
может быть сложно
заметить в плотном
проекте. 

Если вы держите
нажатой клавишу "d", 
то каждое кольцо будет
преобразовано в
большой сплошной
круг, как показано. 
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Теперь Вы можете увеличить отдельные ошибки и исправить их. Группа ошибок вблизи от края платы  показана
ниже. 

Вы можете выбрать одну из ошибок, нажимая на кольцо. Оно будет подсвечено, наряду с элементами, которые
вызвали ошибку, и строка состояния покажет описание ошибки. В скриншоте ниже, я нажал на крайнюю справа
ошибку. 

В этом случае, ошибкой есть нарушение расстояния между площадками, где расстояние - 0 mils вместо допустимых
минимальных 8 mils. Мы можем устранить ошибку, переместив площадку и/или дорожку. Кольцо ошибки не будет
автоматически удалено, когда Вы устраните ошибку, но Вы можете удалить его, выбрав и нажав клавишу "Delete". Вы
можете удалить все ошибки, выбирая Tools > Clear DRC Errors. 
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Важное примечание: Согласие с некоторыми правилами проекта также зависит от Ваших параметров настройки
файла Gerber. Например, параметры настройки показанные ниже могут создать нарушение минимальной ширины
линии шелкографии (которая должна быть по крайней мере 7 mils для Advanced Circuits) и ширины кольца для
выводных контактных площадок (которая должна быть по крайней мере 7 mils), таким образом они должны быть
изменены на подходящие для правил проекта. 

Другое примечание: Если Вы нашли эту часть сбивающей с толку, некоторые изготовители PCB предоставляют
информацию о правилах проекта на их вебсайтах. 



FreePCB.  Руководство пользователя 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

5.20 Экспорт файлов сверления и Gerber  

5.20.1 Создание Файлов 

Конечным шагом в проекте PCB является экспорт файлов, которые фирма изготовитель будет использовать, чтобы
произвести Ваши платы. Эти файлы описаны ниже. 

� Gerber файлы - Эти файлы используются, чтобы создать фотошаблон, которое будет использоваться, чтобы
сделать медные слои, слои шелкографии и маски для PCB. Там есть один файл для каждого слоя или маски. 
Используется расширенный формат Gerber RS274X.  

� Файл сверловки - Этот файл будет использоваться машиной, которая сверлит отверстия в PCB. Здесь
используется формат Excellon, который является отраслевым стандартом. В основном, он начинается со
списка размеров свёрл (в дюймах), а затем дает координаты центра каждого отверстия. Есть важная
проблема относительно размеров свёрл, которая обсуждена в Разделе 5.19.3: Размеры свёрл. 
Пожалуйста, читайте этот раздел прежде, чем Вы пошлете свои файлы в фирму изготовитель PCB. 

Чтобы экспортировать файлы сверловки и Gerber-файлы, выберите Generate CAM files... из меню File. Появится 
следующий диалог. 

В секции Files, выберите файлы, которые Вы хотите генерировать, проверяя или не проверяя поля рядом с каждым. 
Секция Gerber file options позволяет Вам выбрать или снять выбор следующих опций: 

� Include board outline - установить этот флажок, чтобы включать контур платы во всех Gerber-ах.  
� Add moires - добавляет символы муара (иногда называемых "целями") для регистрации слоя.  
� Add layer description text - добавить текстовую строку в каждый Gerber файл, указывающий слой который он 

представляет. 
� Add pilot holes to pads and vias - добавляет пилотное отверстие к контактным площадкам с отверстием и

переходам на верхнем и нижнем слоях, чтобы помочь в сверлении. 
� Use thermal reliefs for pins — при подключении контактных площадок с отверстиями к внутренними

медными слоям, использовать тепловой барьер. 
� Use thermal reliefs for vias - при подключении обрубленных дорожек к внутренним медным слоям с

переходами, использовать тепловой барьер. 
� Make cutouts in solder masks for vias - создавать открытия в масках припоя вокруг переходных площадок. 
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Секция Gerber file dimensions позволяет Вам устанавливать значения для следующего: 
� Copper to copper-fill clearance - является зазором, который FreePCB создаст вокруг дорожек или переходов, 

которые проходят через медные полигоны. 
� Hole-edge to copper-fill clearance - является зазором, который будет создан вокруг просверленных

отверстий. Пожалуйста обратитесь к Разделе 5.194: Зазоры сверловки для важного примечания об этих
зазорах. 

� Solder mask clearance - пространство, которое FreePCB обеспечит вокруг площадок в масках припоя. 
� Pilot hole diameter - диаметр пилотных отверстий, если Вы выбрали их. 
� Minimum silkscreen stroke width - минимальная ширина штриха, которую FreePCB будет использовать для

слоя шелкографии, которая обычно рекомендуется производителем платы. 
� Thermal relief line width - ширина линий, которые будут использоваться, чтобы подключить площадки или

переходы к полигону, используя тепловой барьер. 
� Board outline line width - ширина контурной линии платы, если используется.  
� Annular ring width (pins) and Annular ring width (vias) - ширина медных колец помещенный во внутренних

слоях вокруг штыревого вывода и переходного отверстия, подключенных тепловым барьером к медным
полигонам. 

Секция Panelizing позволяет Вам размножить Ваш проект, создавая множественные копии PCB в файлах Gerber: 
Number of boards (x)/(y) - число копий в каждой оси.  
Spacing edge-edge (x)/(y) - зазор между краями копий в каждой оси. 

Когда Вы кликаете Create Files, файлы будут записаны в Output folder. По умолчанию, это — вложенная папка 
CAM , расположенная в папке проекта. Папка будет создана, если не существовала. Вы можете изменить папку
вывода, или сбросить установленную папку к заданной по умолчанию, при помощи кнопки Set default.  
Если все сделано правильно, Вы бувидите следующий Log диалог, с "*** SUCCESS ***" конечной строкой. Если в
процессе генерации файлов произойдут ошибки, в логфайле будут соответствующие сообщения. Если ошибка
произойдет в процессе генерации файла, то FreePCB прерывает генерацию этого файла и переходит к следующему. 
Каждый файл называют согласно его информационного наполнения, такого как top_copper.grb или drill_file.drl. 

Кликните OK, чтобы закрыть логфайл.  
Когда Вы закончили создание файлов, нажмите Exit в диалоге  Generate Gerber and Drill Files. 
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5.20.2 Просмотр и Печать Файлов  

Есть много бесплатных программ, которые позволяют Вам просматривать Gerber-файлы и файлы сверловки. Прежде, 
чем посылать Ваши файлы производителю, я НАСТОЙЧИВО предлогаю Вам проверить их одной из этих программ. Я
использую ViewMate от PentaLogix (прежде Lavenir). Вы можете загрузить этот вьювер по адресу
www.pentalogix.com/Download/download.html. ViewMate позволяет Вам рассматривать и файлы Gerber и файлы
сверловки, а также позволяет делать пробную печать на принтер. Так как функции печати в FreePCB еще не
осуществлены, это в настоящее время - единственный способ напечатать Ваши проекты.  
Пример того как ViewMate отображает Gerber-файлы FreePCB показан ниже. Этот файл Gerber включает контурную
линию платы, moires и текстовое описание слоя ("Top Copper Layer"). 
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5.20.3 Размеры свёрл 

Файл сверловки определяет размер и позицию каждого отверстия в PCB. Проблема, которая возникает с этими
файлами, это преобразование размера отверстия к фактическому размеру сверла (когда конечный диаметр отверстия
будет на несколько mils меньше после металлизации) или конечному размеру (или покрытый металлом размер), 
который является конечным размером отверстия после металлизации. Мне имеет больше смысла определять
конечный размер и позволять производителю платы выбирать, какое сверло использовать, так как они лучше знают, 
насколько толстым будет их слой металлизации. FreePCB футпринты используют конечные размеры, таким образом
это те размеры, которые появляются в файле сверловки.  
Вы ДОЛЖНЫ уточнить эти размеры с вашим производителем, поскольку некоторые из них ожидают фактические
диаметры сверла, которые должны быть больше конечного размера отверстия. В этом случае, Вам, вероятно, придется
редактировать файл сверловки и увеличить размеры практической отработки соответственно. Ваш производитель
платы должна быть в состоянии помочь с этим, если они понимают то, что Вы хотите.  
Типовой файл практической отработки показан ниже. 

;Holesize 1 = 24.0 PLATED MILS 
;Holesize 2 = 18.0 PLATED MILS 
;Holesize 3 = 14.0 PLATED MILS  
M48  
INCH  
T01C0.024  
T02C0.018  
T03C0.014  
%  
G05  
G90  
T01  
X028000Y018000  
X029000Y018000  
X028000Y017000  

X023000Y010000  
X023000Y011000  
X023000Y012000  
T02  
X012000Y017000  
X006000Y012000  
X012000Y012800  
X024000Y011000  
X024200Y009000  
X024200Y005000  
X024000Y003000  
T03  
X019000Y010000  
M30 

Строки, которые начинаются с символа ";" являются комментариями. Каждый различный размер отверстия описан в
комментарии, как 
 ;Holesize 1 = 24.0 PLATED MILS  
который указывает диаметр отверстия 24 mils, после металлизации. Строка 
 T01C0.024  
является фактической командой для машины, которая устанавливает размер сверловки, в дюймах.  
Если необходимо изменить размер сверления, чтобы учесть металлизацию, Вы должны изменить и комментарий и
машинную команду. Например, чтобы использовать 28 mil сверло вместо 24 mil сверла, измените комментарий на 
 ;Holesize 1 = 28.0 UNPLATED MILS 
и машинная команда к виду  
 T01C0.028  
Некоторые производители платы попросят отдельный текстовый файл, который перечисляет размеры сверления. Вы
можете посоветовать им смотреть на комментарии в начале файла практической отработки, или можете скопировать
их в отдельный файл.  

5.20.4 Зазоры сверления (Drill Clearances) 

Производители плат будут часто рекомендовать "drill clearance". Это - минимальный рекомендуемый размер зазора  
вокруг отверстия во внутреннем слое меди, который создаётся вокруг отверстий и позволяет безопасный проход
отверстия через внутренние слои без коротких замыканий. Как правило, он определяется как что-то типа "диаметр
сверла плюс 0.025 дюйма". Это отсылает к ДИАМЕТРУ зазора отверстия. FreePCB использует Hole-edge to copper-
fill clearance значение, чтобы создавать эти зазоры. Однако, так как FreePCB обрабатывает этот зазор как расстояние
между краем отверстия и краем меди, это будет разницей РАДИУСОВ отверстий, которая является половиной
разницы диаметров. Поэтому, чтобы создать зазор сверления "диаметр сверла плюс 0.025 дюйма", Вы должны
использовать Hole-edge to copper- fill clearance одной половины 0.025 дюймов, или 12.5 mils. Это стоит округлить в
большую сторону к 13 mils. 
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6. Футпринты и библиотеки  

6.1 Библиотеки футпринтов 

Футпринты сохранены в библиотечных файлах library files , у которых есть расширение .fpl. Каждый файл содержит
множество футпринтов, обычно для упаковок того же самого типа. FreePCB уже идет с рядом библиотечных файлов, 
большинство которых было получено путём преобразования библиотек от Ivex Design International Inc., 
производителя коммерческого программного обеспечения ECAD, которое обанкротилось в прошлом году. Эти файлы
организованы в три группы: 

� Основные библиотеки (Core libraries) — Это наиболее часто используемые библиотеки. Они расположены в
папке C:FreePCB\lib, если Вы сделали стандартную инсталляцию.  

� Дополнительные библиотеки — Это библиотеки с реже используемыми корпусами. Они расположены в 
C:FreePCB\lib_extra.  

� Внесенные библиотеки - Библиотеки, внесенные пользователями. Они расположены в 
C:FreePCB\lib_contrib. 

Когда Вы создадите проект в FreePCB, Вы выберете библиотечную папку, чтобы использовать её для проекта. 
Обычно, это будет папка основной библиотеки. Если Вы должны использовать любые другие библиотеки, Вы должны
скопировать их в папку оперативной библиотеки. Если хотите, можете скопировать ВСЕ файлы в папку оперативной
библиотеки и таким образом они все будут в одном месте.  
Вы можете создать свои собственные футпринты, используя Мастер создания футпринтов Footprint Wizard или
редактор футпринтов Footprint Editor , которые рассмотрены в Разделе 6.2: Мастер создания футпринтов и Разделе 
6.3: Редактор футпринтов. Если бы Вы создаете свои собственные футпринты, я рекомендовал бы сохранить их в
отдельных библиотечных файлах вместо стандартных файлов, которые идут с FreePCB. Таким образом, если появятся
обновления стандартных библиотек, Вы можете заменить их, не теряя Ваших собственные футпринтов.  
Каждый библиотечный файл документирован в файл формата PDF, у которого есть то же самое название как
библиотечный файл за исключением расширения .pdf вместо .fpl. Если Вы ищете специфический футпринт, файлы
формата PDF - лучшее место, чтобы смотреть. Вы можете также просмотреть диалог Add > Part для футпринтов, но
файлы формата PDF содержат более подробную информацию, такую как общие размеры и размеры площадок.  
Если Вы создаете или изменяете свои собственные библиотеки, Вы можете сделать файлы формата PDF для них
воспользовавшись пунктом меню Tools > Make PDF from Library File... в редакторе футпринтов.  
Библиотечные файлы, которые в настоящее время поставляются вместе с FreePCB, перечислены в секциях ниже. 
Отметьте, что файлы, содержащие футпринты с площадками под штыревые выводы, начинаются с "th _", в то время
как футпринты с площадками SMT начинаются с "sm _". 
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6.1.1 Основная библиотека 

Имя файла (.fpl) Источник(и) Тип Описание 

th_transistor Ivex, JEDEC through-hole JEDEC TO-серии упаковок транзисторов и ИС 

th_diode Ivex, JEDEC through-hole JEDEC DO-серии диодных упаковок 

th_capacitor Ivex through-hole Конденсаторы, полярные и неполярные 

th_resistor Ivex through-hole Резисторы, включая потенциометры 

th_connector Ivex through-hole Соединители 

th_header Ivex through-hole Headers 

th_sip Ivex through-hole SIP (однорядная) упаковки (100 mil расстояние) 

th_dip Ivex through-hole DIP (двухрядная) упаковки (100 mil расстояние) 

sm_resistor Ivex, IPC surface-mount Чип резистор 

sm_capacitor Ivex, IPC surface-mount Чип и танталовые конденсаторы 

sm_soic Ivex, IPC surface-mount SOIC (small outline IC) packages 

sm_sop Ivex, IPC surface-mount SOP and TSOP (small outline package) packages 

sm_soj Ivex, IPC surface-mount SOJ (small outline J-lead) packages 

sm_lcc Ivex, IPC surface-mount LCC (leadless chip carrier) packages 

sm_plcc Ivex, IPC surface-mount PLCC (plastic leaded chip carrier) packages 

sm_sot Ivex, Siemens surface-mount SOT (small outline transistor) packages 

led Ivex mixed Светодиоды 

test_point Ivex mixed Тестовые точки 

 
6.1.2 Дополнительные библиотеки (Extra libraries) 

Имя файла (.fpl) Источник(и) Тип Описание 

sm_qfp Ivex, IPC surface-mount PQFP, SQFP и QFP (quad flat-pack) упаковки (этот
файл не находится в папке основной библиотеки, 
потому что слишком большой) 

device Ivex mixed Различные устройства 

sm_tantalum_cap Ivex surface_mount Танталовые конденсаторы от AVX 

elfa_cap Ivex mixed Конденсаторы из каталога ELFA 

elfa_chk Ivex mixed Различные устройства из каталога ELFA 

elfa_pot Ivex mixed Потенциометры из каталога ELFA 

elfa_res Ivex mixed Резисторы из каталога ELFA 

flatpack Ivex, JEDEC mixed Quad flatpacks 

sm_ipc782 surface-mount Различные устройства от IPC отсутствующие в других
библиотеках 

siemens2  mixed Siemens LCC упаковки 

siemens3  mixed Siemens SO упаковки 

siemens4  mixed Siemens QFP упаковки 

transformer  mixed Трансформаторы 

tx_inst  mixed Различные упаковки Burr-Brown и Texas Instruments  
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6.1.3 Внесенные библиотеки 

Имя файла (.fpl) Источник(и) Тип Описание 

flintstone Аноним смешанный Различные реле, горшки, трансформаторы и
соединители 

 

6.2 Мастер создания футпринтов 

Могут быть моменты, когда Вам потребуется футпринт, отсутствующий в одной из библиотек, поставляемых с
FreePCB. Мастер футпринта является инструментом для генерации футпринта для множества стандартных упаковок. 
Он вызывается с помощью пункта меню Tools > Footprint Wizard. Который вызывает следующий диалог: 
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Футпринт создаётся, путем настройки различных опций управления в диалоге. Они описаны ниже: 
� Name - Это название, которое будет назначено футпринту, когда он будет сохранен (например DIP28).  
� Type - тип упаковки. Строка диаграммы выбранного типа будет показана в диалоге (QUAD в примере выше). 

� SIP (однолинейная упаковка) — содержит один ряд одного или более выводов. 
� DIP (двухлинейная упаковка) - две строки выводов, пронумерованных как для DIP IC упаковки. 
� QUAD - четыре строки выводов, упорядоченных как прямоугольник (как показано выше) и

пронумерованный  как для PLCC или QFP упаковки. 
� HEADER - выводов, упорядоченные в сетку и пронумерованные последовательно столбцом. 
� HEADER2 - то же самое как HEADER кроме выводов, пронумерованных последовательно строкой. 
� PGA/BGA (массив штырьков или массив шариков) - выводы упорядочены в прямоугольнике, и

обозначены, используя соглашение для массива решетки. 
� Units - mils или мм. 
� Number of pins

� Total - общее количество выводов в упаковке.  
� Per horizontal row (только для упаковок QUAD, HEADER и PGA/BGA) - число выводов на

горизонтальной строке.  
� Per vertical row (только для упаковок QUAD, HEADER и PGA/BGA) - это заполняется автоматически, 

для информации.  
� Pin 1 position (только для упаковок QUAD) — позиция первого вывода. Имеется три опции: 

■ top row, center pin (верхний ряд, средний вывод) 
■ bottom row, left-most pin (нижний ряд, крайний левый вывод) 
■ top row, left-most pin (верхний ряд, крайний левый вывод) 

� Pads
� Shape — форма площадки. Имеется четыре опции:

■ Rectangular - прямоугольная площадка
■ Pin 1 square, others round - квадратная площадка для вывода 1, другие круглые  
■ Round - круглые площадки
■ Square — квадратные  площадки 
■ None — используется для создания отверстия без площадки (например для монтажного отверстия). 

� Hole diameter - диаметр отверстия контактной площадки (пробел или "0" для площадки SMT). Width (X)
- ширина площадки (показана как "X" в строке диаграммы). 

� Length (Y) - длина площадки (показана как "Y" в строке диаграммы).  
� Spacing (E) - интервал между центрами площадок в пределах строки ("E" в строке диаграммы). 

� Distance between top and bottom rows — расстояние между верхним и нижним рядами. Выбирая одну из
трех кнопок, можно установить расстояние как: 
� Inner-inner (G1) - расстояние между внутренними полями площадок ("G1" в диаграмме).  
� Center-center (C1) - расстояние между центрами площадок ("C1" в диаграмме).  
� Outer-outer (Z1) - расстояние между внешними полями площадок ("Z1" в диаграмме). 

� Distance between left and right rows  - расстояние между левым и правым рядами. Выбирая одну из трех
кнопок, можно установить расстояние как: 
� Inner-inner (G2) - расстояние между внутренними полями площадок ("G2" в диаграмме).  
� Center-center (C2) - расстояние между центрами площадок ("C2" в диаграмме).  
� Outer-outer (Z2) - расстояние между внешними полями площадок ("Z2" в диаграмме). 

Preview — клик по этой кнопке создает предварительный просмотр футпринта в диалоге. 
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Данные производителя являются лучшим источником размеров корпуса компонента. Обычно эта информация
доступна через интернет. В некоторых случаях, изготовитель даже предлагает рисунок варианта футпринта PCB (для
SMT компонентов, они часто упоминаются как "land patterns (образец посадки)").  
После того, как параметры настройки для футпринта введены, кликните Preview, чтобы увидеть его изображение.  
Если всё в порядке, то можно сохранить футпринт в библиотечном файле, кликнув Save. Это вызовет диалог
сохранения футпринта показанный ниже. 

Footprint name (название футпринта) скопировано из мастера и при желании может быть изменено. Author (Автор), 
Source (Источник)и Description (Описание) могут быть заполнены текстом, описывающим футпринт. Строка Library 
file позволяет выбрать библиотечный файл или ввести имя нового файла, чтобы его создать. По умолчанию это будет
файл с именем user_created.fpl.  
Ниже дано несколько примеров футпринтов, созданных с помощью мастера. 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

6.2.1 Пример 1: Монтажное отверстие или контрольная точка с единственным выводом  

Чтобы создать футпринт единственного вывода для монтажного отверстия или контрольной точки, установите Type в
"SIP" и Number of pins в "1". Параметры настройки для монтажного отверстия с диаметром отверстия 100 mils и
круглой площадкой диаметром 200 mils показаны ниже. 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

6.2.2 Пример 2: Резистор с осевыми выводами 

Давайте начнём с изображения резистора, взятого из таблицы данных Panasonic. Этот футпринт будет для резистора
мощностью 1/4Вт, типа ERD25. 

Согласно таблицы данных, длина корпуса
резистора составляет 6.35 мм. Чтобы учесть изгиб
выводов, увеличим расстояние между контактными
площадками до 12.5 мм. Диаметр выводов
составляет 0.60 мм. Чтобы обеспечить монтажный
зазор, используем диаметр отверстия 0.9 мм. 
Диаметр площадки пусть будет 1.4 мм. Установки
мастера футпринтов показаны ниже. 
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6.2.3 Пример 3: DIP корпус с прямоугольными площадками  

Здесь приводится настройки для футпринта DIP интегральной схемы (ИС) с 20 штыревыми выводами. Стандартный
DIP интервал между штыревыми выводами - 100 mils, а интервал между рядами выводов - 300 mils. Мы будем
использовать прямоугольные площадки 80 x 40 mils в размере с отверстиями диаметром 25 mil. 
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6.2.4 Пример 4: 100-выводной QFP корпус  

Это футпринт корпуса синхронной оперативной памяти Cypress CY7C1329, 64 КБ X 32. Размеры корпуса
микросхемы, скопированные с таблицы данных Cypress, показаны на рисунке ниже. 

Выдвинем контактные площадки на 0.5 мм дальше
конца каждого вывода, добавив таким образом 1 мм к
внешним размерам выводов. Кроме этого, повернём
корпус так, чтобы вывод 1 оказался в  левом нижнем
углу. Параметры настройки для мастера футпринтов
показаны ниже. 
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6.3 Редактор футпринтов (Footprint Editor)  

Мастер футпринтов предлагает наиболее простой способ создания нового футпринта, но он ограничен несколькими
предопределенными шаблонами. На практике обычно требуется большая гибкость в размещении выводов. Кроме
того, Вы можете захотеть создать более информативные или артистические контуры для своих футпринтов.  
Редактор футпринтов позволяет Вам делать все эти вещи. Он может быть открыт в программе FreePCB несколькими
способами: 

• Выбрав пункт меню File > Open Footprint Editor . Этот способ доступен даже когда в программе нет 
открытых проектов.  

• Выбрав пункт меню Tools > Footprint Editor . Этот способ доступен только когда в программе открыт какой-
то проект.  

• Выбрав корпус и нажав F2 ("Edit Footprint"). Этот способ позволяет открыть редактор с уже
импортированным футпринтом корпуса. После завершения работы редактора, будет предложено внести
сделанные изменения в оригинальный футпринт. 

6.3.1 Окно редактора футпринтов (Footprint Editor)  

После открытия редактора футпринтов, его окно заменяет обычное окно программы FreePCB. Вы можете определить, 
что находитесь в редакторе футпринтов, взглянув на область заголовка окна. После того как редактирование
футпринта завершено, Вы можете вернуться в редактор PCB (FreePCB), нажав клавишу F8 ("Return to PCB"), выбрав
элементы меню File > Return to PCB Layout или Tools > Return to PCB layout или кликнув в боксе "Close" в
верхнем правом углу.  
Копия экрана Footprint Editor, с импортированным футпринтом DIP8, показана ниже. 
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Как и следовало ожидать, пункты меню редактора футпринтов Footprint Editor отличается от меню FreePCB. Они
перечислены ниже: 

� File - 
� New footprint — Начать редактирование нового футпринта. 
� Import Footprint - Импорт футпринта из библиотечного файла.  
� Save Footprint As - Сохраняют футпринт в библиотечном файле. 
� Return to PCB layout - Закрыть Footprint Editor и вернуться к FreePCB.  

� Edit -  
� Undo — отмена последней операции редактирования (если возможно). 

� View -  
� Entire footprint - изменить размеры и повторно выравнять по центру окно, чтобы отобразить все

элементы футпринта. 
� Add -  

� Pin - Добавить новый вывод или строку выводов.  
� Polyline - Добавить новую ломаную линию в слой шелкографии.  
� Text - Добавить текстовую строку. 

� Tools - 
� Footprint Wizard - Вызвать мастер футпринтов.  
� Make PDF from Library File - Создать файл формата PDF, описывающий футпринты в библиотечном 

файле.  
� Return to PCB Layout - То же самое, что и в меню File.  

� Help - 
� About FreePCB - Показать "Окно информации" с номером версии. 

Другие элементы окна, такие как панель инструментов, список слоёв, меню функциональных клавиш, строка
состояния и окно размещения, такие же как для FreePCB.  

6.3.2 Элементы футпринта 

Футпринты состоят из 4-х основных элементов. Это: 
� Pins — выводы, реализованные как стек контактных площадок padstacks. Стек контактных площадок

содержит медные площадки для верхнего, внутренних и нижнего слоёв, а также отверстие. 
� Polylines — линии, которыми прорисовываются графические элементы футпринта в слое шелкографии. Они

могут быть замкнутыми или разомкнутыми.  
� Reference designator - текстовая строка позиционного обозначения. Поскольку фактически позиционное

обозначение принадлежит компоненту а не футпринту, Footprint Editor использует строку "REF" лишь как
указатель места для заполнения. Эта строка всегда присутствует и не может быть удалена. Однако можно
изменить её размер. 

� Selection box - это прямоугольник, который включает все другие элементы и используется для выбора
компонента во время размещения на PCB. Этот прямоугольник генерируется автоматически во время
сохранения футпринта.  

Процесс создания футпринта на самом деле очень похож на процесс размещения PCB и если Вы использовали
FreePCB, то уже имеете большинство необходимых навыков. В следующих разделах мы создадим футпринт для
электролитического конденсатора. Размеры конденсатора, показанные на  рисунке ниже, взяты из таблицы данных
Panasonic. Создадим футпринт для конденсатора, имеющего диаметр корпуса 12.5 мм. 
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6.3.3 Начало создания нового футпринта 

Находясь в FreePCB, вызовите редактор футпринта (Footprint Editor) из меню File или Tools. Вы стартуете с окна
размещения, которое пусто за исключением символа начала координат и позиционного обозначения, как показано в
скриншоте ниже. Так как мы будем использовать метрическую систему измерения, удостоверьтесь, что Units есть 
"мм". 
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6.3.4 Добавление и редактирование выводов (ножек)  

Выберем элемент меню Add > Pin, который активизирует диалог Add/Edit Pin. Средства управления в этом диалоге в
значительной степени очевидны. Некоторые из них активны или не активны в зависимости от добавленного вывода. 
Пока мы добавляем первый вывод, выбор Padstack > Same as pin # заблокирован по очевидным причинам.  
Конденсатор имеет выводы диаметром 0.6 мм. Для получения необходимого зазора, будем использовать диаметр
отверстия 0.9 мм и диаметр площадки 1.5 мм. Для первого вывода мы будем использовать квадратные площадки на
верхних и нижних слоях и круглую площадку на внутренних слоях. Выберите Padstack > Through-hole кнопку и
установите диаметр отверстия hole diameter 0.9 мм. Установите Top pad > Shape в "square (квадратная)" и ширину 
Width 1.5 мм. Inner pads >Shape должны быть "round (круглая)". Bottom pad должна быть такой же как Top pad. 
Установите позицию Position в X = 0.0 и Y = 0.0. В результате, диалог должен выглядеть следующим образом: 

После нажатия OK, контактная площадка вывода будет помещена в
начале координат. 
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Согласно таблице данных, интервал между выводами составляет 5 мм. Таким образом, разместим наш второй вывод в
координатах X = 5.0 мм и Y = 0.0 мм. Чтобы упростить эту задачу, установим видимость Visible сетки и шаг
размещения Placement величиной 1 мм. Теперь повторим выбор Add > Pin, чтобы добавить второй вывод. 

Так как один вывод уже создан, выбор Padstack > Same as pin # активен и, по умолчанию, предлагает создать
второй вывод таким же как первый. Однако, для вывода 2 нам требуется контактная площадка круглой, а не
квадратной формы. Поэтому, снимаем флажек Padstack > Same as pin #  и изменяем Padstack > Top pad > shape
на "round(круглый)". Затем установим флажки для внутренних Padstack > Inner pads > Same as top pad и нижней
площадок Padstack > Bottom pad > Same as top pad, чтобы сделать эти площадки такими же как верхняя. 
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Теперь диалог должен принять следующий вид: 

Нажмём OK, чтобы выйти из диалога и сформировать контактную
площадку. Разместим её в координатах X = 5.0 мм и Y = 0.0 мм, как
показано на рисунке. 
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6.3.5 Добавление контура корпуса компонента (Adding Polylines) 

Теперь, в слое шелкографии, добавим некоторые графические элементы, содержащие контур корпуса (круг  
приблизительно такого же диаметра, как диаметр конденсатора) и символ "+", отмечающий положительный вывод, 
который в соответствии с принятым соглашением является 1-ым.  
Давайте начнём с круга. Круг рисуется замкнутой ломанной линией, состоящей из дуг, соединённых в точках излома. 
Так как нам нужно разместить изломы (углы) этой линии на полпути между выводами на оси X, установим сетку
размещения  Placement в "0.5 мм". Кроме того, удостоверимся в том, что угол излома линии Angle установлен в "45". 
После этого выбираем пункт меню Add > Polyline, который вызовет  диалог Add Polyline: 

Так как для круга нам нужна замкнутая ломанная линия, то удостоверимся, что кнопка Closed выбрана, как показано
выше. Толщина линии Line width установлена в 0.254 мм (или 10 mil) по умолчанию. Это разумное значение, которое
можно оставить без изменения. Чтобы приступить к размещению начального излома линии, нажмём OK. Поместим
его в координатах X =-4.0 мм, Y = 0.0 мм. По умолчанию, ломанная линия формируется из прямых участков. Нажмём
клавишу F2 ("Arc (CW)"), чтобы изменить этот стиль на дугу, формируемую по часовой стрелке. Разместим второй
излом в координатах X = 2.5 мм, Y = 6.5 мм. Далее, разместим третий излом в координатах X = 9.0 мм, Y = 0.0 мм и
четвертый излом в координатах X = 2.5 мм, Y =-6.5 мм. Затем щелкнем правой кнопкой мыши, чтобы замкнуть
ломаную линию. В результате должен получиться круг: 
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Теперь давайте добавим символ "+". Для этого выберем Add > Polyline, но на сей раз выберем разомкнутую (Open) 
ломанную линию. Рисуем вертикальную линию, поместив первый излом в координатах X =-6.0 мм, Y = 5.0 мм и
второй излом в координатах X =-6.0 мм, Y = 1.0 мм. Затем щелкните правой кнопкой мыши, чтобы прекратить
рисование. Таким же образом добавим горизонтальную линию, поместив первый излом в координатах X =-8.0 мм, Y = 
3.0 мм и второй излом в X =-4.0 мм, Y = 3.0 мм. Теперь Ваш футпринт должен приобрести следующий вид: 

6.3.6 Изменение позиционного указателя (Reference Designator)  

Наконец, давайте переместим позиционный указатель за пределы контурной линии корпуса. Кликните на нём, чтобы
выбрать, и нажав F4 ("Move Ref Text"), начнём перемещение. Переместим указатель выше контура корпуса и
разместим левым кликом. Если Вы хотите сделать размеры указателя больше или меньше, нажмите клавишу F1 ("Set 
Size"), а затем используйте диалог Reference Text Properties, чтобы изменить его размер и толщину линии. 
Футпринт, в окончательном виде, должен выглядеть так, как показано ниже: 
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6.3.7 Сохранение футпринта  

Чтобы сохранить Ваш новый футпринт в библиотечном файле, выберите элемент меню File > Save As, который
вызовет диалог Save Footprint. Введите, как показано ниже, имя футпринта Footprint name и (опционально) имя 
автора Author, источник Source и описание Description. Затем выберите библиотечный файл Library file, который Вы 
желаете использовать (или ввести новое имя файла), и нажмите OK, чтобы сохранить футпринт.  

6.3.8 Импорт футпринта  

Выше мы описали, как создать футринт с нуля. Однако, во многих случаях будет проще взять существующий
футпринт и изменить его. Вы можете импортировать футпринт в редактор Footprint Editor используя элемент меню  
File > Import footprint, который вызовет следующий диалог. 

Здесь Вы можете выбрать библиотечную папку, открыть библиотечные файлы и выбрать футпринты. В диалоге
можно осуществить предварительный просмотр выбранного футпринта. Нажмите OK, чтобы импортировать
футпринт  в редактора. После этого Вы сможете редактировать его. 
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6.3.9 Использование мастера футпринта 

Вы можете использовать мастер
футпринта внутри редактора
футпринта. В качестве примера такого
использования, давайте сделаем
футпринт для корпуса PGA 
показанного ниже. Это - датчик
изображения Kodak. Диаметр ножки
вывода - 18 mils, и интервал между
ножками - 100 mils. Выводы называют
так, как обычно принято для PGA. 

Находясь в редакторе футпринта, выберите пункт меню Tools > Footprint Wizard. Мы будем использовать круглые
площадки  диаметром 50 mils с диаметром отверстия 28 mils. Так как ножки упорядочены в 11 столбцах и 11 строках, 
первоначально создадим футпринт как матрицу 11 x  11 = 121 ножек. Затем удалим лишние. Установите диалог
Footprint Wizard как показано ниже. 

Нажмите Done, чтобы создать футпринт и импортировать его в редактор Footprint Editor. Результат изображен ниже: 
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Теперь, выберите каждый лишний вывод и удалите его. Переместите "REF" строку так, чтобы она стала видимой. 
Результат изображен ниже: 
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6.3.10 Создание PDF файла содержимого библиотек 

Если Вы создали или изменили библиотечный файл, то можете сделать файл формата PDF, описывающий футпринты
в библиотеке. Для этого используйте элемент меню Tools > Make PDF from Library File..., который вызовет 
следующий диалог: 

При необходимости, используйте поле Library Folder, чтобы выбрать библиотечную папку. Используйте  
раскрывающееся меню Library File, чтобы выбрать файл, который Вы желаете документировать. Чтобы сделать
файлы формата PDF из всех библиотечных файлов в папке, листайте до основания меню файла и выберите "*** all 
library files ***", как показано ниже. Вы можете использовать меню Page size, чтобы выбрать размер страницы, и 
меню Units, чтобы выбрать единицы измерения, которые будут использоваться в формате PDF. Затем Make PDF file, 
чтобы сделать файл (ы). 

Типовая страница из файла формата PDF показана ниже. 
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7. Учебник  

7.1 Схема 
Лучший способ изучить новую CAD программу состоит в том, чтобы использовать её. Этот учебник проведёт Вас
через создание маленькой печатной платы для моторного контроллера, схема которого показана ниже. Извините, если
это изображение слишком большое.  
Вы можете пожелать распечатать копию схемы, чтобы можно было следовать ей в процессе создания PCB. 
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7.2 Создание проекта  

Сначала создадим новый проект под названием "Motor". 
Выберите пункт New меню File, который вызовет следующий диалог. 

� Введите слово "motor" в блок Name. Это позволит
установить название проекта.  

� Так как у проектной папки обычно такое же как у
проекта название, слово "motor" будет автоматически
добавлен в конец пути папки в блоке Project Folder, 
который должен теперь читаться "..\projects\motor". 
Отметьте, что этот путь указан относительно
местоположения приложения, которое обычно находится
в папке FreePCB\bin. Если Вы хотите использовать
отличную от проектной папку, то можете отменить
значение по умолчанию, вводя другой путь к папке, 
который может быть указан относительно папки
приложения или абсолютно. Если проектная папка ещё
не существует, FreePCB создаст ее (хотя его
родительская папка должна существовать). Так как
проектная папка "motor" уже существует и содержит
файл списка соединений для моторного контроллера, я
предложил бы оставить этот путь в покое.  

� Точно так же Вы можете отменить путь к библиотечной
папке Library Folder, которая содержит библиотеки
футпринтов. Если бы Вы сделали стандартную
инсталляцию FreePCB, то в этом нет необходимости.  

� Если Вы решаете перемещать свои папки, Вы можете
изменить заданные по умолчанию пути, редактируя файл
default.cfg в папке приложения. Если Вы перемещаете
библиотечную папку уже после создания проекта, 
редактируйте библиотечный путь в файле проекта
motor.fpc. 

� Оставьте число медных слоёв равное "4".  
� Заданный по умолчанию размеры дорожек и переходов 

Default trace and via widths будут применены к любому
соединению или дорожке, у которого нет явно 

назначенных размеров. Так как мы будем использовать заданную по умолчанию ширину дорожки 10 mils, 
оставим эти настройки в покое. 

� Menu of trace and via widths является списком значений, которые будут предложены, если Вы позже явно
назначите размеры дорожки или соединения. Вы не ограничены использованием этих значений, но
использование выбора из меню удобно и уменьшает шанс ошибки. Если Вы знаете, что Вы будете
использовать определенные размеры, которые не находятся в заданном по умолчанию меню, Вы можете
добавить их нажатием на Add. С помощью Delete можно удалить элементы, которые Вы не будете
использовать или редактировать элемент, выбрав его и нажав Edit. 

� В этом учебнике мы будем использовать размеры дорожки 10 и 15 mils. Выберите каждый из других размеров
в меню и удалите его. 

� Автосохранение Autosave позволит автоматически периодически сохранять Ваш проект. Разрешите Enable
это и установите интервал сохранения Interval в 5 минут. 
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� Теперь Ваш диалог должен походить на указанный ниже: 

� Нажмите OK, чтобы выйти из диалога.  
� Теперь в область заголовка окна FreePCB должен

читаться надпись "FreePCB - motor.fpc *", где
motor.fpc - название проектного файла, который
будет создаваться. Звездочка указывает, что проект
был изменен, и информация не была сохранена. 
Чтобы удостовериться, что Вы можете сохранить
файл, выберите Save от меню File (или нажмите
ctrl-s). FreePCB запишет файл и звездочка исчезнет. 

�  Если Вы хотите смотреть проектный файл, Вы
можете открыть motor.fpc редактором текста, таким
как Блокнот. Вы будет видеть, что там есть секция
опций [options]  файла, содержащая опции, которые
Вы устанавливаете, наряду с некоторыми другими
опциями по умолчанию. Большинство других
секций файла, таких как ajhvs [shapes], корпуса
[parts] и т.д. будут пустыми. 

� В следующей части мы начнём проектировать нашу 
PCB импортируя файл списка соединений. 
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7.3 Импорт списка соединений  

Файл списка соединений, который мы будем использовать, был перечислен в Разделе 5.14: Импортирование файлов
списка соединений. Возможно полезно было бы сделать обзор этой части перед продолжением. Корпус U2 
преднамеренно оставлен неправильным, таким образом, чтобы мы могли установить это после того, как файл будет
импортирован. 

� Выберите пункт Import из меню File, который вызовет диалог Open. 

� В случае необходимости, переместитесь в проектную папку "motor". Выберите файл motor.net.  
� Выберите Parts and Nets в секции Import диалога.  
� Выберите PADS-PCB в секции Format диалога.  
� Нажмите кнопку Open.  
� FreePCB откроет окно Log и импортирует список соединений, описывая этот прогресс в Log. Вы должны 

видеть сообщение указывающее, что футпринт для U2 не была найден. Нажмите OK, чтобы убрать Log. 
� Все импортированные корпуса компонентов будут расположены в стеке слева от символа начала координат в

окне размещения. 
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� Выберите View > All Parts (или нажмите клавишу "Home"), чтобы видеть все компоненты. Связи между
выводами компонентов будут показаны как ratlines. 

 
� Теперь установим недостающий футпринт. Для этого выберите Parts... из меню Project. В результате 

появится диалог View/Edit Part List: 

� Этот диалог показывает список всех
корпусов, которые были импортированы, 
с их позиционными обозначениями, 
идентификаторами упаковки и
футпринтами. 

�  Обратите внимание, что футпринт для U2 
показан как "??????", указывая, что
идентификатор упаковки "dip14" не
соответствует ни одному из футпринтов
Free PCB. Мы должны определить его. 

� Выберем строку для U2, кликнув по ней. 
Нажмите кнопку Edit Selection(s). Это вызовет 
диалог Add/Edit Part, показанный ниже. 
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� Этот диалог позволяет Вам
редактировать параметры для корпуса
U2, включая его футпринт. Все
доступные библиотеки футпринтов
показаны в большом древовидном
списке, занимающем большую часть
диалога. В первой строке указан "local 
cache (локальный кэш)", который
фактически не является библиотекой, 
но содержит все футпринты, которые в
данный момент загружены в FreePCB. 

� Разверните "th_dip.fpl" библиотеку
кликнув "+" рядом с ней. Эта
библиотека содержит футпринты для
DIP упаковок. Её имя начинается "th _", 
указывая, что он содержит футпринты с
контактными площадками, 
предназначенными для установки
штыревых компонентов (контактные
площадки с отверстиями). 

� Выберите "14DIP300" от библиотеки
кликнув по нему. Изображение
футпринта появится в окне
предварительного просмотра, и 
"14DIP300" должен заменить "??????" в
поле Footprint. Теперь диалог должен
выглядеть так: 

� Нажмите на OK.  
� Появится окно сообщения с вопросом - 

хотите ли Вы заменить все
идентификаторы "dip14" на 
"14DIP300", или только для U2. 
Поскольку мы используем только один
компонент с таким идентификатором, 
то без разницы, что Вы выберите, YES
или NO. 

� Теперь Вы возвратились к диалогу 
View/Edit Partlist, заменив "??????" на 
"14DIP300" для корпуса U2. 

� Нажмите OK. U2 теперь обретёт 
футринт, помещённый в позицию (0,0), 
как показано ниже. 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

 

OK, теперь все футпринты загружены. Сохраните свою работу. В следующем разделе мы создадим плату. 
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7.4 Рисование контура платы 

В этом разделе, мы создадим контур платы для нашей PCB. Это будет прямоугольная плата, 3 дюйма длиной и 2 
дюйма высотой. Полезно сделать обзор Раздела 5.10: Контур платы перед началом. 

� Во-первых, давайте переместим U2 в сторону. Для этого увеличте начало координат платы, помещая курсор
по этому месту и прокрутив вперед колёсико мышки (или нажимая PgUp). Выберите U2, кликнув по нему. В
результате вокруг него появится белая контурная, указывая, что компонент выбран. Нажмите F4, чтобы
начать его перемещение и сместите его влево от начала координат, чтобы создать место для контура платы. 
Перемещайте окно как нужно слегка поворачивая колесо прокрутки мышки или надавливая "space". (Между
прочим, окно, описывающее все "горячие" клавиши, доступно в Help > Keyboard shortcuts.). 

� Левым кликом мышки помещаете U2 в его новую позицию.  
� Во время рисования контурной линии платы действует сетка размещения Placement. Установите для неё 

разумно большое число, как 100 или 200 mils. 
� Выберите Board Outline из меню Add. Курсор должен измениться на перекрестие. Поместите перекрестие в

начале координат (то есть. X=0, Y=0). Левым кликом поместите первый угол платы. 
� Теперь переместите курсор вертикально вверх. За курсором будет тянуться сегмент, представляющий левую

сторону платы. Переместите курсор в X=0, Y=2000 и левым кликом поместите левый верхний угол платы. 
� Точно так же поместите углы в X=3000, Y=2000 и X=3000, Y=0.  

Теперь щелкните правой кнопкой мыши, чтобы замкнуть контурную линию платы нарисованную от последнего угла
до первого. Контур вашей платы должна быть похож на изображенный ниже: 
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Вы можете проверить позицию угла, кликнув по нему, чтобы выбрать. Маленький белый квадрат, показавшийся
вокруг угла, показывает, что он был выбран. Теперь нажмите F1 ("Set Position"), чтобы вызвать диалог Corner 
Position. Этот диалог отображает точные координаты выбранного угла, и позволяет изменять их, если Вы хотите. 
Этот диалог очень полезен, если Вы проектируете плату с необычными размерностями. 

 
� Если Вы желаете, можете испытать некоторые другие команды редактирования контура платы, описанные в 

Разделе 5.10: Контур платы. Когда Вы закончите, убедитесь, что контур был восстановлен к его оригинальной
прямоугольной форме. 

Сохраните проект при помощи пункта Save из меню File. 
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7.5 Добавление монтажных отверстий  

Теперь добавим монтажные отверстия в углах PCB. Полезно было бы сделать обзор Раздела 5.12: Монтажные
отверстия перед началом. 

� Монтажные отверстия фактически являются специальным типом корпуса, состоящего из единственного  
отверстия. Они добавляются к проекту как любой другой корпус. Они могут быть включены в файл списка
соединений, или они могут быть добавлены позже. Так как наш файл списка соединений не включал
монтажные отверстия, мы добавим их используя меню Add > Part. 

� Установите сетку размещения в небольшое число, такое как 25 mils.  
Выберите Part из меню Add. Следующий диалог должен появиться 

 
� Введите "H1" в поле диалога Reference . Это будет позиционное обозначение для первого монтажного 

отверстия. 
Разверните библиотечный файл C:\FreePCB\lib\th_mounting_hole.fpl, нажимая "+" рядом с ним. Затем нажмите на
"HOLE_125_SQUARE_250". Это футпринт монтажного отверстия 125 mils в диаметре, с квадратной площадкой со
стороной 250 mils. Это правильный размере для машинного винта #4. 
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Теперь диалог должен быть таким, как показано ниже: 
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Нажмите OK, чтобы закрыть диалог и начать перемещение монтажного отверстия. Переместите его в координаты X = 
150, Y = 150, как показанный ниже. 
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Нажмите левую кнопку мыши, чтобы разместить отверстие. Теперь схема размещения примет следующий вид: 
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� Точно так же, добавьте еще 3 монтажных отверстия в других углах PCB, используя позиционные обозначения
H2, H3 и H4, как показано ниже. Обратите внимание на то, что когда Вы используете диалог Add > Part для
добавления отверстий, их позиционные обозначения увеличиваются автоматически для каждого
последующего. Таким образом Вам только остаётся нажать OK или "return", чтобы добавить следующее
монтажное отверстие. 

 
� Теперь мы подключим отверстие H4 к цепи GND, так, чтобы его можно было использоваться для заземления 

PCB на корпус. Для этого мы должны выбрать вывод H4.1, вместо корпуса H4, так как подключения всегда
делаются к выводам. Имейте в виду, что в скриншоте выше, прямоугольник выбора вокруг H4 не похож на
"X", указывая, что выбран корпус, а не вывод. Строка состояния также показывает, что выбран корпус H4. 
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� Чтобы выбрать вывод H4, кликните где-нибудь в районе площадки. Теперь прямоугольник выбора должен
превратиться в "X" и в строке состояния появится сообщение о том, что вывод H4.1 был выбран, как показано
ниже. Если Вы хотите повторно выбрать корпус (чтобы переместить его, например), то щелкните  еще раз по
площадке. 

 
� С выбранным выводом, нажмите F1 ("Set Net"), что вызовет следующий диалог. Используйте

раскрывающееся меню, чтобы выбрать цепь GND, как показано ниже: 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

� Нажмите OK, чтобы назначить H4.1 на цепь GND. После этого к выводу подключится соответствующая
ratline. 
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� Теперь подключим H3.1 к GND, рисуя ratline от H4.1 к H3.1. С всё ещё выбранным выводом H4.1 нажмите
клавишу F4 ("connect Pin"). Теперь Вы будете тянуть ratline от H4.1. Поместите конец ratline на H3 и левым
кликом подключите H3.1 к H4.1, как показано ниже: 
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Точно так же, подключите H4 с H1 и H2. 
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Теперь нажмите F8 ("Recalc ratlines"), чтобы перерисовать ratlines, минимизировав их полную длину. 
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7.6 Размещение корпусов  

В этом разделе, мы разместим корпуса на нашей плате (PCB). 
� Установите сетку размещения Placement в разумное значение, такое как 100 mils, для того, чтобы разместить 

корпуса со штыревыми выводами, у которых интервал между отдельными выводами составляет  100 mils. Это
облегчит выравнивание корпусов. Позже, мы можем использовать меньшую сетку для SMT корпусов. 

� Выберите Show all из меню View (или нажмите клавишу "Home") так, чтобы Вы могли видеть все корпуса. 
Это поможет, если Вы сделаете окно FreePCB как можно больше (хотя тогда у Вас может быть проблемы с
просмотром этого учебника, если конечно у Вас нет второго монитора). 

� Прежде чем размещать корпуса, уделите минуту, чтобы сделать обзор схемы. Может быть полезным
напечатать схему так, чтобы Вы могли обращаться к ней, проектируя PCB. Так как U1 - наибольший и
наиболее "подключенный" компонент, я предложил бы поместить его куда-нибудь около центра платы, с
другим ИС неподалёку. Разъёмы JP1-JP6, вероятно, должны быть помещены около краев. 

� Давайте начнём с размещения U1. Выберите его, кликнув по нему. Белая контурная линия должна появиться
вокруг корпуса, показывая, что он был выбран. Будте осторожными, что бы не нажимать на одну из площадок
или позиционное обозначение, или Вы выберете это вместо всей корпуса. Если у Вас есть проблема с
поиском U1, Вы можете использовать пункт View > Show part, чтобы выбрать нужное позиционное 
обозначение. 

� Предупреждение: Иногда может быть трудно выбрать маленький корпус, у которой есть относительно
большие площадки, такие как a конденсатор поверхностного монтажа. Однако, вот уловка, которую Вы
можете использовать. FreePCB никогда не будет выбирать кое-что, что уже выбрано, если есть альтернатива. 
Поэтому, если Вы нажимаете на корпус и выбираете площадку вместо этого (или какая-нибудь структура
перекрывания), щелкаете еще раз, и Вы, скорей всего, выберите корпус. Вы должны убедиться в том, что
между отдельными щелчками есть достаточный период времени, чтобы Windows не восприняла их за
двойной щелчок, который обычно ничего не делает. С выбранным U1, нажмите F4, чтобы начать его
перемещение. Перетащите его к центру платы. Курсор будет "прикреплен" к первому выводу корпуса. 
Вращайте корпус, нажимая F3, так, чтобы корпус стал вертикально и вывод 1 располагался в верхнем левом
углу. Когда корпус окажется в центре платы, левым кликом разместите его. Результат должен выгляденть
примерно так: 

 

 

� Обратите внимание, что ratlines двигаются с корпусом. После того, как Вы разместили его, возможно
обратите внимание, что часть из ratlines изменили своё подключение к выводам. Это потому, что FreePCB 
автоматически оптимизирует ratlines для минимизации их полной длины. 
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� Теперь давайте поместим другие DIP ИС, U1 и Y1, как показано ниже: 

� Теперь поместите DIP разъёмы вдоль краев платы, как показано ниже: 

В процессе размещения корпусов смотрите на ratlines, чтобы попытаться найти оптимальное расположение для более
легкой последующей разводки. Однако, не обязательно обращать внимание на все ratlines. На этой плате мы будем
использовать внутренние слои для цепей VCC и GND. Поэтому, ratlines для этих цепей лучше сделать невидимыми. 
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� Выберите Nets... из меню Project. Появится следующий диалог: 

 
Большая часть диалога занята списком цепей. Рядом с названием каждой цепи показано количество выводов, 
входящих в цепь, размеры дорожек и переходных отверстий. Кроме того, слева от каждого названия есть
переключатель, который определяет видимость ratlines данной цепи. В данный момент все цепи видимы. Чтобы
сделать VCC и GND невидимыми, снимите галочки рядом с ними. Затем нажмите OK. Теперь видимых ratlines стало
меньше. 
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� Теперь разместите остальные корпуса. Как упомянуто выше, выбор маленьких корпусов SMT конденсаторов
может оказаться сложным, если Вы не располагаете курсор точно между его контактными площадками или не
используете метод с двух щелчков. Вы можете использовать мелкую сетку размещения Placement, такую как 
50 mils. После того, как все корпуса будут размещены, возможно, Вам придется ещё несколько раз
перемещать их, чтобы создать свободное место место или улучшить эффективность подключений. 
Попытайтесь устанавливать корпуса не слишком плотно. В реальной жизни от правильного размещения
корпусов зависит успех разводки. Так что не жалейте времени на то, чтобы сделать это правильно. Однако, 
как бы то ни было, на данной плате это не должно быть большой проблемой. 

� Вы можете видеть мой вариант размещения корпусов ниже. Обратите внимание, что я переместил U2 вправо
от U1, чтобы сократить длину ratlines между этими корпусами. 

 
� Теперь, давайте разместим позиционные обозначения корпусов в слое шелкографии так, чтобы они были

правильно ориентированы и хорошо видимы после того, как компоненты будут впаяны. Во-первых, 
установите маленькое значение сетки размещения Placement, например 10 mils, для более точного  
размещения этих маленьких элементов. Выберите каждое позиционное обозначение, кликая по нему, и
переместите его клавишей F4. Как и с корпусами, F3 вращает позиционное обозначение во  время
перемещения. 

� Так как позиционные обозначения для монтажных отверстий не представляют пользы, можете сделать их
невидимыми, последовательно выбирая их, затем нажимая F5 ("Set Size") и обнуляя размер. Поскольку они
расположены прямо над контактными площадками отверстий, Вы, скорей всего, не сможете их выбрать. 
После клика будет выбираться либо корпус, либо вывод. Поэтому, используйте маску выбора, чтобы
отключить выбор корпусов и/или выводов, а затем кликните по позиционному обозначению. В качестве
альтернативы, выберите корпус монтажного отверстия, а затем выберите Set Ref. Text Size из меню правого
клика. Таким же образом можно сделать их видимыми снова, увеличив размер. 
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Вот конечный скриншот: 
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7.7 Добавление корпусов и редактирование соединений  

Изменение проекта PCB через добавление, замену или удаление корпусов или изменение списка соединений, иногда
упоминается как редактирование "на лету". FreePCB дает Вам фактически неограниченную свободу для этого типа
редактирования. Однако, Вы должны использовать эту свободу осторожно. Имейте в виду, что, изменяя partlist и
список соединений, Вы создаете несоответствие между своей схемой размещения PCB и схемным оригиналом. Если
вы вносите любые значимые изменения, то также должны обратно внести их в схему. В противном случае
диагностика PCB может стать кошмаром. Вообще, "оперативное" редактирование лучше всего используется для
относительно незначительных изменений. Если вам нужно выполнить более обширные переработки, то лучше
вернуться в схемный редактор и создать новый файл списка соединений.  
В этом разделе мы добавим три блокировочных конденсатора к нашему PCB, один для каждого DIP корпуса. Мы
подключим их к цепям VCC и GND. FreePCB обеспечивает несколько способов, чтобы сделать это, и мы их все
обсудим. 

� Установим разумное значение сетки размещения для конденсаторов поверхностного монтажа, например, 50 
mils.  

� Выберем Parts... из меню Project. В результате появится диалог View/Edit Part List . 

 
� Обратите внимание, что последним в списке корпусов будет конденсатор C4. Мы добавим C5, C6 и C7.  
� Нажмите Add New Part. Это вызовет диалог Add/Edit Part. 
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� Разверните библиотеку sm_capacitor.fpl, кликая по символу "+" рядом с ней.  
� Выберите футпринт "C1206", кликнув по нему. Поле Footprint должно измениться на "C1206".  
� Введите "C5" в поле Reference. Теперь Вы должны видеть: 

  
Нажмите OK, чтобы добавить корпус в список partlist. 

� Теперь Вы вернетесь в диалог View/Edit Part List. Нажмите OK, чтобы выйти. Новый конденсатор C5 
появился слева от начала координат. 
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Выберите C5, кликнув по нему, и разместите его сверху от Y1. Если необходимо, переместите текст позиционного
обозначения таким образом, чтобы оно было видимо. 
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� Теперь подключим выводы C5. Для этого делаем видимыми только цепи VCC и GND. Выберите Project > 
Nets..., чтобы вызвать диалог View/Edit Netlist. 

 
Нажмите кнопку Make all visible/invisible дважды, чтобы очистить все галочки и сделать все соединения
невидимыми. Затем установите галочки для VCC и GND, чтобы сделать эти соединения видимыми. Затем нажмите
OK. Теперь видимы только ratlines цепей VCC и GND. 
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� Нажмите на крайнюю справа площадку C5, чтобы выбрать её. Если Вы не вращали корпус, то это будет
вывод 2. Нажмите F1 ("Set Net"), чтобы появился следующий диалог: 

 
� Из выпадающего меню, выберите VCC, или просто напечатайте "VCC" в текстовом поле. Нажмите OK, чтобы

подключить вывод. Нажмите F8 ("Recalc. Ratlines"), чтобы повторно вычислить ratlines для VCC, и  включить
новый вывод C5.2. 

� Теперь выберите крайнюю левую площадку C5, и повторите всю процедуру, чтобы подключить её к GND. 
Теперь Вы должны видеть ratlines у обеих площадок C5. 

 
Теперь давайте использовать немного другой метод, чтобы добавить C6. Выберите Add > Part. В результате появится 
диалог Add/Edit Part. Это тот же самый диалог, что мы вызывали раньше из диалога  View/Edit Partlist, за 
исключением того, что кнопка Drag to position теперь разрешена и выбрана. На сей раз, для нового корпуса выберите
футпринт C0805. Введите C6 в поле Reference. 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

 
� Нажмите OK. Теперь Вы можете перемещать C6. Поместите его около выводов 19 и 20 U1, как показано

ниже. 
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Мы подключим C6 к цепям VCC и GND, рисуя ratlines между выводами. Выберите верхнюю площадку  C6, кликнув
по ней. Затем нажмите F4 ("Connect Pin"), подключив ratline к площадке. Переместите курсор к площадке вывода 20 
U1 (который присоединен к цепи VCC), и кликните по ней, чтобы подключить ratline к этому выводу. Точно так же, 
подключите нижнюю площадку C6 к выводу U1.19. Выберите C6, кликнув по нему, и нажмите F8 ("Recalc. Ratlines"), 
чтобы повторно вычислить ratlines для C6. Ваше размещение должно выглядеть следующим образом: 

� И наконец, добавьте C7 тем же самым способом, которым мы добавили C6, используя Add > Part. Поместите 
его сверху от U2, так же как мы поместили C5 сверху от Y1. 
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Теперь давайте организуем подключение к VCC и GND, используя пункт Project > Nets..., вызывающий диалог 
View/Edit Netlist. Выберем цепь VCC, нажимая на неё, как показано ниже. 

 
Теперь нажмите на Edit selection. Появится диалог Add/Edit Net. 

� Введите C7.2 в текстовое поле рядом с кнопкой Add 
Pin. Затем нажмите на Add Pin. Вывод C7.2 должен
быть добавлен к списку Pin list. Нажмите OK для
подтверждения. Это вернёт Вас к диалогу View/Edit 
Netlist. 

� Теперь выберите цепь GND, кликнув по ней, и
редактируйте список вывода так же, как это было
сделано для VCC, но на сей раз добавляя C7.1. 

� Совет: Когда Вы добавляете вывод компонента к цепи, 
используя диалог Add/Edit Net, убедитесь, что Вы
кликнули на Add Pin. Если просто кликнуть по OK, то
это приведёт к завершению диалога без добавления
вывода. 
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Нажмите F8 ("Recalc. Ratlines"), чтобы добавить ratlines к недавно добавленным выводам компонентов. Схема
размещения должна теперь смотреться так, как показано ниже: 

В следующем разделе мы будем использовать медные полигоны и обрубленные дорожки, чтобы создать цепи VCC и
GND. 



FreePCB.  Руководство пользователя 

 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

7.8 Добавление полигонов 

В этом разделе, мы создадим проводящие области на внутренних слоях платы для плоскостей питания и земли. 
� Выберите Project > Nets.... В результате должен появиться диалог View/Edit Netlist. Если Вы продолжаете

действия описанные в предыдущем разделе, то будут видимы только цепи VCC и GND, как показано ниже. 

 
� Нажмите на Make all visible/invisible один или два раза, чтобы сделать все цепи невидимыми. Затем сделайте

видимой только цепь GND. 
� Обратите внимание, что ширина дорожки для каждого соединения "0". Это означает, что по умочанию будет

использовано проектное значение 10 mils. Давайте увеличим ширину дорожку цепи GND до 15 mils. 

� Выберите цепь GND, нажимая на ее имя, которое
после этого подсветится. Тогда нажмите на кнопку 
Change widths. В результате появится следующий
диалог. 

� Выберите "15" для новой ширины цепи GND, выбрав
это значение из раскрывающегося меню, или введя
"15" в текстовое поле. Оставьте кнопку Use default 
via for this trace width выбранной. Если мы хотим
отменить значения, установленные по умолчанию
для переходных отверстий, то выбираем Set via 
widths  и явно устанавливаем  ширину площадки и
размер отверстия для переходного отверстия в
текстовых полях. Нажмите OK, чтобы выйти из
диалога. 
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Диалог View/Edit Netlist теперь похож на изображенный ниже: 

 
Нажмите OK, чтобы выйти из диалога. В окне схемы размещения теперь показаны только ratlines для соединения
GND. 
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Теперь мы добавим полигон для цепи GND. Для этого установим сетку разводки 50 mils. Затем
выберем Add > Copper Area. В результате появится следующий диалог. 

 
Мы будем использовать слой "inner 1" для полигона GND. Для этого выберем "GND" из раскрывающегося списка Net 
, или тип "GND" в текстовое поле. Выберем "inner 1" из списка Layer. Установим шаблон штриховки Full. 
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� Нажмите OK, чтобы выйти из диалога и начать рисовать ломаную линию внешнего контура полигона. Курсор
должен измениться на перекрестие. Допустим, что мы хотим разместить край полигона на расстоянии 50 mils 
от контура платы. Поместите курсор в левый нижний угол будущего полигона, который имеет координаты X 
= 50, Y = 50. Левым кликом мышки разместим первый угол. Затем переместите курсор в координату X = 50, Y 
= 1950 и левым щелчком мышки разместите второй угол. Разместите третий угол в координатах X = 2950, Y = 
1950 и четвертый угол в координатах X = 2950, Y = 50. После размещения четвертого угла, щелкните правой
кнопкой мыши, чтобы замкнуть ломаную линию. Теперь Ваша плата должна быть похожей на изображенную
ниже: 

� Обратите внимание, что область полигона заполнена диагональным шаблоном штриховки, имеющим цвет
слоя "inner 1". Кроме того, большинство ratlines для цепи GND исчезло, и поверх выводом штыревых
компонентов этой цепи появились символы X-shaped в цвете ratline. Они указывают на внутреннее
подключения этих штырьков к полигону цепи GND, с использованием металлизированных отверстий и
тепловых барьеров. 

� Теперь нам необходимо подключить выводы SMT компонентов к полигону GND. Для этого будем
использовать обрубленные дорожки stud traces, которые начинаются на выводах компонентов и
заканчиваются переходным отверстием в плоскость полигона GND. 

� Начнём c нижнего вывода C1. Для этого выберем этот вывод, кликнув по нему. Белый блок "X" появиться
вокруг вывода, указывая, что он был выбран, и в строке состояния появится описание вывода. 
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� Теперь начните разводку обрубленной дорожки, нажав F3 ("Start Stub"). При этом курсор должен измениться
на крест и сможете рисовать дорожку на верхнем медном слое. Прокручивая колёсико мышки или клавишей
"Page Up" можно увеличить масштаб изображения. Переместите курсор на короткое расстояние ниже вывода
и левым щелчком установите излом. Затем щелкните правой кнопкой мыши, чтобы закончить дорожку. В
изломе появится переходное отверстие, как показано. Обратите внимание, что на переходе есть символ
теплового барьера, указывая на внутреннее подключение с полигоном GND. 

� Если Вы недовольны своей дорожкой, Вы можете удалить его, выбирая сегмент дорожки или конечное
переходное отверстие и нажав F7 ("Delete Connection"). Вы можете переместить переходное отверстие, 
выбрав его и нажав F4 ("Move Vertex"). Вы можете добавить сегменты, выбрав переходное отверстие и нажав
F2 ("Add Segment"). 

� Так как обычно обрубленные дорожки используются для подключения к медным областями на других слоях, 
конечное переходное отверстие добавляется автоматически после завершения обрубленной дорожки. При
желании, Вы можете удалить переходное отверстие, выбрав его и нажав F3 ("Delete Via"). Это может быть
полезно, если Вы подключаете вывод с медной областью на том же самом слое, или если используете
обрубленную дорожку для другой цели, например для экранирования. 
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Теперь, когда Вы знаете, как это делается, добавьте обрубленные дорожки ко всем SMT выводам, у которых есть
ratlines. Возможно Вам придётся переместить некоторые из позиционных обозначений, чтобы сохранить их
свободными от переходных отверстий, так как это плохая практика, когда элемент шелкографии накладывается на
площадки или переходы. Ваша плата должна смотреться примерно так: 

� Поздравляю, Вы развели всю цепь GND, которая безусловно является наибольшей цепью в проекте. Полигон
сильно упростил эту задачу. 

� Так как мы не будем делать никакой разводки в слое "inner 1", а шаблон штриховки может раздражать при
работе с другими слоями, давайте сделаем его невидимым. Для этого выберите Layers из меню View, чтобы 
вызвать диалог View/Edit Layers, и снимите переключатель Visible рядом с Inner 1. Нажмите OK, и медная
область должна исчезнуть. В качестве альтернативы, мы можем изменить шаблон штриховки, выбрав сторону
полигона и щелкнув правой кнопкой мыши, а затем выбрав Hatch style в контекстном меню. 

� Теперь, давайте добавим полигон для цепи VCC на медном слое "inner 2". Для этого необходимо повторить те
же самые шаги, которые были выполнены для области GND: 
� Сделайте цепь VCC видимой.  
� Измените ширину дорожки VCC на 15 mils.  
� Нарисуйте полигон цепи VCC в слое "inner 2" (Вы можете использовать те же самые угловые позиции, 

как для полигона GND).  
� Добавьте обрубленные дорожки для всех площадок SMT цепи VCC. Их должно быть, для C1, C5, C6 и 

C7.  
� Сделайте слой "inner 2" невидимым. 
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� Выберите Project > Nets..., чтобы начать диалог View/Edit Netlist. Сделайте цепи VCC и GND видимыми. 
Теперь Ваша плата должна быть такой: 

В следующем разделе мы разведём остальную часть соединений на верхних и нижних медных слоях. 
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7.9 Разводка 

Хорошо, давайте разведём нашу плату (PCB). Перед началом будет полезно сделать обзор Раздела 5.13: Соединения, 
Ratlines и Разводка. 

� Дополнительно: Если Вы хотите попробовать некоторые из особенностей редактирования ratline, которые
были описаны в Разделе 5.13: Соединения, Ratlines и Разводка: 
� Сначала сохраним проект. Таким образом Вы сможете перезагрузить его, если что-то испортите.  
� Из меню, выберите Project > Nets..., чтобы вызвать диалог View/Edit Netlist. Сделайте все соединения 

невидимыми кроме GND. 
� Выберите ratline и удалите её, нажимая F7 ("Delete Connect"). Затем нажмите F8 ("Recalc. Ratlines"), и

ratline должна вновь появиться. 
� Вы можете добавить новую ratline между выводами того же самого соединения, выбирая один из выводов

и используя F4 ("Connect Pin"), который позволяет Вам протянуть ratline к другому выводу. Нажмите F3 
("Lock Connect"), чтобы блокировать её. Теперь, если Вы нажимаете F8 ("Recalc. Ratlines"), некоторые
другие ratline цепи должен исчезнуть. 

� Вы можете разблокировать блокированное подключение при помощи F3. Теперь, если Вы нажмете F8, 
подключения должны вернуться назад к их оригинальному состоянию. 

� OK, назад к делу. Используйте диалог View/Edit Netlist, чтобы сделать все цепи видимыми.  
� В случае необходимости, используйте диалог View/Edit Layers, чтобы сделать медные слои inner1 и inner2 

невидимыми 
� Теперь Ваша плата должна смотреться примерно так: 
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� Выберите разумно маленькое значение для сетки разводки, такое как 10 mils.  
� Мы будем разводить дорожки на верхнем и нижнем медных слоях, так как inner1 и inner2 использованы для

полигонов VCC и GND. В настоящее время активный слой показан в строке состояния ("Top" на скриншоте
выше). Нажмите клавишу "4", чтобы переключиться на нижний слой (так как имеется 4 слоя). Нажмите
клавишу "1", чтобы переключиться назад на верхний слой. Клавиши "2" и "3" выбирают внутренние (inner) 
слои. 

� Теперь выберите одну из длиннейших ratlines, такую как одна внизу слева от JP4.8 к U1.14. Нажмите F4 
("Route Segment"), чтобы начать разводку. Курсор должен измениться на перекрестие, и Вы сможете тянуть
сегмент дорожки от того вывода, который был ближайшим к курсору во время нажатия F4. Так как активный
слой - "Top", сегмент дорожки будет окрашен в зелёный. Обратите внимание, что сегменты дорожки
фиксируются под углом кратным 45 градусов. 

� Разместите первый излом дорожки левым кликом мышки. Теперь Вы будете тянуть новый сегмент от этого
излома. Нажмите "4", чтобы переключиться на нижний слой. Сегмент станет красным, а в изломе появится
переходное отверстие. 

� Продолжите добавлять сегменты, пока не завершите дорожку на последнем изломе в конечном выводе. 
Нажмите F4 ("Complete Segment"), чтобы добавить последний сегмент, или кликните левой кнопкой мыши на
конечном выводе. Ваша дорожка должна смотреться примерно так как показано на скриншоте ниже. 
Обратите внимание, что я использовал больше сегментов и переходов чем необходимо. 

  

Теперь давайте попытаемся редактировать дорожку, которую только что протянули. Выберите один из изломов, 
нажимая на него. Маленький белый блок вокруг излома указывает, что он был выбран, и информация о изломе
должна появиться в строке состояния. Опции редактирования для излома: 

� F1 ("Set Position") - появляется диалог, позволяющий явно установить координаты X и Y излома.  
� F4 ("Move Vertex") - запускает перемещение излома при помощи мыши. Угол излома не будет  

действовать, но сетка разводки будет.  
� F5 ("Delete Vertex") - удаляет излом, и отменяет разводку для двух смежных сегментах, которые будут

заменены единственным сегментом ratline.  
� F6 ("Unroute trace") — отменяет разводку всей дорожки, которая возвращается к ratline.  
� F7 ("Delete Connect") - удаляет дорожку, не заменяя её ratline.  
� F8 ("Recalc. Ratlines") - восстанавливает ratlines для соединения. 

� Теперь выберите один из сегментов дорожки, который должен побледнеть, указывая на то, что был выбран. 
Опции редактирования для сегмента дорожки: 
� F1 ("Set Width") - появляется диалог, разрешающий Вам установить ширину цепи, дорожки или сегмента

дорожки.  
� F5 ("Unroute Segment") - заменяют сегмент на ratline.  
� F6 ("Unroute trace") — отменяет разводку всей дорожки, которая возвращается к ratline.  
� F7 ("Delete Connect") - удалть дорожку, не заменяя её на ratline.  
� F8 ("Recalc. Ratlines") - восстанавливает ratlines для цепи. 

� Большинство этих опций редактирования довольно очевидны, таким образом Вы можете испытать их
самостоятельно. Попробуйте удалить излом или сегмент дорожки, а затем изменить маршрут прокладки 
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ratline. Ratline между изломами направлены точно так же как ratlines между выводами.  
� Теперь давайте изменим размеры некоторых дорожек. Увеличте окно на компонентах в верхнем левом углу, 

как показано ниже: 

� Дорожки между JP6, D1, R3, C2 и U3 должны быть мощными и поэтому давайте сделаем их шире чем
предусмотрено значением по умолчанию - 10 mils. Выберите ratline между JP6.1 и D1.1. Строка состояния
должна показать, что это - соединение "N00534". Нажмите F1 ("Set Width"). В результате должен появиться
следующий диалог: 

В выпадающем меню для Trace width (mils) есть две опции, 10 и 15 mils. Давайте используем 20 mils вместо этого, 
печатая "20" непосредственно в текстовое поле. Нажмите OK, чтобы выйти из диалога. 

� Теперь разведите дорожку. Так как D1 - корпус SMT, сегмент дорожки, который соединяется с D1.1, должен
быть на верхнем слое. Если Вы начнёте разводку от этого вывода, то активный слой будет автоматически
установлен в  "Top". Если Вы начинаете разводку от JP6.1, который является штыревым, Вы можете начать
дорожку или в слое "Top" или в слое "Bottom", но Вы должны быть в слое "Top", чтобы завершить дорожку на
D1.1. 
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Точно так же, установите ширину других мощных дорожек в 20 mils и разведите их. Ваша плата должна стать
похожей:  

Теперь разведите остальные дорожки на плате. Не стесняйтесь творчества с размерами дорожки и разводкой, 
если Вам это нравится. Если бы мы фактически собирались произвести плату, то это могло бы выглядеть примерно
так. 
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7.10 Добавление текста 

Чтобы завершить наш шедевр, давайте добавим некоторый текст в верхнем слое шелкографии, чтобы
идентифицировать плату. 

� Выберите Text из меню Add, чтобы появился диалог Add/Edit Free Text. 
 

� Введите "Motor Controller" в поле Text. Удостоверьтесь что Units
установлены в "MIL". Введите "100" в поле Uppercase Height, 
как показано ниже. 
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� Нажмите OK. Теперь Вы сможете перемещать прямоугольник, который представляет рамку редактирования
для текста. Поместите эту рамку недалеко от нижнего края PCB, и кликните левой кнопкой мыши. 

Это завершает нашу схему размещения PCB. В следующем разделе мы будем создавать файлы Gerber и сверловки, 
которые Вы послали бы изготовителю, чтобы изготовить Вашу плату. 
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7.11 Проверка правил проектирования 

Design Rules (Правила проектирования) - ряд правил, которые устанавливают минимальные пределы для
размерностей, таких как ширина дорожки и зазоры. Они необходимы потому, что производственный процесс PCB 
подвергается определенным ограничениям и допускам, и проект должен учесть это. Например, Вы не можете
использовать ширину дорожки 1 mil в Вашей плате потому, что физически невозможно такие дорожки протравить. 
Если у Вас есть своя PCB, которую необходимо изготовить, то будет необходимо обеспечить правила
проектирования, основанные на техпроцессе производителя. Например, Advanced Circuits рекомендует следующие
правила для их дешевого процесса: 

Minimum trace width  
Минимальная ширина дорожки  

0.008 inch (0.2032 мм) 

Minimum clearance between copper features  
Минимальный зазор между медными областями 

0.008 inch (0.2032 мм) 

Minimum distance from copper to edge of PCB  
Минимальное расстояние от меди до края платы 

0.014 inch (0.3556 мм) 

Minimum annular ring width (pins)  
Минимальная ширина дужки для штыревых выводов 

0.007 inch (0.1778 мм) 

Minimum annular ring width (vias)  
Минимальная ширина дужки для переходных отверстий 

0.005 inch (0.127 мм) 

Minimum silkscreen line width  
Минимальная ширина линии шелкографии 

0.008 inch (0.2032 мм) 

 
Программа контроля правил проектирования (Design Rule Checker или DRC) является инструментом, который Вы
можете использовать, чтобы удостовериться, что созданный проект не содержит нарушений этих правил. Они
упоминаются как Ошибки (Errors) DRC. Так как Ваш учебный проект, может не содержать ошибок DRC, я предлогаю
закрыть его и вместо него открыть проект C:\freepcb\tutorial\motor_drc_errors.fpc, как показано ниже. Этот проект
содержит несколько типичных ошибок. Посмотрим, сможете ли Вы найти их. 
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Теперь давайте выполним Программу контроля правил проектирования. Вы можете начать её, выбрав пункт меню
Tools > Design Rule Check. Это вызовет следующий диалог: 

Мы изменим поля в диалоге, чтобы соответствовать Advanced Circuits значениям. Trace width (Ширина дорожки) 
должна быть установлена в 8 mils. Значения pad to pad, pad to trace, trace to trace и copper area to copper area 
должны быть установлены в 8 mils. annular ring (pins) значение должно быть установлено в 7 mils, и annular ring 
(vias) значение, должно быть установлено в 5 mils. board edge to any copper поле должен быть установлено в          
14 mils. hole to pad or trace, board edge to hole и hole to hole значения не даны, что позволяет нам использовать    
25 mils, которые кажутся разумными. Ваш диалог должен быть похожим на следующий: 
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Теперь нажмите OK, чтобы выполнить проверку. Новый диалог списка ошибок должен появиться, как показано ниже: 

Ошибки 0 и 1 являются нарушениями минимального зазора между площадками и краем платы. Ошибки 2 и 3 
являются нарушениями зазора дорожки и площадки. Если Вы пристально рассмотрите окно схемы размещения, то
увидите, что символы, состоящие из маленьких оранжевых колец, на месте каждой ошибки, как показано ниже: 
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Эти маленькие круги могут быть трудно различимыми, но если Вы нажмете клавишу "d" на клавиатуре, они
становятся намного большими сплошными кругами, как показано ниже: 

Теперь увеличте окно на одной из ошибок, например на U1.16. 

В этом случае, ошибкой является нарушение зазора между площадкой
U1.16 и сегментом дорожки, проходящим через неё, но не
принадлежащем той же самой связи. Ой! 

Нажмите на кольцо ошибки DRC, чтобы подсветить его. Элементы PCB, 
которые вызвали нарушение, будут также подсвечены, как показано. 
Кроме того, описание ошибки появится в строке состояния. 
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Теперь давайте увеличим окно на ошибках DRC с левой стороны 
платы, и выберем одну из них.

В этом случае обнаружена ошибка - нарушение зазора между
площадкой и краем палаты. В принципе, JP6 расположен слишком
близко к краю платы. Мы можем решить проблему, перемещая его
далее вправо, как показано ниже. 

Я предоставлю Вам самим найти и устранить последнюю ошибку. Тогда Вы можете выполнить программу контроля
правил проектирования снова и она не должна найти ошибки. Вы должны перезагрузить свой проект motor.fpc
прежде, чем начнёте следующий раздел. Когда Вы будете закрывать проект motor_drc_errors.fpc, я предложил бы
НЕ сохранять свои изменения. Таким образом Вы или кто-то еще сможет использовать его снова. 

Вы можете исправить ошибку, изменив маршрут дорожки, чтобы
обогнуть площадку, как показано. Отметьте, что символ ошибки DRC 
автоматически не исчезает, но Вы можете его удалить, выбрав и нажав
клавишу "Delete", или сделав повторный запуск программы контроля
правил проектирования. 
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7.12 Созданий файлов сверловки и Gerber 

Конечным шагом в этом учебнике является создание файлов Gerber и сверловки, который Вы можете послать
изготовителю PCB. Перед продолжением будет полезно сделать обзор Раздела 5.19: Экспорт файлов сверловки и
Gerber. 
Выберите Generate CAM files... из меню File. "CAM" - акроним для "Computer-Aided 
Manufacturing (Автоматизация производства)". В результате должен появиться следующий диалог: 

В секции Files, выберите файлы, которые Вы желаете создать, проверяя или не проверяя поля рядом с ними.  
В секции Gerber file options Вы можете выбрать: 

� Include board outline — добавлять контур платы к каждому файлу Gerber  
� Add moires - добавляет муаровые шаблоны (также названный "targets (цели)") к каждому файлу Gerber  
� Add layer description text - добавляет текстовую строку, описывающую слой, к каждому файлу Gerber  
� Add pilot holes - добавляют пилотный отверстия к площадкам и переходам на верхнем и нижнем слоях 
� Use thermal reliefs for pins - использовать тепловой барьер для подключения штыревых выводов к медной 

области  
� Use thermal reliefs for vias - использует тепловой барьер для подключения переходного отверстия к медной 

области  
� Make cutouts in solder mask for vias - делать открытия для площадок переходных отверстий в слоях маски 

припоя 
В секции Panelizing Вы можете выбрать количество копий, которые будут произведены в каждом направлении и
интервал между копиями. 
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Секция Gerber file dimensions позволяет Вам устанавливать числовые параметры для файлов Gerber. Когда Вы
делаете реальную плату, то получите их от изготовителя PCB. Значения, показанные выше, довольно типичны для
дешевого, многослойного процесса. 

� Copper to copper-fill clearance - зазор который будет создан вокруг дорожек и переходных отверстий,  
проходящих через медные области. 

� Hole-edge to copper-fill clearance - зазор который будет создан вокруг отверстий, проходящих через медные 
области. 

� Solder mask clearance - зазор, который будет создан вокруг площадок и переходов в маске припоя. 
� Pilot hole diameter - диаметр пилотных отверстий в площадках, если Вы захотели включить их.  
� Minimum silkscreen stroke width - минимальная ширина дорожки, которая будет использоваться для

элементов на слое шелкографии. 
� Thermal relief line width - ширина дорожек в тепловом барьере, которые соединяют площадки с медной 

областью. 
� Board outline line width - ширина дорожек используемых для рисования контура платы.  
� Annular ring width (pins) - ширина кольца помещённого во внутреннем слое вокруг штыревого вывода для

теплового барьера. 
� Annular ring width (vias) - ширина кольца помещённого во внутреннем слое вокруг переходного отверстия

для теплового барьера. 
� Shrink SMT pads for paste mask - сокращения размера площадки для маски пасты. 

Output folder - папка получатель для файлов, которые будут созданы. По умолчанию, это - подпапка проектной папки, 
названной "CAM". При желании, Вы можете изменить её. Папка будет создана, если она не будет уже существовать
(хотя его родительская папка должна существовать).  
Теперь нажмите Create files, чтобы создать файлы. Должен появиться следующий диалог: 
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Если были какие-нибудь ошибки, то в диалоге появятся сообщения об них. Обычно, ошибка приведет к прерыванию
создания текущего файла и перехода к следующему. Нажмите OK, чтобы закрыть диалог.  
Теперь Вы можете рассмотреть свои файлы Gerber и файлы сверловки, используя Gerber Viewer, такие как ViewMate

от PentaLogix (которые бесплатны и доступны здесь: http://www.pentalogix.com/viewmate.php). При 
помощи ViewMate можно также напечатать проверочную копию на Вашем принтере. Вы должны ВСЕГДА проверять
свои файлы прежде, чем использовать их для изготовления PCB. Кроме того, читайте Раздел 5.20.3: Размеры сверла
для важной информации о файле сверловки.  
Скриншоты файлов Gerber для верхнего слоя шелкографии, верхнего и внутреннего 1 медных слоёв нашего учебного
проекта показаны ниже. Они выглядят довольно сырыми в скриншотах. Чтобы оценить, насколько точны они на
самом деле, Вы должны открыть свои собственные файлы в ViewMate и увеличить некоторые небольшие
особенности. 
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Хорошо, это - конец обучения. Я попытался охватить большинство главных особенностей FreePCB. Теперь Вы  
готовы создать свою собственную плату. 
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8. Форматы файлов  

8.1 Файл проекта 

Проектный файл (*.fpc) — это текстовый файл ASCII, содержащий всю информацию для единственного проекта. Он
состоит из нескольких разделов, при этом каждый раздел начинается с имени, заключенного в квадратные скобки,: 
например, "[options]". В каждом разделе есть несколько элементов, где каждый элемент начинается  ключевым словом
с двоеточием, таким как "units:" После каждого ключевого слова обычно следует один или несколько параметров. 
Могут быть элементы, вложенные один ниже другого. Эта связь показывает обозначение строк для вложенных
элементов. 
Строки параметров, следующие за ключевым словом разделяются пробелами. В порядке разрешения пробелов внутри
параметра, такого как пробел в имени файла, первый параметр, следующий за ключевым словом может быть окружен
двойными кавычками (например, "test file"), и пробелы между кавычками не будет считаться разделителем. 
Последующие параметры не должен содержать внутри пробелов. 
Многие из параметров представляют размерности, такие как длину или ширину линии. По умолчанию,  
размерности выражены в нанометрах. Суффикс может быть добавлен к размерности, чтобы указать другие 
единицы измерения, такие как "100MM" или "23.5MIL". Для футпринттов есть элемент, названный "units:" который
изменяет заданные по умолчанию единицы измерения для всех параметров футпринта, так, чтобы суффиксы не
требовались.  
Вот список всех секций и элементов, которые могут появиться в проектном файле. Для каждого элемента, показано
ключевое слово, за которым следует список параметров , где описание каждого параметра окружено символами "<>", 
а опциональные элементы окружены "{}". Этот список является текущим на программную версию 1.327. 

[options] 
version: <the version number of the freepcb.exe application that created the file, such as "1.328"> 
file_version: <the version number of the oldest freepcb.exe application that can read the file, such as 
"1.312"> 
project_name: <the name of the project, usually the same as the project file name without the ".fpc" 
extension> 
full_library_folder: <the absolute path to the default library folder for the project> 
CAM_folder: <the absolute path to the folder for CAM files , or "" if not yet defined> 
ses_file_path: <the absolute path to the last .ses file imported , or "" if not yet defined> 
dsn_bounds_poly: <the board outline index used for the bounds for the .dsn file> 
dsn_signals_poly: <the board outline index used for the bounds for signals the .dsn file> 
autosave_interval: <the interval between autosaves in msec, or "0" if autosave disabled> 
netlist_import_flags: <the flags set in the last "import netlist" dialog> 
units: <the currently-selected units for the project, either "MM" or "MIL"> 
visible_grid_spacing: <the currently-selected visible grid spacing, in nanometers> 
       visible_grid_item: <the first item in the menu of visible grids> 
       visible_grid_item: <the next item in the menu of visible grids> 
         ... 
       visible_grid_item: <the last item in the menu of visible grids> 
placement_grid_spacing: <the currently-selected placement grid spacing, in nanometers> 
       placement_grid_item: <the first item in the menu of placement grids> 
       placement_grid_item: <the next item in the menu of placement grids> 
        ... 
       placement_grid_item: <the last item in the menu of placement grids> 
routing_grid_spacing: <the currently-selected routing grid spacing, in nanometers> 
       routing_grid_item: <the first item in the menu of routing grids> 
       routing_grid_item: <the next item in the menu of routing grids> 
        ... 
       routing_grid_item: <the last item in the menu of routing grids>  

snap_angle: <the currently-selected snap angle in degrees> 
fp_visible_grid_spacing: <the currently-selected visible grid spacing for the Footprint Editor, in 
nanometers> 
fp_visible_grid_item: <the first item in the menu of visible grids for the Footprint Editor> 
fp_visible_grid_item: <the next item in the menu of visible grids for the Footprint Editor> 
... 
fp_visible_grid_item: <the last item in the menu of visible grids for the Footprint Editor> 
fp_placement_grid_spacing: <the currently-selected placement grid spacing for the Footprint Editor, in 
nanometers> 
fp_placement_grid_item: <the first item in the menu of placement grids for the Footprint Editor> 
fp_placement_grid_item: <the next item in the menu of placement grids for the Footprint Editor> 
... 
fp_placement_grid_item: <the last item in the menu of placement grids for the Footprint Editor> 
fp_snap_angle: <the currently-selected snap angle for the Footprint Editor, in degrees> 
fill_clearance: <for Gerber files, the copper-copper clearance for copper areas> 
mask_clearance: <for Gerber files, the solder-mask clearance> 
thermal_width: <for Gerber files, the width of the cross-hairs for thermal reliefs> 
min_silkscreen_width: <for Gerber files, the minimum width of silk-screen lines> 
board_outline_width: <for Gerber files, the width of board-outline lines> 
hole_clearance: <for Gerber files, clearance from holes to copper areas> 
pilot_diameter: <for Gerber files, the pilot hole diameter> 
annular_ring_for_pins: <for Gerber files, the width of annular rings for through-hole pins> 
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annular_ring_for_vias: <for Gerber files, the width of annular rings for vias> 
shrink_paste_mask: <for paste mask Gerber files, pad size reduction> 
cam_flags: <bitwise ORed flags for CAM options> 
cam_layers: <bitwise ORed flags for CAM files to generate> 
cam_drill_file: <flag to make a drill file> 
cam_units: <units to use for CAM parameters in dialog> 
cam_n_x: <for panelizing, number of boards horizontally> 
cam_n_y: <for panelizing, number of boards vertically> 
cam_space_x: <for panelizing, horizontal spacing of boards> 
cam_space_y: <for panelizing, vertical spacing of boards> drc_check_unrouted: 
<flag to treat unrouted connections as DRC errors> drc_trace_width: <minimum 
trace width for DRC> 
drc_pad_pad: <minimum pad-pad clearance for DRC> 
drc_pad_trace: <minimum pad-trace clearance for DRC> 
drc_trace_trace: <minimum trace-trace clearance for DRC> 
drc_hole_copper: <minimum hole-copper clearance for DRC> 
drc_annular_ring_pins: <minimum annular ring width for pins for DRC> 
drc_annular_ring_vias: <minimum annular ring width for vias for DRC> 
drc_board_edge_copper: <minimum copper-board_edge clearance for DRC> 
drc_board_edge_hole: <minimum hole-board_edge clearance for DRC> 
drc_hole_hole: <minimum hole-hole clearance for DRC> 
drc_copper_copper: <minimum copper_area-copper_area clearance for DRC> 
default_trace_width: <default trace width for project> default_via_pad_width: 
<default via pad width for project>  

default_via_hole_width: <default via hole diameter for project> 
n_width_menu: <number of trace width menu items> 
width_menu_item: <index of first item> <trace width> <via pad width> <via hole diameter> width_menu_item: 
<index of this item> <trace width> <via pad width> <via hole diameter> 
... 
width_menu_item: <index of last item> <trace width> <via pad width> <via hole diameter> n_copper_layers: 
<number of copper layers in project> 
layer_info: <name of first layer> <index into layer array> <color: red> <color: green> <color: blue> <flag 
if visible> 
layer_info: <name of next layer> <index into layer array> <color: red> <color: green> <color: blue> <flag 
if visible> 
... 
layer_info: <name of last layer> <index into layer array> <color: red> <color: green> <color: blue> <flag 
if visible> 
[footprints] 
name: <name of footprint> 
{author: <name of author>} 
{source: <description of source>} 
{description: <description of footprint>} 
units: <units: "NM", "MM" or "MIL"> 
sel_rect: <for selection rectangle: left> <bottom> <right> <top> 
ref_text: <for reference text: height> <left> <bottom> <angle> <line width> 
{text: <text string> <height> <x> <y> <angle> <line width> <flag if mirrored> <layer>} 
... 
{outline_polyline: <line width> <starting x> <starting y> 
next_corner: <next x> <next y> <side style> 
next_corner: <next x> <next y> <side style> 
... 
close_polyline: <if closed polyline, last side style>} 
... 
n_pins: <number of pins> 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
... 
pin: <pin name> <hole_diameter> <x> <y> <angle> 
top_pad: <shape> <width> <length/2> <length/2> <corner radius> 
inner_pad: <shape> <width> <length/2> <length/2> <corner radius> 
bottom_pad: <shape> <width> <length/2> <length/2> <corner radius> 
[board] 
outline: <number of corners in board outline> <outline index> 
corner: <index> <x> <y> <style of next side> 
corner: <index> <x> <y> <style of next side> 
... 
corner: <index> <x> <y> <style of next side> 
... 
[solder_mask_cutouts] 
sm_cutout: <number of corners in solder mask cutout> <fill style> <layer> 
corner: <index> <x> <y> <style of next side> 
corner: <index> <x> <y> <style of next side> 
... 
corner: <index> <x> <y> <style of next side> 
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...  

 [parts] 
part: <reference designator> 
ref_text: <height> <line width> <angle> <x> <y> 
package: <package identifier from netlist file, or ""> 
shape: <footprint name> 
pos: <position: x> <y> <side> <angle> <flag if glued> 
[nets] 
net: <name of net> <# pins> <# connections> <# areas> <default trace width> <default via pad width> 
<default via hole dia> <visibility> 
pin: <index of first pin in net> <name, such "U1.5"> 
pin: <index of next pin in net> <name, such "U1.5"> 
... 
pin: <index of last pin in net> <name, such "U1.5"> 
connect: <index of this connection> <index of start pin> <index of end pin> <# segments> <flag if locked> 
vtx: <first trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad width> 
<via hole dia> <tee id> 
seg: <first trace segment: index> <layer> <width> <via width> <via hole diameter> 
vtx: <next trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad width> 
<via hole dia> <tee id> 
seg: <next trace segment: index> <layer> <width> <via width> <via hole diameter> 
... 
seg: <last trace segment: index> <layer> <width> <via width> <via hole diameter> 
vtx: <last trace vertex: index> <x> <y> <first/last vertex, pad layer> <force via flag> <via pad width> 
<via hole dia> <tee id> 
area: <index of this copper area> <# corners> <layer> <hatch style> 
corner: <index of first corner> <x> <y> <style of next side> <flag if last corner of this contour> 
corner: <index of next corner> <x> <y> <style of next side> <flag if last corner of this contour> 
... 
corner: <index of last corner> <x> <y> <style of next side> <flag if last corner of this contour> 
[texts] 
text: <text string> <x> <y> <layer> <angle> <mirror flag> <height> <line width> 

8.2 Файлы библиотек 

Библиотечный файл (*.fpl) являются текстовым файлом ASCII, содержащим один или более футпринтов. Формат для
этого файла точно такой же, как секция [footprints] проектного файла, описанного выше. 

8.3 Файлы конфигурации 

Файл конфигурации (default.cfg) является текстовым файлом ASCII, содержащии заданные по умолчанию параметры, 
которые используются для новых проектов. Этот файл расположен в той же самой папке, где расположен
исполняемый файл программы "freepcb.exe". Файл использует такой же формат, как секция [options] проектного
файла, описаного выше, с двумя дополнительными элементами: 

parent_folder: <the absolute or relative path to the default parent folder for new projects> 
library_folder: <the absolute or relative path to the default library folder for new projects> 
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Библиотеки футпринтов программы FreePCB 

Валентин Володин
valvolodin@narod.ru 

1 Элементы библиотечного футпринта 

В программе FreePCB корпус реального компонента представлен в виде двухмерного отпечатка — футпринта
(Footprint). 
Футпринты, используемые программой FreePCB для проектирования печатных плат, состоят из 4-х основных
элементов. Перечислим эти элементы: 

• Pins – Это выводы компонентов. Выводы реализованы в виде стека контактных площадок (padstacks). Стек
контактных площадок содержит медные площадки в верхнем (сторона компонентов) медном слое для всех
компонентов, а также отверстие и площадки на внутренних и нижнем слое, если компонент имеет штыревые
выводы. 

• Polylines — Это различные линии и дуги в слое шелкографии (silk). Они могут быть замкнутыми или
разомкнутыми.  

• Reference designator - Это текстовая строка позиционного обозначения. Поскольку позиционное обозначение
присваивается компоненту (Part) на печатной плате, а не футпринту, то редактор футпринтов (Footprint Editor) 
использует строку "REF", как указатель места заполнения. Эта строка всегда присутствует, её невозможно
удалить, но можно изменить размер. 

• Selection box - Это прямоугольник, который используемые для выбора футпринта во время размещения на
печатной плате. Генерируется автоматически во время сохранения футпринта.  

Футпринты сохранены в библиотечных файлах (library files), которые имеют расширение .fpl. Каждый файл содержит
множество футпринтов, обычно имеющих аналогичный тип упаковки. Под упаковкой понимается взаимное
расположение и нумерация выводов реального корпуса компонента.  
Программа FreePCB уже имеет в своём составе ряд библиотечных файлов, большинство из которых были получены
путём преобразования библиотек футпринтов коммерческого программного продукта ECAD обанкротившейся
компании Ivex Design International Inc. Эти файлы организованы в три группы: 

• Основные библиотеки (Core libraries) — Это наиболее часто используемые библиотеки. В случае стандартной
установки они обычно расположены в папке C:\Program Files\FreePCB\lib.  

• Дополнительные библиотеки (Extra libraries) — Это библиотеки с менее востребованными  футпринтами. В
случае стандартной установки они обычно расположены в папке  C:\Program Files\FreePCB\lib_extra.  

• Внесенные библиотеки (Contributed libraries) – Это библиотеки, созданные пользователями программы
FreePCB. В случае стандартной установки они обычно расположены в папке  C:\Program 
Files\FreePCB\lib_contrib. 

Начиная очередной проект в FreePCB, Вы можете выбрать библиотечную папку Library Folder, которая будет
использоваться в проекте. По умолчанию, этой папкой будет папка основной библиотеки (рис.1). Если Вы хотите
иметь под рукой какие-то дополнительные или даже все библиотеки, то для этого достаточно скопировать их в
выбранную папку проекта. 

Рис.1 Выбор библиотечной папки в окне проекта Project 
Options. 

Для облегчения работы, все поставляемые с FreePCB библиотеки документированы в виде PDF файлов, имеющих
названия, совпадающие с названиями библиотечных файлов. Эти файлы могут быть распечатаны в виде небольшой
книжки, которая сильно облегчит работу с обширными библиотеками футпринтов. Разумеется, информацию о
футпринтах можно посмотреть используя стандартный диалог Add > Par, но файлы PDF содержат более подробную
информацию, такую как размеры площадок и отверстий.  
По мере наработки собственных библиотек Вы сами можете их документировать, воспользовавшись пунктом меню
Tools > Make PDF from Library File... в редакторе футпринтов (рис.2). 
Далее в таблицах 1, 2 и 3 перечислены библиотечные файлы, которые в настоящее время поставляются с программой
FreePCB. Обратите внимание, что имена файлов библиотек, содержащих футпринты корпусов с штыревыми
выводами, начинаются с "th _", а имена файлов содержащих футпринты SMD корпусов с "sm _". 
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Рис.2 Окно PDF документа, описывающего
библиотеку футпринтов. 

  

Таблица 1. Основные библиотеки (Core libraries) 

Имя файла (.fpl) Источник Тип Описание 

th_transistor Ivex, JEDEC through-hole JEDEC TO-серия транзисторов и ИС 

th_diode Ivex, JEDEC through-hole JEDEC DO-серия диодов 

th_capacitor Ivex through-hole Конденсаторы, полярные и неполярные 

th_resistor Ivex through-hole Резисторы, включая потенциометры 

th_connector Ivex through-hole Соединители 

th_header Ivex through-hole Разъёмы 

th_sip Ivex through-hole SIP корпуса (межвыводное расстояние 100 мил) 

th_dip Ivex through-hole DIP корпуса (межвыводное расстояние 100 мил) 

sm_resistor Ivex, IPC surface-mount SMD резисторы 

sm_capacitor Ivex, IPC surface-mount SMD и танталовые конденсаторы 

sm_soic Ivex, IPC surface-mount SOIC корпуса 

sm_sop Ivex, IPC surface-mount SOP и TSOP корпуса 

sm_soj Ivex, IPC surface-mount SOJ корпуса 

sm_lcc Ivex, IPC surface-mount LCC корпуса 

sm_plcc Ivex, IPC surface-mount PLCC корпуса 

sm_sot Ivex, Siemens surface-mount SOT корпуса 

Led Ivex mixed Светодиоды 

test_point Ivex mixed Тестовые точки 

 

Таблица 2. Дополнительные библиотеки (Extra libraries) 

Имя файла (.fpl) Источник Тип Описание 

sm_qfp Ivex, IPC surface-mount PQFP, SQFP и QFP корпуса (этот файл не находится в
папке основной библиотеки, потому что слишком
большой) 

Device Ivex mixed Различные устройства 

sm_tantalum_cap Ivex surface_mount Танталовые конденсаторы от AVX 

elfa_cap Ivex mixed Конденсаторы из каталога ELFA 

elfa_chk Ivex mixed Различные устройства из каталога ELFA 

elfa_pot Ivex mixed Потенциометры из каталога ELFA 
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elfa_res Ivex mixed Резисторы из каталога ELFA 

Flatpack Ivex, JEDEC mixed QUAD корпуса 

sm_ipc782 surface-mount Различные устройства от IPC отсутствующие в других
библиотеках 

siemens2  mixed Siemens корпуса LCC 

siemens3  mixed Siemens корпуса SO 

siemens4  mixed Siemens корпуса QFP 

transformer  mixed Трансформаторы 

tx_inst mixed Различные корпуса Burr-Brown и Texas Instruments  

 

Таблица 3. Внесенные библиотеки (Contributed libraries) 

Имя файла (.fpl) Источник Тип Описание 

Flintstone Аноним смешанный Различные реле, трансформаторы и соединители 

 

2 Мастер типовых футпринтов (Footprint Wizard) 

2.1 Запуск мастера типовых футпринтов 

Время от времени Вы будете сталкиваться с ситуацией, когда нужно будет создать какой-то новый футпринт, 
отсутствующий в стандартной библиотеке FreePCB. Процесс создания стандартных футпринтов может значительно
облегчится, если воспользоваться мастером типовых футпринтов (Footprint Wizard).  
В виду того, что полное название нашего мастера получилось слишком длинным, то условимся, что далее мы будем
использовать его более короткие варианты, такие как мастер футпринтов или просто мастер. Так как в программе
FreePCB пока другие аналогичные инструменты отсутствуют, то всегда будет понятно, о чём идёт речь.  
Мастер является инструментом генерации футпринтов для различных корпусов в стандартной упаковке. Он
вызывается с помощью пункта меню Tools > Footprint Wizard.  
К сожалению, после запуска программы FreePCB  меню Tolls не активно (окрашено серым). Чтобы его
активизировать, необходимо открыть какой-то проект. Если проектов пока отсутствуют, то самое время создать
первый. Для этого, с помощью пункта меню File > News (аналогичный результат будет получен, если нажать
комбинацию клавиш Ctrl+N или кликнуть по иконке  на панели инструментов) открываем окно настройки нового
проекта Project Options (рис.3).  

Рис.3 Окно настройки нового проекта (Project Options) 

Если Вы только знакомитесь с программой FreePCB и просто хотите добраться до мастера (Footprint Wizard), то
введите какое имя проекта в поле Name. Так как проект первый, то введём что-то типа My first project (или любую
другую комбинацию цифр и букв латинского алфавита, на ваше усмотрение). Далее нажимаем ОК. После этого
программа обнаружит, что папка проекта пока отсутствует и предложить её создать (рис.4). Разрешаем создание
папки, нажав кнопку “Да”, и сразу же оказываемся в окне нового проекта, которому, по умолчанию, присвоено имя
My first project.fpc (или то что вы выбрали сами, плюс расширение .fpc).  Посмотрев на панель меню, с
удовлетворением замечаем, что меню Tools стало активным.   
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Рис.4 Диалог создания папки нового проекта My first project 

2.2 Рабочее окно мастера футпринтов 

После активизации пункта Footprint Wizard  меню Tools возникает рабочее окно мастера (Footprint Wizard) (рис.5): 

Рис.5 Рабочее окно мастера (Footprint Wizard) 

Благодаря мастеру, весь процесс создания контактных площадок и контура нового футпринта сводится к заполнению
различных информационных полей рабочего окна Footprint Wizard. Рассмотрим подробнее назначение этих
информационных полей: 

• Name – в этом поле следует указать название упаковки, для которого создаётся футпринт.  
• Type – в этом поле указывается один из стандартных типов упаковки:   

o SIP — упаковка содержит один ряд выводов.  
o DIP – упаковка содержит два ряда выводов, пронумерованных способом характерным для  

интегральных микросхем в DIP корпусе (по кругу против часовой стрелки). 
o QUAD – упаковка содержит четыре ряда выводов, упорядоченных в виде прямоугольника и 

пронумерованных способом характерным для интегральных микросхем в PLCC или QFP корпусе (по
кругу против часовой стрелки). 

o HEADER – упаковка содержит два ряда выводов, пронумерованных способом характерным для
некоторых разъёмов (последовательно столбцом). 

o HEADER2 - то же самое, что и HEADER, но выводы пронумерованы последовательно строкой. 
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o PGA/BGA – упаковка содержит выводы, упорядочены в виде прямоугольника и пронумерованы
способом характерным для прямоугольного массива (строки обозначаются буквами латинского
алфавита, а колонки цифрами). 

o EDGE – упаковка содержит контактные площадки на верхней и нижней стороне платы, 
пронумерованные способом характерным для некоторых разъёмов (последовательно строкой). Такой
футпринт обычно используется для формирования непосредственно на плате различных разъёмных
соединений. 

o EDGE2 – то же самое, что и EDGE, но выводы пронумерованы по кругу по часовой стрелке. 
• Units – в этом поле выбираются единицы измерения. Можно выбрать “mils” (1 mil = 1/1000 дюйма = 0.0254 

мм) для дюймовой системы измерения или “мм” для метрической. 
• Number of pins – количество выводов:  

o Total - общее количество выводов упакованных в футпринт. Это значение вводится первым.  
o Per horizontal row – количество выводов горизонтального ряда (необходимо указывать только для 

упаковок типа QUAD, HEADER и PGA/BGA). Это значение вводится вторым после Total.  
o Per vertical row – количество выводов вертикального ряда (только для упаковок QUAD, HEADER и 

PGA/BGA). Это значение заполняется автоматически и получается делением   общего количества
выводов (Total) на количество выводов горизонтального ряда (Per horizontal row) .  

o Pin 1 position – позиция первого вывода (активно только для упаковки QUAD). Возможны три опции:  
� top row, center pin, согласно которой первым является средний вывод верхнего ряда; 
� bottom row, left-most pin, согласно которой первым является крайний левый вывод нижнего

ряда; 
� top row, left-most pin, согласно которой первым является крайний левый вывод верхнего ряда. 

• Pads – контактные площадки: 
o Shape — Форма контактных площадок. Возможны четыре опции:  

� Rectangular - прямоугольные площадки; 
� Pin 1 square, others round - квадратная площадка для первого вывода, а остальные площадки

круглые;  
� Round - круглые площадки; 
� Square — квадратные площадки;  
� None — Нет контактной площадки. Эта опция используется для создания отверстия без

площадки (например, для монтажного отверстия). 
o Hole diameter - диаметр отверстия в площадке для штыревых компонентов. Для SMD компонентов

можно ввести “0” или оставить пробел.  
o Width (X) - ширина площадки (размер "X" на схеме расположения площадок). 
o Length (Y) - длина площадки (размер "Y" на схеме расположения площадок).  
o Spacing (E) - интервал между центрами площадок в пределах ряда (размер "E" на схеме расположения 

площадок). 
• Distance between top and bottom rows – Расстояние между верхним и нижним рядами площадок. Возможно три 

варианта указания этого расстояния:  
o Inner-inner (G1) – указывается расстояние между внутренними краями площадок (размер "G1" на 

схеме расположения площадок).  
o Center-center (C1) – указывается расстояние между центрами площадок (размер "C1" на схеме 

расположения площадок).  
o Outer-outer (Z1) – указывается расстояние между внешними краями площадок (размер "Z1" на схеме 

расположения площадок). 
• Distance between left and right rows – Расстояние между левым и правым рядами площадок. Возможно три 

варианта указания этого расстояния:  
o Inner-inner (G2) - указывается расстояние между внутренними краями площадок (размер "G2" на 

схеме расположения площадок).  
o Center-center (C2) - указывается расстояние между центрами площадок (размер "C2" на схеме 

расположения площадок). 
o Outer-outer (Z2) - указывается расстояние между внешними краями площадок (размер "Z2" на схеме 

расположения площадок). 
• Save – Сохранить. После нажатия этой кнопки мастер проверяет заполнение всех полей и если какое-то поле 

не заполнено, то появляется небольшое окошко с указанием ошибки и кнопкой ОК (рис.6).  

Рис.6 Окно сообщения об ошибке. 
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Если все поля правильно заполнены, то вызывается окно Save Footprint to Library (Рис. 7), позволяющее
сохранить созданный футпринт в библиотеку. 

Рис.7 Окно Save Footprint to Library, позволяющее сохранить созданный футпринт в библиотеку.  

В области Footprint окна Save Footprint to Library уже указано имя футпринта (Name) и при необходимости
можно указать автора (Author), информационный источник (Source) и различные примечания (Description). В
области Library окна Save Footprint to Library необходимо указать полный путь к директории библиотеки
(Folder), а так же имя самой библиотеки (File). Вновь созданные или изменённые футпринты лучше хранить в
пользовательской библиотеке user_created.fpl. 

• Exit – Выход. С помощью этой кнопки можно прервать процесс создания футпринта. 
• Preview — Предварительный просмотр. Кликнув по этой кнопке, можно оперативно посмотреть на созданный 

футпринт. 

2.3 Выбор системы измерения 

При создании футпринта любого компонента мы имеем возможность выбора системы измерения. Поэтому сразу
встаёт вопрос, какую же систему измерения выбрать, английскую или метрическую? Казалось бы, на дворе XXI век и
в мире давно господствует система СИ, с её метром в качестве меры длины. Но, как ни странно, где-то там внутри
промышленных гигантов, производящих электронные комплектующие, прочно укоренилась английская система
измерения, продолжая плодить компоненты, размеры которых выражаются в единицах кратных дюйму. В частности
такой единицей является 1/1000 дюйма (inch), которая называется мил (mil). 1 мил=0.0254 мм. Параллельно с этими
комплектующими на рынке электроники присутствуют компоненты, размеры которых кратны мм (напомним, что 1 
мм=0.001м). В соответствии с различными системами измерения использовались различные упаковочные стандарты. 
Например, если дюймовые DIP компоненты имеют расстояние между соседними ножками одного ряда 100 мил = 
2.54мм, то в метрических это расстояние округлено до 2.5мм. При этом, при изменении системы измерения, смещение
крайних ножек больших корпусов типа DIP40 достигает 0.76мм, что приводит к заметному выгибанию ножек.     
Первое, что приходит на ум в этом случае, это использование той системы измерения, к которой привязаны размеры
корпуса  компонента. Но в этом случае придётся делать две параллельные библиотеки, одну для дюймовых
футпринтов, а другую для метрических. Помимо дополнительной работы это вызовет проблему совместного
использования дюймовых и метрических футпринтов в одном проекте. Для их совместимости на уровне размещения
(Placement) и трассировки (Routing) придётся использовать самые мелкие сетки, что отрицательно скажется на
качестве и производительности проектирования.  
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Более разумным вариантом будет использование одной системы измерения. Так как мы уже располагаем библиотекой
футпринтов, выполненной в английской системе измерения, то имеет смысл именно на ней и остановить свой выбор. 
В этом случае размеры метрических футпринтов, по возможности делаются кратными дюймовым, а в случае крайней
необходимости просто с максимальной точностью конвертируют в милы. Приняв этот вариант, нам не придётся в
полном объёме воссоздавать метрическую библиотеку футпринтов, а также можно будет использовать достаточно
крупные сетки размещения и трассировки. 

2.4 Создание футпринта для DIP корпуса 

Воспользуемся мастером (Footprint Wizard) для создания футпринта 8-ми выводного DIP корпуса. Именно в такой
корпус упакован ШИМ контроллера LT1285, используемый в нашем преобразователе 12/19В.  
Активизируя пункт Footprint Wizard меню Tools, вызовем рабочее окно мастера (рис.5). Как говорилось ранее, весь
процесс создания футпринта сводится к корректному заполнению соответствующих информационных полей. Вариант
заполнения этих полей для требуемого футпринта изображён на рис.8. 

Рис.8 Создание 8-ми выводного DIP  футпринта при помощи мастера футпринтов.  

В поле Name указано имя футпринта – LT1285. В поле Type выбрана стандартная упаковка DIP. В поле Units выбрана
единица измерения – mils (как говорилось ранее, 1 мил (mil) в 1000 раз меньше дюйма).  
Далее, в области Numbers of pin, сгруппированы информационные поля, определяющие общее количество выводов, их
структуру и положение первого вывода. Общее количество выводов, равное 8, указано в поле Total. После ввода
общего количества выводов футпринта, мастер соображает, что количества выводов одного ряда будет в два раза
меньше и автоматически вносит это значение в неактивное поле Per horizontal row. Так как DIP корпус имеет только
два горизонтальных ряда выводов, то в неактивное поле Per vertical row, указывающее количество выводов
вертикального ряда, записывается 0. В следующем неактивном поле Pin 1 position по умолчанию выбрано, что первым
будет крайний левый вывод нижнего ряда выводов (bottom row, left-most pin).  
Разобравшись с выводами, перемещаемся к области Pads, в которой описывается форма и размеры контактных
площадок. Чтобы избежать ошибки при монтаже DIP футпринта на плату, желательно чтобы площадка первого
вывода отличалась формой от остальных площадок. Поэтому в поле Shape выбираем вариант Pin 1 square, others round, 
означающий, что контактная площадка первого вывода будет квадратной, а остальные площадки будут иметь круглую
форму. В поле Hole Diameter установлен диаметр отверстия в контактной площадке равный 30 мил (≈ 0.8 мм).  В поле
Width (X) установлена ширина контактной площадке равная 60 мил (≈ 1.6 мм). Так как площадки имеют круглую или
квадратную форму, то в поле Length (Y) автоматически внесено значение высоты контактной площадки равное её 
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ширине. В поле Spacing (E) указано стандартное для DIP расстояние между выводами одного ряда, равное 100 мил. 
Поле Corner radius (Rounded Rect) не активно для любых типов упаковок и, видимо, зарезервировано на перспективу.   
Далее перейдём к области Distance between top and bottom rows, где надо будет указать рсстояние между верхним и
нижним рядами выводов. В данном случае мастер лишает нас выбора и предлагает ввести расстояние между центрами
отверстий (Center-center). Для DIP это расстояние равно 300 мил. После ввода требуемого значения, мастер
автоматически заполняет неактивные поля, указывающие расстояние между внутренними (Inner-inner) и внешними
(Outer-outer) краями площадок.  
Теперь, чтобы отобразить полученный футпринт в окне Preview, достаточно кликнуть по одноименной кнопке (рис.8). 
Если внешний осмотр нас удовлетворил, то можем сохранить новый футпринт в библиотеку футпринтов, нажав
кнопку Save. 

 

2.5 Создание не типового футпринта 

Не смотря на то, что мастер рассчитан для создания типовых футпринтов, его с успехом можно использовать и для
создания заготовок для не типовых футпринтов. Например, воспользовавшись мастером, создадим заготовку  а
двухвыводного терминала DG301-5.0, выпускаемого фирмой DEGSON. Такие терминалы нам потребуются в
преобразователе 12/19В, для подключения первичного источника питания и нагрузки.  
Как видно из справочных данных от производителя (рис.9), конструктивные размеры терминала кратны мм. Обычно, 
в этом случае, наиболее критичным размером, который может вызвать проблемы монтажа, является расстояние между
выводами терминала. Это расстояние  равняется 5 мм, что на 0.08 мм меньше ровного значения в 200 мил=5.08 мм. 
Т.е. каждый вывод терминала будет смещён на 0.04 мм относительно центра отверстий, просверленных с шагом 200 
мил=5.08 мм. Так как смещение весьма незначительное и будет скомпенсировано разницей между диметром
отверстия и диаметром вывода, то будем считать, что расстояние между выводами терминала равно 200 мил. 

Рис.9 Размеры двухвыводного терминала DG301-5.0.  

Чтобы вызвать рабочее окно мастера футпринтов (рис.5), активизируем пункт Footprint Wizard меню Tools. На рис. 10 
показан вид рабочего окна с уже заполненными информационными полями.  
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Рис.10 Создание двухвыводного терминала.  

В поле Name указано имя футпринта – TERMINAL2. В поле Type выбрана стандартная упаковка SIP, которая больше
всего подходит для создания футпринтов, имеющих один ряд выводов. В поле Units выбрана единица измерения – 
mils.  
Далее, в области Numbers of pin, сгруппированы информационные поля, определяющие общее количество выводов, их
структуру и положение первого вывода. Общее количество выводов, равное 2, указано в поле Total. После ввода
общего количества выводов, мастер автоматически вносит это значение в неактивное поле Per horizontal row, 
определяющее количество выводов горизонтального ряда. Так как SIP корпус имеет только один горизонтальный ряд
выводов, то в неактивное поле Per vertical row, указывающее количество выводов вертикального ряда, записывается 0. 
В следующем неактивном поле Pin 1 position по умолчанию выбрано, что первым будет крайний левый вывод
нижнего ряда выводов (bottom row, left-most pin).   
Разобравшись с выводами, перемещаемся к области Pads, в которой описывается форма и размеры контактных
площадок. В поле Shape выбрана круглая форма контактной площадки ( Round). В поле Hole Diameter установлен
диаметр отверстия в контактной площадке равный 50 мил (≈ 1.3 мм).  В поле Width (X) установлена ширина
контактной площадке равная 100 мил (≈ 2.6 мм). Так как площадка круглая, то в поле Length (Y) автоматически
внесено значение высоты контактной площадки аналогичное её ширине. В поле  Spacing (E) установлено расстояние
между выводами, равное 200 мил (≈5 мм).  
Теперь, когда все активные поля заполнены, достаточно нажать кнопку Preview, чтобы отобразить футпринт в окне с
аналогичным названием (рис.10). Футпринт пока выглядит как две контактные площадки, находящиеся внутри
жёлтого и белого прямоугольников. Эти прямоугольники автоматически генерируется мастером. Жёлтый
прямоугольник наносится в слое шелкографии (top silk) и символизирует собой контур футпринта. Белый
прямоугольник наносится в слое Selection и служит для индикации выбранного футпринта. Более подробно структура
слоёв футпринта будет рассмотрена далее, при описании редактора  Footprint Editor.  
На этом работа мастера заканчивается и нам лишь остаётся сохранить футпринт, воспользовавшись кнопкой Save 
(рис.7) . Если нас на данном этапе что-то не устраивает, то все дальнейшие доработки футпринта мы сможем сделать в
редакторе. 
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3 Редактор футпринтов (Footprint Editor) 

3.1 Запуск редактора футпринтов 

Мастер футпринтов является эффективным инструментом создания футпринтов по заранее созданному шаблону. К
сожалению, большая часть компонентов не вписывается в заранее созданные шаблоны мастера. В этом случае
требуется более гибкий, хоть и более сложный инструмент. Именно таким инструментом для создания различных, в
том числе и типовых, футпринтов является редактор футпринтов (Footprint Editor).  
В виду того, что полное название редактора также получается длинноватым, условимся, что далее мы будем называть
его просто редактором. 
Редактор футпринтов можно вызвать двумя способами. В первом случае он вызывается аналогично мастеру
футпринтов из окна активного проекта, через активизацию пункта Footprint Editor меню Tools. Во втором случае он
вызывается активизацией пункта Open Footprint Editor меню File и при этом не требуется, чтобы какой-то проект был
активным.  Кроме перечисленных случаев, редактор можно вызвать в окне активного проекта для редактирования
конкретного футпринта. Для этого, достаточно левым кликом мышки выбрать футпринт и затем нажать
функциональную клавишу F2 (Edit Footprint). Или выбрать футпринт и правым кликом мышки вызвать меню (рис.11) 
в котором выбрать пункт Edit Footprint. 

Рис.11 Запуск редактора (Footprint Editor)  

3.2 Окно редактора (Footprint Editor) 

Редактор запускается в окне программы FreePCB (рис.12) и если до этого там отображался активный проект, то
редактор просто заменяет его. Для возврата к проекту можно просто закрыть окно обычным для Windows способом, 
кликнув крестик в верхнем правом углу окна, или активизировав пункт меню Return to PCB layout в меню File либо
Tools.  

Рис.12 Основные элементы рабочего окна редактора (Footprint Editor)  

Основные элементы рабочего окна редактора:  
1. Заголовок окна. 
2. Строка меню. 
3. Панель задач.  
4. Список слоёв.  

5. Строка состояния.  
6. Меню функциональных, которое показывает
доступные команды функциональной клавиши.  
7. Рабочая область.
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Рассмотрим по очереди эти элементы рабочего окна редактора  

3.2.1 Заголовок окна 
В заголовке окна, в зависимости от режима работы, отображается название активного проекта или редактируемого
футпринта, если запущен редактор (Footprint Editor) .   

3.2.2 Строка меню 
Строка меню содержит следующие меню: 

• File – 
o New footprint — Начать редактирование нового футпринта; 
o Import Footprint - Импортировать футпринт из библиотечного файла;  
o Save Footprint As - Сохранить футпринт в библиотечном файле; 
o Print… (Ctrl+P) - Печать (не реализовано);  
o Print Preview – Печать видимой области (не реализовано); 
o Print Setup – Настройка печати (не реализовано); 
o Return to PCB layout - Закрыть редактор и вернуться в основное окно программы FreePCB.  

• Edit –  
o Undo — отмена последней операции редактирования; 
o Cut (Ctrl+X) – Вырезать (не реализовано); 
o Copy (Ctrl+C) – Копировать (не реализовано); 
o Paste (Ctrl+V) – Вставить (не реализовано). 

• View –  
o Entire footprint - Изменяет размеры и повторно выравнивает по центру окно, чтобы отобразить все 

элементы футпринта. 
• Add –  

o Pin - Добавить новый вывод или ряд выводов;  
o Polyline - Добавить новую ломаную линию в слой шелкографии;  
o Text – Добавить текстовую строку. 

• Tools – 
o Footprint Wizard - Вызвать мастер футпринтов; 
o Make PDF from Library File – Создать файл формата PDF, описывающий футпринты в библиотечном 

файле;  
o Return to PCB Layout - Закрыть редактор и вернуться в основное окно программы FreePCB.  

• Help – 
o About FreePCB – Отображает информационное окно с номером версии программы FreePCB. 

3.2.3 Панель задач  
В левой части панели задач (рис.12) расположены 8 иконок, которые являются ярлыками для следующих пунктов
меню: 

•  (New footprint) — Начать редактирование нового корпуса; 
•  (Import Footprint) - Импортировать корпус из библиотечного файла; 
•  (Save Footprint As) - Сохранить корпус в библиотечном файле; 
•  (Cut) – Вырезать (не реализовано); 
•  (Copy) – Копировать (не реализовано); 
•  (Paste) – Вставить (не реализовано); 
•  (Print) - Печать (не реализовано); 
•  (About FreePCB) – Отображает информационное окно с номером версии программы FreePCB. 

В правой части панели задач расположены пять раскрывающихся меню, предназначенных для установки единиц
измерения и шага сеток, используемых в редакторе. Это: 

• Units – выбрать mils или mm для указания размеров; 
• Grids :Visible – установить шаг сетки в окне редактора. Возможные значения: 

o 100, 125, 200, 250, 400, 500, 1000 мил; 
o 1, 2, 2.5, 4, 5, 10, 20, 25, 40, 50, 100 мм. 

• Placement – установить шаг сетки для размещения контактных площадок, текста, а так же рисования
ломанных линий (polyline). Возможные значения: 
o 10, 20, 25, 40, 50, 100, 200, 250, 400, 500, 1000 мил; 
o 0.1, 0.2, 0.25, 0.4, 0.5, 1, 2, 2.5, 4, 5, 10 мм. 

• Routing – не используется; 
• Angle – установить угол излома (в градусах) для рисования ломанных линий. Возможные значения: 

o 45 – угол излома 45 градусов; 
o 90 – угол излома 90 градусов; 
o Off – произвольный угол излома. 
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3.2.4 Список слоёв  

Список слоёв (рис.13) расположен слева от рабочей области редактора. В этом списке, каждый слой обозначен
квадратиком, цвет которого соответствует цвету слоя. Каждый слой отвечает за отображение определённой
информации. К сожалению, на цвет и видимость верхних шести слоёв мы не можем влиять. Перечислим эти слои: 

• Selection – слой, которым подсвечивает рамку вокруг выбранного элемента; 
• Background – слой рабочей области редактора; 
• Visible grid – слой координатной сети; 
• Highlight – не используется; 
• Top silk – слой шелкографии; 
• Drilled hole – слой. отображающий отверстия в контактных площадках. 

Нижние три слоя используются для отображения контактной площадки и только один из этих слоёв может быть
активным. Перечислим эти слои: 

• Top copper – слой контактных площадок на верхней стороне платы (со стороны компонентов); 
• Inner – слой контактных площадок на внутренних слоях платы; 
• Bottom – слой контактных площадок на нижней стороне платы. 

Активный слой отмечен треугольным указателем, расположенным левее от соответствующего квадратикай. Для
изменения активного слоя нужно нажать одну из цифровых клавиш, от 1 до 3. Активный слой всегда отображается
поверх других слоёв в рабочем окне редактора.     

3.2.5 Строка состояния 
Строка состояния находится в нижней части окна редактора (рис.12). Она содержит следующие элементы, 
перечисленные слева на право: 

• Надпись Ready, которая преобразуется в подсказку, если курсор навести на любую из иконок панели задач; 
• X и Y координаты курсора в милах или мм (в зависимости от выбранной единицы измерения). 
• Информация об элементе, который выбран. Если элемент не выбран, то выводится надпись No selection. 
• Текущий активный слой (Top) 

3.3 Нумерация выводов футпринта 

Для того, чтобы создать печатную плату, FreePCB использует входной файл списка соединений, который
генерируется независимым схемным редактором. В нашей системе сквозного проектирования роль такого схемного
редактора выполняет программа SwCad III. В свою очередь, список соединений представляет собой перечень цепей, а
также выводов компонентов электрической принципиальной схемы, с которыми эти цепи соединены. Поэтому, чтобы
добиться корректного преобразования списка соединений в печатную плату, нужно обеспечить соответствие между
нумерацией выводов элементов электрической схемы и футпринтов на печатной платы. Для нумерации выводов
стандартных элементов электрической схемы, таких как резисторы, конденсаторы, индуктивности, транзисторы, 
диоды и т.п., программа SwCad использует стандарт принятый в SPICE симуляторах. Нумерация, соответствующая
этому стандарту, приведена в разделе, где описываются схемные элементы симулятора LTSpice. С другой стороны
вывода библиотечных футпринтов в программе FreePCB пронумерованы в соответствии с рекомендациями
производителей электронных компонентов. Зачастую эта нумерация не соответствует SPICE стандартам. Так
нумерация выводов, предлагаемая производителем, обычно не критична, то приоритетной становится нумерация
соответствующая стандарту SPICE. Перед тем, как приступить к созданию печатной платы, необходимо убедиться в
том, что нумерация выводов футпринтов, соответствует нумерации их электрических прототипов. В отличие от
рассмотренного ранее, мастера (Footprint Wizard), который автоматически производил нумерацию выводов, редактор
позволяет определять нумерацию выводов создаваемых футпринтов, а так же изменять её для уже существующих. 
Примечание: футпринта, с изменённой нумерацией выводов, следует переименовывать и сохранить  в
пользовательской библиотеке user_created.fpl. В противном случае они могут быть утеряны при обновлении
стандартных библиотек футпринтов.   
 

Рис.13 Список слоёв 
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3.4 Редактирование существующего футпринта 

3.4.1 Загрузка существующего футпринта из библиотеки 
Начнём работу с редактором с того, что отредактируем заготовку футпринта TERMINAL2, которая была создана
ранее при помощи мастера. Для этого, находясь в программе FreePCB, запустим редактор футпринтов, 
воспользовавшись пунктом Open Footprint Editor меню File или пунктом Footprint Editor меню Tools.  Редактор
начинает работу с пустого окна, на котором отражаются лишь символ начала координат и строка REF (рис.12).  
Для загрузки существующего футпринта воспользуемся пунктом Import footprint… меню File. Если редактор  
запускался в отсутствии активного проекта (использовался пункт Open Footprint Editor меню File), то это может
вызвать появление окна предупреждения (рис.14), которое говорить о том, что редактор не обнаружил библиотечных
файлов.  

Рис.14 Окно предупреждения редактора (Footprint Editor)  

В этом нет ничего страшного, просто давим на кнопку ОК. После этого окно предупреждения закрывается, и мы
попадаем в меню загрузки библиотечного файла (рис.15).   

Рис.15 Меню загрузки библиотечного файла Import Footprint from library file.  

Как и следовало ожидать, редактор не обнаружил библиотечных файлов и список пуст. Чтобы найти библиотеки
воспользуемся кнопкой Browse…. Если директория установки программы FreePCB была выбрана “по умолчанию”, то
путь к библиотекам, скорей всего, будет следующий C:\Program Files\FreePCB\lib. После того, как библиотеки
обнаружены, меню загрузки примет вид, изображённый на рис.16. 
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Рис.16 Меню загрузки библиотечного файла Import Footprint from library file.  

Опускаемся в самый низ списка библиотек и обнаруживаем пользовательскую библиотеку “user created.fpl”. Именно в
эту библиотеку мы сохранили заготовку футпринта TERMINAL2, которая была создана ранее при помощи мастера. 
Чтобы открыть библиотеку, кликаем по символу “+” левее её названия. После этого библиотека раскрывается и мы
можем видеть все футпринты, которые она содержит. Выбираем футпринт TERMINAL2. После того, как футпринт
выбран, в окне просмотра появляется его изображение (рис.17). Полюбовавшись на него, нажимаем кнопку ОК.  

Рис.17 Меню загрузки библиотечного файла в состоянии, когда выбран какой-то библиотечный футпринт.  



Библиотеки футпринтов программы FreePCB 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

После загрузки библиотечного футпринта, окно редактора будет выглядеть примерно так, как показано на рис.18.  

Рис.18 Вид окна редактора.  

3.4.2 Изменения внешних очертаний футпринта. 
Контур футпринта терминала, автоматически прорисованный мастером в слое top silk, обычно не соответствует
действительному. Как результат, это может привести к тому, что терминал неожиданно “наедет” на корпуса соседних
компонентов, при установке его на готовую плату. Чтобы избежать таких конфликтов, лучше заранее обеспечить
соответствие библиотечного футпринта его физическому прототипу. Так как размеры терминала указаны в мм (рис.9), 
то необходимо мм перевести в милы, воспользовавшись соотношением 1 мил=0.0254 мм, а так же рассчитать
координаты характерных точек. Результат этих преобразований и расчётов изображён на рис. 19.    

Рис.19 Координаты характерных точек футпринта двухвыводного терминала.  

Первый вывод футпринта расположен в начале координат и, соответственно, имеет координаты 0:0.  
Для начала удалим ненужный контур, кликнув по нему левой кнопкой мышки, а затем нажав функциональную
клавишу F7 (Delete Polyline) или клавишу Delete (рис.20). 

  

Рис.20 Удаление линии контура футпринта.  
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Чтобы нарисовать новый контур, выберем пункт Polyline меню Add. После чего появится не большое окно настройки
(рис.21), в котором можно выбрать толщину линии (Line width), единицы измерения (Units), а так же тип линии -  
разомкнутая (Open) или замкнутая (Closed). Оставим всё как есть и, чтобы запустить рисование линии, нажмём
кнопку ОК.  

  

Рис.21 Окно настройки ломанной линии (Add polyline).  

После этого в окне редактора появляется перекрестие, прочерченное белой пунктирной линией, которое обозначает
текущую координату линии. Перекрестие следует за мышкой, перепрыгивая между узлами сетки размещения. Так как
координаты, указанные на рис. 19, кратны 25 мил, то установим соответствующий шаг сетки размещения. Для этого
кликнем левой кнопкой мышки по кнопке с треугольником в поле Placement,  находящимся на панели задач. В
выпадающем меню выберем 25. Далее, наблюдая координаты перекрестия в строке состояния, переместим его в точку
X:-100 Y:-125. После того, как перекрестие достигло требуемой точки, начнём рисование линии, кликнув левой
кнопкой мышки. Далее рисуем линию, последовательно кликнув левой кнопкой мышки в точка с координатами X:-
100 Y:-125, X:-100 Y:175, X:300 Y:175, X:300 Y:-125. В последней точке линия автоматически прерывается. Результат
нашего рисования изображён на рис.22.   

  

Рис.22 Футпринт терминала с корректной контурной линией.  

Теперь футпринт практически готов. Осталось только переместить текст позиционного обозначения REF в удобное
для обзора место. Так как положение и размер этого текста можно поменять в любое удобное время, то с выбором
можно особо не мучиться. Чтобы переместить текст REF, кликнем по нему левой кнопкой мышки. После этого вокруг
REF появится тонкая белая рамка, которая говорит о том, что данный элемент выбран. Чтобы переместить REF, 
нажмём функциональную клавишу F4 (Move Ref Text). При перемещении текста, он так же привязан к узлам сетки
Placement и может вращаться при помощи функциональной клавиши F3 (Rotate Ref Text). Чтобы закрепить текст REF 
в новом месте, достаточно кликнуть левой кнопкой мышки. Готовый футпринт терминала изображён на рис. 23. 

Рис.23 Футпринт терминала в заключительном виде.  

Чтобы сохранить футпринт в пользовательской библиотеке user_created.fpl, можно воспользоваться пунктом Save 
Footprint As… меню File или иконкой на панели задач (рис.7).  
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3.4.3 Изменение нумерации выводов футпринта 
Как говорилось ранее, нумерация выводов библиотечных футпринтов программы FreePCB может отличатся от  
нумерации в стандарте SPICE, которая используется в редакторе схем программы SwCad III. В этом случае, чтобы
избежать путаницы, необходимо исправить нумерацию выводов.  
Например, упакуем встроенный NMOS транзистор программы SwCad (рис.24) в стандартный футпринт ТО-220, 
который находится в  библиотеке футпринтов th_transistor.fpl.  

Находясь в редакторе (Footprint Editor), активизируем пункт  Import footprint... меню File или кликнем по кнопке на

панели задач. Как результат, появится меню загрузки файла футпринта (рис.25).  

Рис.25 Загрузка библиотечного файла ТО-220. 

Чтобы открыть библиотеку th_transistor.fpl, кликаем по символу “+” левее её названия. После этого библиотека
раскрывается и мы можем видеть все футпринты, которые она содержит. Выбираем футпринт TO-220 и нажимаем
кнопку ОК.  
Выбранный футпринт загружается в окно редактора. Теперь, чтобы увидеть номер любого вывода, необходимо
выбрать его кликнув левой кнопкой мышки по центру соответствующей контактной площадки. Номер выбранного
вывода (Pin 1) отображается в строке состояния (рис.26).  

Рис.26 Проверка номера вывода футпринта. 

Рис.24 Нумерация выводов NMOS транзистора в программе SwCad III. 



Библиотеки футпринтов программы FreePCB 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

Текущая нумерация, а так же требуемое функциональное назначение выводов изображены на рис.27.    

Рис.27 Нумерация и функциональное назначение выводов NMOS транзистора в корпусе ТО-220.  

При сравнении рис. 27 с рис. 24 можно заметить, что текущая нумерация выводов футпринта ТО-220 не соответствует
требуемой нумерации NMOS транзистора. Чтобы привести всё в соответствие нужно первый вывод сделать вторым, а
второй первым. Для этого выбираем второй (средний) вывод футпринта ТО-220, кликнув по нему левой кнопкой
мышки. После того, как вывод выбран, вызываем меню редактирования вывода Add/Edit Pin, нажав функциональную
клавишу F1 (Edit Pad). Меню редактирование вывода имеет множество информационных полей, назначение которых
будет рассмотрено позже. А пока, чтобы не вызвать конфликта с существующими номерами выводов, введём в поле
Pin # несуществующий номер 4 (Рис.28а) и нажмём кнопку ОК. Далее, аналогичным образом, выберем левый вывод
футпринта и вызовем его меню редактирования. В информационном поле Pin # введём номер 2 (рис.28б). И наконец
выберем средний вывод и изменим его номер с 4 на 1 (рис.28в).     

Рис.28 Последовательность изменения нумерации выводов футпринта ТО-220:  
а – присвоение среднему выводу несуществующего номера; б – изменение номера левого вывода; в – изменение 

номера среднего вывода. 
Чтобы сохранить футпринт в пользовательской библиотеке user_created.fpl, можно воспользоваться пунктом Save 
Footprint As… меню File или иконкой на панели задач (рис.7). Изменённому футпринту нужно присвоить новое
название, не совпадающее с тем, которое футпринт имел до редактирования.   
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3.5 Создание нового футпринта 

3.5.1 Запуск редактора 
Находясь в программе FreePCB, запустим редактор, воспользовавшись пунктом Open Footprint Editor меню File или
пунктом Footprint Editor меню Tools.  Редактор начинает работу с пустого окна, на котором отражаются лишь символ
начала координат и строка REF (рис.12).  Английская система измерения (mil) установлена по умолчанию.   
В качестве примера, создадим футпринт HEXFET транзистора IRFZ44N, который используется в  преобразователе
12/19В. Библиотечный футпринт ТО-220 рассчитан на установку в вертикальном положении, что нас не устраивает, 
т.к. используемый радиатор предполагает, что транзистор будет “положен”.  
На рис.29 приведены размеры корпуса транзистора IRFZ44N, взятые из документации производителя. Размеры
приведены в мм (дюймах). 

  

Рис.29 Размеры корпуса транзистора IRFZ44N.  

3.5.2 Добавление выводов 
Начнём создание футпринта транзистора с
выводов.  Для этого воспользуемся пунктом Pin 
меню Add. Это вызовет диалоговое окно
Add/Edit Pin (рис.30). По сравнению с
профессиональными программными пакетами, 
создание выводов и их контактных площадок в
программе FreePCB сильно упрощено и
заключается в заполнении информационных
полей диалогового окна. При этом качество
описания практически не страдает, но сам
процесс значительно упрощается и ускоряется. 
Например, если в области ввода Operation 
установлена опция Add single pin, то вводится
одиночный вывод. Его номер вводится в поле
Pin #. Если футпринт имеет ряд равноудалён-
ных и последовательно пронумерованных
выводов, то для их ввода можно воспользо-
ваться опцией  Add row of pins. В этом случае в
информационном поле Pin # вводится номер
первого (крайнего левого или нижнего) вывода
ряда, а в информационном поле # of pins 
вводится общее количество выводов.  

   

Рис.30 Вид заполненного диалогового окна описания вывода Add/Edit Pin.  
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Согласно версии производителя (рис.29), вывода транзистора равноудалены и образуют ряд с последовательной
нумерацией. К сожалению, предложенная нумерация не соответствует стандарту SPICE принятому в программе
SwCad III для NMOS транзистора(рис.24). Поэтому, чтобы избежать последующего редактирования нумерации, 
вывода футпринта лучше вводить в режиме  Add single pin.   
В области Padstack описываются контактные площадки вывода (или выводов). Если выбрана опция SMT (top), то
вводится SMT контактная площадка со стороны компонентов платы. Если выбрана опция SMT (bottom), то вводится
SMT контактная площадка со стороны паек платы. Если выбрана  опция Through-hole, то вводится стек контактных
площадок штыревого вывода. Для контактных площадок имеющих прямоугольную форму, с помощью выпадающего
меню Orientation of length axis можно выбрать направление, в котором ориентирована более длинная сторона
прямоугольника. Если выбрать horiz, то длинная сторона ориентирована по горизонтали, а если vert, то по вертикали. 
Информационное поле Same as pin # не активно, так как в рабочем поле редактора ещё отсутствуют контактные
площадки выводов. В противном случае это поле активизируется и там можно указать номер вывода, контактная
площадка которого будет выбрана в качестве прототипа для очередного вывода. 
Так как корпус ТО-220 имеет штыревые выводы, то выбираем опцию Through-hole и в поле hole diameter вводим
диаметр отверстия в контактной площадке равный 50 мил(1.27мм). 
В подобласти Top pad описываются форма и размеры контактной площадки со стороны компонентов. В выпадающем
меню Shape можно определить следующие формы контактных площадок: 

• None – контактная площадка отсутствует; 
• Round – круглая. В поле Width вводится диаметр круга; 
• Square – квадратная. В поле Width вводится длина стороны квадрата; 
• Rect – прямоугольная. В поле Width вводится ширина прямоугольника, а в поле Length длина; 
• Rounded-rect – прямоугольная со скруглёнными углами. В поле Width вводится ширина прямоугольника, в 

поле Length длина, а в поле Corner radius радиус закругления углов; 
• Oval – овальная. В поле Width вводится ширина овала, а в поле Length длина;  
• Octagon – восьмиугольная. В поле Width вводится размер восьмиугольника:   

В подобласти Inner pads, аналогичной Top pad, описываются форма и размеры контактных площадок во внутренних
слоях платы. Если установить галочку Same as top pad, то эти площадки станут подобны площадке в со стороны
компонентов. 
В подобласти Bottom pad, аналогичной Top pad, описываются форма и размеры контактной площадки со стороны
паек. Если установить галочку Same as top pad, то эта площадка станет подобной площадке со стороны компонентов. 
Для стороны компонентов выберем круглую (round) форму контактной площадки и в поле Width укажем её диаметр, 
равный 80 мил (≈2 мм). В подобластях Inner pads и Bottom pad установим галочки Same as top pad, что сделает эти
площадки подобными площадке со стороны компонентов. 
В области Position выбирается режим позиционирования вывода. Если выбрана опция Drag to position, то вывод
перетаскивается курсором мышки. В этом случае, для размещения вывода в требуемой позиции достаточно кликнуть
левой кнопкой мышки. Если выбрана опция Set: X Y, то требуется явно указать координаты размещения вывода. 
Последняя опция удобна тем, что сразу помещает вывод в нужное место,  а так же просто незаменима, если позиция
вывода не совпадает с узлами сетки Placement.  
Область Row активна, если вводится ряд выводов. В этом случае в поле Row orientation можно выбрать ориентацию
ряда (горизонтальная или вертикальная), а в поле Row spacing расстояние между соседними выводами.  
Установим координаты размещения вывода Set: X0 Y0 и нажмём на кнопку ОК. После этого окно закроется и в
начале координат появится контактная площадка вывода.  
Чтобы разместить следующий вывод,  снова активизируем пункт Pin меню Add. Это вызовет диалоговое окно
Add/Edit Pin, заполненное аналогично предыдущему выводу. Единственное отличие этого окна в том, что в поле Pin # 
автоматически проставлен следующий номер вывода – 2. Установим координаты размещения вывода Set: X-100 Y0 и
нажмём на кнопку ОК.  
Третий вывод размещается так же как первый и второй, но в точке Set: X100 Y0. То, что в результате получилось, 
изображено на рис. 31. 

Рис.31 Контактные площадки выводов транзистора IRFZ44N.  
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3.5.3 Рисование контура футпринта 
Далее необходимо прорисовать контуры футпринта. Для этого, воспользовавшись информацией производителя
(рис.29) и определим размеры и координаты характерных точек (рис.32), которые облегчат процесс рисования. Здесь
длина выводов уменьшилась с 530…555 мил, до 300 мил. Оставшиеся 230 мил (5.845 мм) выделены для отгибания и
запайки в плату.  

Рис.32 Координаты характерных точек футпринта транзистора IRFZ44N.  

Начнём с рисования контура вывода, находящегося в координате 0:0. Для этого выберем пункт Polyline меню Add. 
После чего появится не большое окно настройки (рис.21), в котором можно выбрать толщину линии (Line width), 
единицы измерения (Units), а так же тип линии -  разомкнутая (Open) или замкнутая (Closed). Оставим всё как есть и, 
чтобы запустить рисование линии, нажмём кнопку ОК. После этого в окне редактора появляется перекрестие, 
прочерченное белой пунктирной линией, которое обозначает текущую координату линии. Перекрестие следует за
мышкой, перепрыгивая между узлами сетки размещения (Placement). Так как контур вывода имеет ширину 40 мил и
его края смещёны относительно нулевой координаты на 20 мил, то установим шаг сетки размещения равным 20 мил. 
Для этого кликнем левой кнопкой мышки по кнопке с треугольником в поле Placement,  находящимся на панели задач. 
В выпадающем меню выберем 20. Далее, наблюдая координаты перекрестия в строке состояния, переместим его в
точку X:-0 Y:-0. После того, как перекрестие достигло требуемой точки, начнём рисование линии, кликнув левой
кнопкой мышки. Далее рисуем линию, последовательно кликнув левой кнопкой мышки в точках с координатами X:-
20 Y:-0 и X:-20 Y:220. Далее ширина контура вывода увеличивается до 50 мил и эта величина не кратна выбранному
шагу сетки размещения. Чтобы установить новую сетку, не прерывая процесс рисования линии, вызываем
выпадающее меню Placement и выбираем 25. Продолжаем рисование,  последовательно кликнув мышкой в точках с
координатами X:-25 Y:225 и X:-25 Y:300. Чтобы прервать линию, кликнем правой кнопкой мышки. Теперь
аналогичным образом, изменив знак координаты X, прорисуем другой край контура вывода. Далее, со смещением по
оси X на 100 и 200 мил, прорисуем контуры оставшихся двух выводов (рис.33).  
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Рис.33 Контуры выводов транзистора IRFZ44N.  

Потренировавшись на выводах, приступим к контуру футпринта. Для этого начнём новую линию в точке          X:-100 
Y:300 и продолжим её до точки X:-100 Y:800. Далее, чтобы нарисовать полукруглую выемку, нажмём
функциональную клавишу F3, которая позволяет нарисовать дугу (Arc) против часовой стрелки (CCW). Кликнем
левой кнопкой мышки в точке X:-75 Y:250, а затем в точке X:-100 Y:850. После этого выемка готова. Чтобы
продолжить рисование контура прямой линией, нажмём функциональную клавишу F1 (Strtaight Line). После того, как
нарисованы все контуры футпринта, необходимо нарисовать контур его крепёжного отверстия. В FreePCB 
окружности рисуются фрагментами дуги. Поэтому рисование окружности можно начать, как рисование дуги в точке
X:25 Y:800 (или любой другой из четырёх указанных точек). В зависимости от привычки или удобства, окружность
можно рисовать дугой в направлении по часовой (функциональная клавиша F2) или против часовой (функциональная
клавиша F3) стрелке. Если окружность рисуется по часовой стрелке, то дуга последовательно пройдёт через точки с
координатами X:100 Y:875, X:175 Y:800 и X:100 Y:725. При возврате в начальную точку линия автоматически
прерывается. Полностью нарисованный контур изображён на рис.34.   

  

Рис.34 Полностью нарисованный контур транзистора IRFZ44N. 
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Теперь футпринт практически готов. Осталось только переместить текст позиционного обозначения REF в удобное
для обзора место. Так как положение и размер этого текста можно поменять в любое удобное время, то с выбором
можно особо не мучиться. Чтобы переместить текст REF, кликнем по нему левой кнопкой мышки. После этого вокруг
REF появится тонкая белая рамка, которая говорит о том, что данный элемент выбран. Чтобы переместить REF, 
нажмём функциональную клавишу F4 (Move Ref Text). При перемещении текста, он так же привязан к узлам сетки
Placement и может вращаться при помощи функциональной клавиши F3 (Rotate Ref Text). Чтобы закрепить текст REF 
в новом месте, достаточно кликнуть левой кнопкой мышки. Футпринт транзистора IRFZ44N, в завершённом виде, 
изображён на рис. 35. 

   

Рис.35 Футпринт транзистора IRFZ44N.  

3.5.4 Сохранение футпринта 
Чтобы сохранить футпринт в пользовательской библиотеке user_created.fpl, можно воспользоваться пунктом Save 
Footprint As… меню File или иконкой на панели задач.  Это действие вызовет появление окна Save Footprint. В 
информационном поле Footprint name введём имя нового футпринта IRFZ44NL. В необязательных (опциональных) 
полях можно ввести имя автора (Author), создавшего библиотечный футпринт, источник информации (Source), 
которым пользовалис при создании футпринта, а так же краткие комментарии к футпринту (Description). Затем, в
информационном поле Library file, выбираем название пользовательской библиотеки user_created.fpl и нажимаем OK, 
чтобы сохранить футпринт (рис.36). 

  

Рис.36 Окно сохранения футпринта в библиотеку.  
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3.6 Использование мастера футпринтов в окне редактора. 

Мы имеем возможность, находясь в окне редактора, использовать мастер футпринтов. Для этого достаточно выбрать
пункт Tools меню Footprint Wizard. Используем эту возможность для создания 44-выводного TQFP футпринта
популярного SMT микроконтроллера PIC16F877,  размеры которого показаны на рис.37.  

Рис.37 Размеры 44-выводного TQFP корпуса.  

Находясь в редакторе, выберем пункт Tools меню Footprint Wizard. Результатом будет появление  рабочего окна
мастера (Footprint Wizard) (рис.5). Информационные поля этого окна уже рассматривались ранее во второй части этой
главы и поэтому не будем на этом останавливаться. Вид этого окна с полями заполненными соответствующим
образом показан на рис.38. 

Рис.38 Пример создания футпринта TQFP с помощью мастера.  
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В поле Name указано имя футпринта – PIC16F877PT. В поле Type выбрана стандартная упаковка QUAD. В поле Units 
выбрана единица измерения – mils.  
Общее количество выводов, равное 44, указано в поле Total. Количество выводов горизонтального ряда, равное 11, 
указано в поле Per horizontal row. Количество выводов вертикального ряда мастер автоматически указывает в поле Per 
vertical row. В поле Pin 1 position указано, что первым будет крайний левый вывод нижнего ряда выводов (bottom row, 
left-most pin).  
Так как площадки нашего SMT компонента имеют прямоугольную форму без отверстий, то в поле Shape выбран
вариант Rectangular, а в поле Hole diameter записан 0. В поле Width (X) установлена ширина контактной площадке
равная 20 мил (≈ 0.5 мм), а в поле Length (Y) длина, равная 60 мил (≈1.5мм). В поле Spacing (E) указано расстояние
между выводами одного ряда, равное 31 мил.  
Далее, в поле Distance between top and bottom rows, указано расстояние между выводами верхнего и нижнего рядов, 
равное 250 мил. И аналогичное значение в поле Distance between left and right rows для расстояния между центрами
выводов левого и правого ряда. В отличие от других размеров, эти расстояния, а также размеры контактных площадок
не указаны производителем явно и поэтому определяются таким образом, чтобы для любых указанных разбросов
исключить замыкания и обеспечить гарантированное попадание выводов футпринта на контактные площадки.  
Теперь, чтобы отобразить полученный футпринт в окне Preview, достаточно кликнуть по одноименной кнопке. Чтобы
закончить работу мастера и перенести готовый корпус в окно редактора, необходимо нажать кнопку Done (рис.38).  
При необходимости, в редакторе можно доработать футпринт, а затем сохранить его, вызвав пункт Save Footprint As… 
меню File или нажав кнопку на панели задач. 



TinyCAD User's Manual

Version 2.80.03

http://tinycad.sourceforge.net

TinyCAD

Руководство пользователя  

Перевел Валентин Володин  
email: valvolodin@narod.ru 

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

http://tinycad.sourceforge.net


Copyright 1994-1995, 2002-2010  Matt Pyne.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General 
Public License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any 
later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the 
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser 
General Public License for more details.
You should have received a copy of the GNU Lesser General Public License along with this application; if not, write to 
the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

Credits

TinyCAD has been supported by many people over the last few years, and here are just some of the people who have 
contributed:

Founding author

Matt Pyne

Legacy contributors

Arron Lawrence
Dariusz Rybak 
Jean Demartini
Jesper Reenberg
Jesus Consuegra 

Kirk Bailey 
Victor Faria
Wim Knevel
Andrew Walker
Emile de Groot

Greg Newton
Jean Demartini
Jesus Consuegra 
Wim Knevel
Kai Blaschek

Current development team

Don Lucas
Mark Langezaal

Magnus Beischer
Stephen Friederichs

Jason Sachs

Recent contributors from outside the development team:

Thomas Peterson Oleg Skydan Greg Endler

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

TinyCAD.  Руководство пользователя 



Добро пожаловать в TinyCAD!

TinyCad является бесплатным редактором электрических схем с открытым исходным кодом и рассчитан на 
работу под управлением операционной системы MS Windows (NT/2000/XP).  На сайте программы 
http://tinycad.sourceforge.net можно узнать самые последние новости, а также скачать установочный файл 
TinyCAD-2.80.03.exe последней версии (на момент написания статьи доступна  версия 2.80.03)  или исходный 
код. 
TinyCad имеет богатый набор встроенных библиотек символов, которые можно использовать для создания 
собственных схем. Также большое количество готовых библиотек, созданных пользователями TinyCad, можно 
найти на Yahoo group http://uk.groups.yahoo.com/group/tinycad/ . Кроме этого в TinyCad встроен редактор 
библиотек, который позволяет редактировать существующие библиотеки символов, а также создавать свои 
собственные библиотеки. 
TinyCAD имеет специальное меню, при помощи которого можно автоматически присваивать позиционные 
обозначения символам, проверять готовый проект на отсутствие ошибок, а также генерировать список 
соединений (netlist) для программы проектирования печатных плат. 
Схемы, созданные в TinyCad, могут простым копированием-вставкой переносится в документы Word или 
OpenOffice. При необходимости схемы могут быть распечатаны на принтере. Если размер схемы слишком 
велик, то её можно распечатать на нескольких листах или изменить её масштаб для печати на один лист. 

Перевёл и дополнил руководство Валентин Володин
http://valvolodin.narod.ru
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1. Установка и рабочее окно программы TinyCAD

Установка программы особых затруднений не вызывает и заключается в активизации установочного файла. 
Далее следует просто соглашаться со всеми предложенными опциями. После установки будет создана 

соответствующая запись в списке программ, а также появится иконка   на рабочем столе. После двойного 
щелчка левой кнопкой мышки по этой иконке откроется рабочее окно программы. 

На рисунке выше изображены основные области и элементы рабочего окна программы. Функциональное 
назначение и использование таких элементов, как координаты курсора, горизонтальная и вертикальная линейки, 
горизонтальная и вертикальная полосы прокрутки, очевидны и особого описания не требуют. Однако некоторые 
другие области и элементы окна следует подробно рассмотреть.

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

TinyCAD.  Руководство пользователя 



2. Рисование схемы

Электрическая схема создается из встроенных объектов, таких как провода, точки соединения и т.п., а так же из 
импортированных символов компонентов, таких как диоды, транзисторы и т.п.

Размещение символов компонентов в вашей схеме

1. Используйте список символов компонентов (далее по тексту просто символы или компоненты) в левой части 
окна программы для просмотра и выбора символов, необходимых в вашей схеме.
2. Если вы не помните название требуемого символа, то можете воспользоваться диалогом поиска объекта. 
Введите слово, описывающее компонент. По мере ввода, список символов будет сокращаться таким образом, 
чтобы включать только те символы, которые содержат введённый текст в их названии или описании. Если 
требуемый символ компонента отсутствует, то его придется создать. Как это можно сделать описано в разделе 
описания библиотек.
3. Поместите символ на схему, выбрав его как актуальный инструмент (Tool). Это можно сделать дважды 
щелкнув левой кнопкой мыши по названию символа, либо щелкнув по изображению символа в окне просмотра.
4. Разместите символ в окне схемы, щелкнув левой кнопкой мыши в нужном месте. Символ можно вращать при 
помощи диалога, расположенного в верхней части окна Tool Options. Выберите Up(Вверх), Down(Вниз), 
Left(Влево) или Right(Вправо) для ориентации символа. Те же самые операции можно последовательно 
производить при помощи комбинации клавиш Ctrl-R. Установив галочку Mirror(отразить) можно получить 
зеркальное отображение символа.  
5. После размещения всех символов одного типа, щёлкните правой кнопкой мыши для окончания.

Совет - вы можете перемещать текстовые поля символа. Для этого, сначала выберите символ для 
редактирования, а затем перетащите, при помощи мыши, любое поле символа  в новое положение на 
схеме.

В любой момент времени используется определенное количество библиотек символов. Список выбранных 
библиотек отображается в меню библиотек. Перед тем, как Вы начнёте использовать символы компонентов, 
необходимо выбрать хотя бы одну библиотеку символов. (См. Меню библиотек, в меню ссылок для получения 
дополнительных сведений о добавлении библиотеки в этот список).

Соединение компонентов в схеме

1. Используйте инструмент Wire(провод), который отображается в виде синей линии  на панели 
инструментов.
2. Наведите указатель мыши на начальную точку подключения провода. Небольшой красный кружек появится 
вокруг ближайших активных точек символов компонентов или других проводов. Этот кружочек указывает 
точки доступные для подключения провода. Для подключения провода щелкните левой кнопкой мыши.  
3. Продолжите прокладку провода. Нажатие левой кнопки мыши, в процессе этого, позволяет изменить 
направление прокладки провода (излом).
4. Для завершения прокладки, выберите другую активную точку (которая также выделяется красным кружком).
5. Обратите внимание, что провод буквально притягивается к выводам символов компонентов  и другим 
проводам.
6. Если вы подключаете провод к другому проводу, то автоматически формируется точка соединения.

Совет
– очень распространенной ошибкой является использование Lines Poligon(ломаной линии)  
вместо провода. По понятной причине, этого следует избегать. Ломаная линия не воспринимается 
программой TinyCad как электрическая связь, что не позволит в последующем экспортировать вашу 
схему в программу проектирования печатных плат.
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Редактирование схемы

После того, как символ компонента был помещен на схему, 
вы можете изменить его свойства. Инструмент 
редактирования, на панели инструментов рисования, 
используется для редактирования уже размещенных 
объектов. Обычно инструмент редактирования выбирается 
по умолчанию после того, как вы закончили работу с 
другим инструментом. Чтобы выбрать его вручную, 
нажмите на белую стрелку , расположенную на панели 
инструментов.
Иногда, в процессе рисования провода, требуется 
продолжить его прокладку в части схемы, находящейся за 
границами отображения. Перетащить скрытую часть в 
область видимости можно путем панорамирования, при  
помощи средней кнопки мыши (как правило, с колесом 
прокрутки) или используя полосы прокрутки в нижней и 
правой части области рисования. Вы также можете 

использовать колесо прокрутки для увеличения и уменьшения изображения на чертеже.
Используйте инструмент редактирования в режиме характерном для Windows. Для выбора одного объекта 
щелкните по нему левой кнопкой мыши, для выбора нескольких объектов используйте клавишу Ctrl или 
выделите область расположения этих объектов. Если выбран один объект, то будет показано диалоговое окно 
Tool options с его параметрами, доступными для редактирования.
Вы можете перемещать объекты в обычном режиме Windows, который заключается в том, что объекты сначала 
выбираются а затем перемещаются. По умолчанию, при перемещении символов компонентов, провода, 
подключенные к ним, не отрываются. Однако, если вы хотите отцепить провода от символа, то в процессе его 
перемещения удерживайте нажатой клавишу Ctrl.
Для удаления выбранных объектов используйте кнопку Delete(удалить)   на панели инструментов или кнопку 
Del(удалить) на клавиатуре. Обычные операции вырезки, копирования и вставки также возможны. Доступ к ни 
можно получить через меню Edit(правка) или вызвав контекстное меню, при помощи правой кнопки мыши.
Если вы предпочитаете не использовать Windows возможности редактирования в TinyCAD, то можно 
воспользоваться инструментами для перемещения, перетаскивания и дублирования блока. Их можно 
обнаружить на панели блоковых инструментов.
Если вы хотите повернуть блок (на 90 градусов), то используйте инструмент вращения блока, который также 
расположен на панели блоковых инструментов. Щелкнув по кнопке, выделите прямоугольную область блока, а 
затем используйте кнопки на всплывающей панели Block Rotate Tool Options (опции инструмента вращения 
блока), чтобы повернуть или отразить выделенную область.
Программа TinyCAD имеет встроенный буфер отмены / повтора. Если вы вдруг сделаете ошибку, то всегда 
сможете отменить последнее действие при помощи команды Undo(отменить) из меню Edit(правка).
Чтобы, в случае сбоя компьютеры, Вы не потеряли результаты своей работы, программа TinyCAD
периодически сохраняет проект. По умолчанию режим автосохранения активизируется каждые 10 минут. 
Резервная копия схемы сохраняется в том же каталоге, что и оригинал, но с расширением "autosave".
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Каждый символ имеет по крайней мере два 
текстовых атрибутов, связанных с ним.

Атрибут Имя (Name)
Это имя или тип компонента, который представ-
лен символом. Если компонент имеет номинал, 
вставьте этот номинал здесь. Например, если это 
резистор, то в качестве имени указывается 

сопротивление резистора, 330R или 4K7. Если символ представляет собой штекер для наушников, то названием 
будет что-то типа Phono.

Атрибут Ссылка (Reference)
Это позиционное обозначение компонента, которое является уникальным для всей конструкции. Ссылка может 
выглядеть как R1 или Q3 и т.п. В конструкции может быть много резисторов с номиналом 330R, однако, 
каждый резистор должен иметь уникальное позиционное обозначение. Т.е. в схеме должен быть только один 
символ R1. Это поле обычно оставляется так как есть. Для автоматической расстановки позиционных 
обозначений Вы можете использовать пункт Generate Symbol References(Генерация ссылок символов) меню 
Special (Специальное), где использовать режим Use reference painter для явного указания последовательности 
присвоения ссылок или формировать последовательность ссылок автоматически.

Атрибут упаковки
Этот атрибут используется для экспорта списка соединений для печатной платы. Программа проектирования 
печатной платы (PCB) будет использовать этот атрибут для того, чтобы определить, какой футпринт (посадочное 
место) соответствует каждому компоненту принципиальной схемы. Не существует жестких правил для на-
именования этого атрибута, которое полностью зависит от библиотек футпринтов, поставляемых с программой 
PCB.
Не все библиотечные символы программы TinyCAD имеют заполненный по умолчанию атрибут упаковки. Вы 
должны добавить его самостоятельно, если хотите экспортировать схему в программу PCB. Чтобы добавить 
его, просто нажмите на кнопку Add, а затем переименуйте новый атрибут в Package.

Другие атрибуты
Вы можете добавить дополнительные атрибуты в диалоге Tool Options. Не существует каких-то реальных 
ограничений на количество добавляемых атрибутов. Вы можете использовать эти ссылки практически для 
любых целей. Например, можете добавить здесь инструкцию по разводке печатной платы или добавить данные 
для автоматического формирования BOM-а (Bill of materials — список материалов, компонентов, блоков, 
составных частей конечного продукта). 
Все символы в поставляемых библиотеках имеют атрибут other уже определенный для вас. Тем не менее, вы 
можете добавить больше, если хотите. Это можно сделать, либо добавив их по умолчанию, отредактировав 
символ в библиотеке, либо добавить их в индивидуальном порядке для каждого символа во время размещения 
на схеме.

Автоматическое размещение точек соединения
Точки соединения размещаются автоматически таким образом, что обычно для этого не нужно использовать 
специального инструмента.
Два пересекающихся провода не считаются соединёнными, пока не будет использовано соединение в точке 
пересечения. Соединение также образуется, если вывод компонента касается проходящего провода.
Если вы хотите размещать точки соединения в ручную, выключите автоматическое размещение соединений 
(Auto-place junctions) при помощи диалога Settings в меню Options. 
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После этого инструмент Junctions (Соединения) , не доступный в режиме автоматического размещения 
соединений, станет доступным. 

Расширенные методы рисования

Для более продвинутых схем, TinyCAD имеет расширенные возможности.

Нет соединений
Обычно все выводы компонентов должны быть подключены. Однако может возникнуть ситуация, когда вы 
захотите оставить некоторые выводы не подключенными. При этом, чтобы при проверке правил 
проектирования не возникала ошибка, вы должны каким-то образом показать, что вывод не подключен 

намеренно. Это можно сделать при помощи специального инструмента No-connect (нет соединения) , 
расположенного на панели инструментов. Просто наведите No-connect маркер на каждый вывод, который 
должен оставаться не подключенным, и щелкните левой кнопкой мыши.

Объекты питания показывают, где к вашей схеме подключается напряжение 
питания. Возможны различные варианты отображения символов питания.
Символы объекта питания всегда подключайте в конце его вывода. Точка 
соединения необходима, если символ питания подключается к проходящему 
проводу или к пересечению проводов. При необходимости, точка соединения 
размещается автоматически.
Вариант отображения символа питания не имеет значения и игнорируется.  
Важным является значение имени символа объекта питания (параметр Power 
Voltage), которое автоматически присваивается соответствующей цепи 
питания. При этом, все элементы, подключенные к символам питания с 
аналогичным именем, считаются соединенными вместе.
Некоторые символы компонентов, такие как символы библиотеки 74TTL, 
автоматически подключаются к питанию. Для обеспечения правильности 
подключения, всегда используйте имена цепей питания, которые аналогичны 
используемым в библиотеке. Например, при использовании библиотеки 
74TTL, используйте имена цепей питания GND и VCC для напряжений 0В и 
5В соответственно.
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Во время размещения метки вы можете использовать сочетания 
клавиш для её левого или правого вращения, а также отражения.
Все провода имеющие одинаковую метку будут рассматриваться 
как соединённые вместе. Таким образом, связь между проводами 
формируется без необходимости рисовать её.
Используйте метки для подключения проводов между листами в 
тех же файлах или для подключения проводов одной страницы, 
которые не полностью прорисованы в связи с высокой 
плотностью схемы или личными предпочтениями.

Добавление шины

Шина может быть использована, чтобы указать большое количество соединений. Опции повторения помогут 
вам чертить шину.

Чтобы создать шину, воспользуйтесь кнопкой Bus (Шина) , расположенной на панели инструментов, и 

нарисуйте саму шину рядом с местами её предполагаемого подключения. Теперь, при помощи кнопок  или 

, добавьте входы в шину. Проведите провода между входами в шину и точками подключения в схеме.
Наконец, добавьте метки. Поместите первую метку. В зависимости от вашего варианта повтора имя метки будет 
автоматически обновляться. Поместите метку на каждый провод. Теперь подключение к шине завершено!
Используйте те же имена для всех соединений с шиной. Порядок расположения имен значения не имеет. 
Подключения к шине не требуют точек соединения, подобных тем, которые формируются при подключении к 
обычным проводам.

После того, как шина подключена, вы можете назвать её, используя инструмент наименования шины . 
Инструмент наименования позволяет разместить текст рядом с шиной. Название может содержать лишь одно 
число, указывающее количество проводов в шине, или указывать функциональное назначение шины, например,  
"Data Bus" и т. п.
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Добавление текста и аннотаций

Вы можете добавить следующие аннотации: текст, линии, прямоугольники, эллипсы и дуги . 
При генерации выходных файлов проекта все эти объекты будут проигнорированы.
Аннотации могут пересекать провода, символы и узлы, не затрагивая их. Использование этих объектов зависит 
от вас.

Рисование прямоугольников и эллипсов

Прямоугольники и эллипсы могут быть залиты цветом и TinyCAD, для доступа ко всем цветам, использует 
диалог выбора цветов Windows.
Чтобы нарисовать прямоугольник или эллипс, выберите соответствующий инструмент на панели инструментов 
аннотации , а затем щелкнув левой кнопкой мыши и удерживая её "вытяните" фигуру с необходимыми 
пропорциями. Когда вы отпустите кнопку мыши форма будет выбрана и готова к перепозиционированию, в 
случае необходимости.
Форму фигуры можно редактировать, выбрав её, щелкнув по фигуре, а затем при помощи ручек захвата 
(выглядят как маленькие квадратики) перемещать стороны фигуры, изменяя её размеры и пропорции.
Вы также можете выбрать стиль линии и цвет заливки фигуры при помощи диалогового окна Rectangle Tool 
Options, которое обычно отображается в правом верхнем углу схемы.

Рисование многоугольников и ломаных линий

Ломаная линия представляет собой набор соединенных между собой линий, которые должны быть одинаковой 
ширины и цвета. Многоугольник — это замкнутое множество соединенных линий, который может быть залит 
цветом.
Чтобы нарисовать многоугольник или ломанную линию, сначала выберите соответствующий инструмент на 
панели инструментов аннотации. Далее создадим фигуру, разместив её углы щелкая левой кнопкой мыши. 
Завершить фигуру можно либо двойным щелчком по последнему углу, либо вызвав контекстное  меню при 
помощи правой кнопки мыши и выбрав пункт Finish Polygon.
После завершения, фигура будет выбрана для редактирования. Вы можете выбрать цвет для заливки фигуры и 
выбрать стиль линии, используя диалоговое окно Polygon Tool Options, которое обычно отображается в правом 
верхнем углу схемы. При попытке залить цветом разомкнутую ломанную линию, будет создана дополнительная 
линия от её конечной точки к начальной, которая превратить разомкнутую линию в ряд многоугольников, 
залитых выбранным цветом.
Вы можете любой сегмент ломанной линии превратить в дугу или обратно при помощи пунктов Free line, Arc 
in, Arc out контекстного меню, вызываемого при помощи правой кнопки мыши.

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

TinyCAD.  Руководство пользователя 



Редактирование многоугольников и ломанных линий

После размещения многоугольника или ломанной линии:
 Можно изменить их полный размер и пропорции;
 Можно переместить любой угол;

 Можно добавить новый угол, при помощи пункта Add handle контекстного меню;

 Можно удалить угол, при помощи пункта Delete handle контекстного меню;

 Изменить форму любого сегмента из прямой в дугообразную и обратно, при помощи пунктов Free line, 
Arc in, Arc out контекстного меню.

Изменение размера и перемещение многоугольника или ломанной линии с помощью ручек захвата, которые 
отображаются после выбора фигуры.
Чтобы добавить угол, щелкните правой кнопкой мыши в том месте, где хотите его добавить и выберите пункт 
Add handle из выпадающего контекстного меню.
Чтобы удалить угол, щелкните по нему правой кнопкой мыши и выберите пункт Delete handle из выпадающего 
контекстного меню.
Чтобы изменить форму линии от прямой к дуге или обратно, щелкните по нему правой кнопкой мыши и 
выберите требуемый вариант из Free line, Arc in, Arc out в выпадающем контекстном меню.

Изменение порядка наложения

Если одна из ваших аннотаций закрыта другой, щелкните правой кнопкой мыши по ней и используйте пункт Z-
Order контекстного меню и далее Bring to front, чтобы переместить аннотацию на передний план, или Send to 
Back, чтобы переместить аннотацию на задний план.
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3. Введение в библиотеки

Символы компонентов образуют очень важную часть уровня проекта. Для удобства, символы собраны вместе в 
библиотеки символов. Вы можете редактировать и создавать свои собственные новые символы и библиотеки.
Маловероятно, что существующие библиотеки символов будут содержать все символы о которых вы могли бы 
только мечтать. Поэтому, эта программа была разработана таким образом, чтобы позволить вам самим легко 
создавать свои собственные символы.

Выбор библиотек

Перед тем, как использовать библиотечные символы, необходимо выбрать соответствующую библиотеку для 
использования. Это делается с помощью библиотечных опций в меню библиотек, которое вызывается после 
нажатия кнопки Libraries....

Этот диалог показывает список используемых библиотек (Libraries in Use). Перед тем, как редактировать 
библиотеку или извлекать из ней символ, необходимо добавить её в этот список. 
Чтобы добавить библиотеку в этот список нажмите на кнопку Add(добавить). После этого появится диалог 
выбора файла. Выберите индексный библиотечный файл (с расширением .idx) или файл базы данных (с 
расширением .mbd). После этого выбранная библиотека будет добавлена в список.
Для удаления библиотеки из списка, нажмите на библиотеку в списке, чтобы выбрать её, а затем нажмите на 
кнопку Remove(удалить). Эта команда не удаляет файл фактически и библиотека по-прежнему доступна для 
других. Для фактического удаления библиотеки используйте проводник Windows (Windows Explorer).
Фактически удаленные библиотеки будут присутствовать в списке, пока не будут удалены командой Remove. 
Если библиотека не существует, то вы будете проинформированы каждый раз при чтении индекса библиотеки. 
Это обычно происходит тогда, когда TinyCAD стартует и перечитывает опции в меню выбранных библиотек.
Вы можете посмотреть содержимое библиотеки дважды щелкнув по имени библиотеки в списке или выбрав 
библиотеку и нажав на кнопку Edit(редактировать).
Обновление библиотеки преобразует её из старого формата в новый формат базы данных Microsoft Access. Этот 
формат создает файл чуть большего размера, однако это позволит TinyCAD иметь больше возможностей в 
будущем.
По состоянию на TinyCAD 1.90.00, опция Tidy больше не требуются для нового формата библиотек и поэтому 
была удалена из диалога.
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Редактирование и печать библиотеки 

Используйте диалог выбора библиотеки для редактирования. После выбора вы увидите новое окно с 
миниатюрами символов библиотеки. Если библиотека новая и не содержит символов, то окно будет пустым.

Используйте окно редактирования библиотеки для:
 просмотра всех символов библиотеки;
 добавления новых символов в библиотеку;
 удаления и переименования символов в библиотеке;
 редактирования атрибутов и имени символов;
 перемещения символов из одной библиотеки в другую;
 экспорта символов в XML файл;
 импорта символов из XML файла в библиотеку.

Вы можете выбирать символы в библиотеке щелкая по ним. После выбора Вы можете использовать меню 
Symbol для редактирования или удаления символа. Также можно щелкнуть правой кнопкой мыши по символу, 
чтобы вызвать контекстное меню, которое является коротким путем для перехода в меню Symbol.
Используйте меню Symbol или контекстное меню для добавления нового символа в библиотеку.
Чтобы редактировать символ, дважды щелкните по нему.

Редактирование и добавление символов

Символы создаются из нормальных объектов, найденных на панели инструментов. Они могут содержать любой 
из этих объектов, кроме других символов.
Если символ действительно содержит любые объекты со специальными функциями (например, объект питания 
или провода), то эти объекты будут рассматриваться как аннотации. Все их специальные функции теряются при 
использовании в символе.
Чтобы изменить существующий символ, сначала выберите библиотеку, которую нужно изменить в меню 
библиотек.
Затем выберите символ для редактирования, щелкнув по нему. Откроется окно редактирования с размещённым 
в нём символом. Символ можно редактировать таким же образом, как редактируется нормальный проект, за 
исключением того, что в символ нельзя вставлять другие символы, однако можно добавлять выводы.
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После завершения используйте пункт Save(сохранить) меню File(файл) или просто закройте окно. Это позволит 
сохранить новый символ обратно в библиотеку. Диалоговое окно автоматически запоминает детали по 
выбранному символу. Если вы ввели здесь имя отличное от предыдущего, то под новым именем будет 
сохранена копия символа. Если ввести имя существующего символа, то он заменит старый символ в 
библиотеке.

Выводы символов

Соединения с символом осуществляется через выводы. Важно правильно выбрать тип каждому выводу. Это 
позволит корректно осуществлять генерацию Netlist(список соединений для печатной платы) и проверять 
правила проектирования. Выводы также позволяют корректно работать признаку part-per-package(секций в 
упаковке).
Правила проектирования определяют тип каждого вывода и могут генерировать соответствующее сообщение, 
если вы сделали ошибку в проекте. Например, при проверке можно обнаружить, что к входу не подключено ни 
одного выхода. Для этого вы должны назначить выводам правильные типы.

Несколько секций в упаковке

Некоторые полупроводники имеют нескольких секций в упаковке. Вы можете определить разные выводы в 
упаковке и, опционально, выводы для каждой секции символа. При вставке символа в проект, вы можете 
выбрать, какую секцию использовать.
Есть два типа символов с несколькими секциями в упаковке. Это однородные и неоднородные символы:
1. Секции однородного символа имеют такие же контуры, но разные номера выводов для каждой секции в 
упаковке.
2. Неоднородный символ имеет различные контура и номера выводов для каждой из секций в упаковке.
Используйте однородных символы, когда секции являются взаимозаменяемыми. Используйте неоднородные 
символы, когда разные секции представляют собой различные аспекты символа и, следовательно, не могут быть 
взаимозаменяемыми.
Перед созданием символа необходимо решить к какому типу он будет относится, а затем использовать пункты 
Homogeneous(однородные) или Heterogeneous(неоднородные) в меню Library или, при помощи правой кнопки 
мыши, установить эти же пункты на вкладке в нижней части экрана. Эти опции будут работать только до того 
момента, как вы установите количество секций в упаковке.
Затем используйте опцию Set part per package в меню Library или щелчок правой кнопкой мыши по вкладки в 
нижней части экрана. Эта опция позволит выбрать количество секций в упаковке для символа. Используйте 
вкладки в нижней части экрана для редактирования отдельных секций.
Для однородного символа, любое редактирование рисунка одной секции будет применено для других секций. В 
неоднородном символе отдельные секции могут иметь различный рисунок.

Пример микросхемы 7402, имеющей 4 секции в одной упаковке

Например, м/сх 7402 имеет четыре секции в упаковке. Эти секции имеют индексы A, B, C и D. Этот символ  
однородный и поэтому единственным различием между секциями будет нумерация выводов.
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Создание новой библиотеки символов

Создание новой библиотеки не вызывает особых проблем. Используйте кнопку New(новая) в диалоге 
редактирования библиотеки. Пустая библиотека будет создан с именем, которое вы укажете.
Дважды щелкните по библиотеке, чтобы отредактировать его. Теперь Вы можете добавить в неё ваш первый 
новый символ.

Свойства символа

Этот диалог используется для редактирования имен символов и атрибутов установленных по умолчанию. 
Теперь, начиная с версии 2.00.00, вы можете дать символу более одного имени. С каждым именем символа 
может быть связано множество различных атрибутов по умолчанию. Нет каких-то ограничений на имя символа. 
В нём можно использовать верхний или нижний регистр, а также пробелы.
Вы можете получить доступ к этому диалогу двумя способами. В первом случае можно щелкнуть правой 
кнопкой мыши по значку символа и в выпадающем контекстном меню выбрать Symbol Properties. Во втором 
случае диалог появится после завершения редактирования символа и закрытия окна.
Если вы хотите, чтобы символ в библиотеке имел больше одного имени, используйте кнопку Add name. Каждое 
имя имеет свой собственный набор атрибутов по умолчанию и описание. Вы можете использовать 
дополнительные имена для того, чтобы дать различные атрибуты для одного основного символа. Например,  
можно определить различные имена для конденсаторов, для различных футпринтов, которые вы используете в 
своей программе PCB. 
Вы также можете добавить любое количество дополнительных параметров символа. Для добавления и удаления 
параметров используйте кнопки Add(добавить) и Delete(удалить). Однако вы не можете удалить параметры 
name(имя) или reference(позиционное обозначение), так как они всегда требуются для символа.
Вы должны ввести для символа букву позиционного обозначения, принятую по умолчанию. Этот текст 
появляется в поле позиционного обозначения символа, когда он впервые извлекается из библиотеки. Помните, 
что позиционное обозначение, как правило, представлена одной буквой и символом '?'. Например: U?
Дополнительные параметры могут быть использованы для хранения любой необходимой информации. 
Например, информация о компоновке печатной платы или SPICE информация. Эту информацию пользователь 
может видеть в процессе разработки символа. Параметры также записываются в файл списка соединений (см.  
меню Special).
Нажмите кнопку ОК для сохранения символа, или кнопку Cancel(отмена), чтобы выйти без изменения символа.
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4. Печать проекта

Как только ваш проект нарисован, его можно распечатать на любом принтере, который поддерживается 
Windows.

Параметры печати доступные в меню File, подробно описаны в разделе 8.
Если проект не возможно разумно разместить на одной странице, его можно распечатать частями на нескольких 
страницах. То есть, каждая страница будет содержать различные части проекта. После того как все страницы 
будут напечатаны, их можно склеить, так чтобы образовалась единая схема проекта.
Также можно всю схему распечатать на одном странице. Если выбрать опцию Fit on a singl page, то 
автоматически будет выбран масштаб, позволяющий распечатать весь проект на одной странице.
Для получения наилучшего результата при печати небольших проектов, используйте опцию Printer Setup в 
диалоге Page Setup. Это будет гарантировать, что размеры листа дизайна будут соответствовать выходу 
принтера, и масштабирование не потребуется.
Для получения наилучшего результата на чёрно-белом принтере, используйте печать в черно-белом режиме.
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5. Экспорт в программу PCB

TinyCAD имеет возможность создавать список соединений (netlist) для передачи его в программу разводки 
печатной платы. Однако, чтобы это работало, вы должны правильно использовать программу TinyCAD:

1. Правильно используйте провода и символы;
2. Добавьте атрибуты Package(упаковка) в символы;
3. Экспортируйте список соединений в формате, совместимом с вашей программой разводки печатной 

платы.

Правильное использование проводов и символов

Чтобы программа TinyCAD "поняла" схему, вы должны использовать инструмент Wires(провод) для прокладки 
электрических связей в вашей схеме. Если бы вы использовали для соединений ломанную линию, то TinyCAD
не "поймёт" этого и не экспортирует таких соединений в Netlist. Чтобы убедиться в том, что ваша схема 
подключена правильно, используйте опцию Check Design Rules(проверка правил проектирования) в меню 
Special, прежде чем экспортировать список соединений.
Провода необходимо подключать строго к символам выводов. Обычно это делается автоматически. При 
перемещении провода рядом с символом, точки подключения отмечаются маленьким красным кружком, 
указывая что к ним можно подключиться. Не подключенные выводы не будут указаны в списке соединений, 
передаваемом в печатную плату.

Добавить атрибуты Package во всех символах

При экспорте списка соединений, этот атрибут вносится в список соединений для того, чтобы программа 
разводки PCB "знала", какой футпринт(посадочное место) использовать с символом. Помните, что футприн 
может различаться для  одного и того же символа, установленного в различных местах схемы. Например символ 
конденсатора в одной части схемы может иметь футпринт, отличный от футпринта конденсатора, 
установленного в другой части схемы.

Вы можете отредактировать библиотеки символов таким образом, чтобы каждый символ имел атрибут Package
заполненный по умолчанию.
Например, проект "amp.dsn" имеет заполненный атрибут Package для каждого используемого символа.
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Экспорт списка соединений в формате, совместимом с вашей программой 
разводки

Выберите опцию Create netlist for PCB program(создание списка соединений для программы PCB) в меню 
Special.

Используйте этот диалог для выбора формата выходного списка соединений и имени выходного файла. В 
настоящее время TinyCAD имеет ограниченный набор форматов выходных файлов, однако, скорей всего, в этом 
наборе найдётся подходящий формат, который распознаётся вашей программой разводки печатных плат.
Все форматы файлов текстовые. Так что, если вы хотите увидеть результаты экспорта, то загрузите 
экспортированный файл в блокнот или другой текстовый редактор.
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6. Многолистовые схемы

В TinyCAD есть два способа, которые позволяют расширить сложную схему на несколько листов:
1. Вы можете использовать несколько листов (так же, как листы Excel);
2. Вы можете использовать иерархические рисунки (то есть вставки одного файла в другой чертеж)

Два различных способа могут быть использован в той же схеме.

Использование нескольких листов

Чтобы добавить новый лист, нужно всего лишь щелкнуть правой кнопкой мыши по кнопке Sheet1(лист 1) в 
нижней части экрана и в выпадающем меню выбрать пункт Insert Sheet(вставить лист). Это создаст новый 
чистый лист в том же чертеже.
Все листы одного чертежа должны иметь одинаковый размер страницы, однако, каждый из них может иметь 
свои собственные детали проекта. Когда проект сохраняется, все листы сохраняются в одном и том же файле. 
Это самый простой способ создать несколько схемных листов и очень эффективный для небольших схем.
При создании списка соединения для программы PCB, листы связываются между собой. Любые метки с 
одинаковыми именами считаются связаны на различных листах. Используйте метки, чтобы соединять цепи на 
различных листах.
Разумеется, вы можете удалять и переименовывать листы, щелкнув правой кнопкой мыши по имени листа в 
нижней части экрана. Удаление листа не может быть отменено. Поэтому делайте это осторожно!

Использование иерархической конструкции

Иерархическая система рисования предполагает вставку в основную схему проекта фрагментов схем или даже 
схем других проектов, имеющих как-бы более низкий уровень иерархии. При этом вставляемый фрагмент 
оформлен в виде символа, подобно библиотечному (иерархический блок).
Для создания иерархического блока, вы должны добавить к файлу соответствующей иерархической схемы её 
символ, при помощи команды Special(специальный)->Add Hierarchical Symbol(добавить иерархический 
символ). Это добавит к иерархической схеме  новый специальный лист. В этом специальном листе нарисуйте 
символ для иерархического блока. Если предполагается, что иерархический блок будет иметь внешние 
электрические связи, необходимо на его символе разместить выводы. Эти выводы практически идентичны 
выводам библиотечного символа, в отличие от которых они могут иметь имена, но могут не иметь номеров.
Чтобы осуществить связь между ножками символа и схемой на других листах, используйте метки. Во время 
генерации списка соединений (netlist), любые цепи, помеченные так же как выводы, будут считаться 
электрически связанными с выводами.
Если у вас есть иерархическая символ добавленный в проект, вы можете вставлять его в другие чертежи, как 
иерархический блок. Для этого выберите команду Special(специальный)->Insert Another design as a 
Symbol(вставить другой проект как символ). Это позволит вам выбрать ранее сохраненный проект, как символ, 
связанный с ним.
Встроенный иерархический блок действует так же, как библиотечный символов и может быть вставлен в любое 
место схемы, его можно поворачивать и подключать. Разница лишь в том, что когда генерируется список 
соединений основного проекта, нижний уровень также включается и связывается через выводы.

Использование иерархических конструкций и нескольких листов

Нет никаких специальных требований для применения обоих методов в действительно сложных схемах. Вы 
можете иметь много листов в каждом из файлов, и включать в них столько иерархических блоков, сколько вам 
нужно для создания вашего проекта.
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7. Использование SPICE с TinyCAD 

TinyCAD способен генерировать SPICE - файлы. Однако, пока в TinyCAD не включены готовые библиотеки для
его совместного использования с SPICE симулятором. Эти библиотеки вам придётся создавать самим. 
Чтобы понять, как использовать TinyCAD совместно с симулятором, вы должны разобраться с форматом SPICE 
- файла. В интернете есть много хороших описаний SPICE. И если вы заинтересовались электрическим
моделированием, я предлагаю начать с одного из многочисленных бесплатных движков SPICE, и с его помощью

создать несколько файлов SPICE, прежде чем пытаться создавать свои собственные SPICE библиотеки для
TinyCAD . 

Совет - Помните, вам всегда помогут! 

Создания схем для SPICE симулятора не является тривиальным занятием, но это проще, если вы уже знаете что-
то о SPICE. Если вы в чём-то не можете разобраться, используйте веб-сайт TinyCAD для получения поддержки. 

SPICE система TinyCAD 

TinyCAD генерирует SPICE файлы, используя систему строкового шаблона. Разрешенный символ SPICE 
включает в себя 3 части: 

1. Шаблон Model - это строка, которая вставляется в SPICE файл для каждого компонента в схеме; 
2. Шаблон Prologue - это строка, которая вставляется один раз в верхнюю часть SPICE файла для 

компонентов одного типа; 
3. Шаблон Epilogue - это строка, которая вставляется один раз в нижнюю часть SPICE файла для 

компонентов одного типа. 
Эти три шаблона можно найти на вкладке SPICE, которая находится в диалоговом окне Update Library 
Symbol. Чтобы вызвать это окно, щелкните правой кнопкой мыши по символу в окне с миниатюрами символов
библиотеки и выберите пункт Symbol Properties (свойства символа). 
Схема SPICE должна соответствовать трём основным условиям: 

1. Можно использовать только символы разрешенные в SPICE; 
2. Схема должна содержать специальный символ RUN (который вы должны создать); 
3. Схема должна содержать специальный узел "0", который обязательно должен присутствовать в любой 

SPICE схеме. 
После того, как все эти требования были выполнены, вы можете использовать опцию Create Spice Net List … в
меню Special для создания SPICE файла. 

Строки SPICE шаблона  

После добавления символа в схему, соответствующая строка добавляется в выходной SPICE файл. Эта строка
представляет собой шаблон того, что было добавлено.  
Например, для резистора мы имеем:  

R$(refnum) %(1) %(2) $(NAME) 

Это означает, что при выводе этой строки в SPICE файл, вместо элемента % () будет вставлено имя цепи к
которой подключен соответствующий вывод резистора, а вместо элемента $ () вставлено значение атрибута
Name. Например, если резистор величиной 10K был подключен к цепям 7 и 9, TinyCAD  выведет:  

R3 7 9 10K 

Обратите внимание, как каждый из элементов строки $ () и % () был заменен на информацию цепи. 
Примечание: Наблюдательные, скорей всего, заметили особенность генерации Refnum. Это позиционное
обозначение символа, которое, как правило, представляет из себя что-то вроде R3. Тем не менее, мы включили  
R в шаблон. А произошло то, что строка Refnum шаблона обрабатывается особым образом, согласно которому
собственный символ позиционного обозначения (в данном случае R) удаляется. Это связано с тем, что
встроенная модель резистора в SPICE всегда обозначается символом R. Если мы вдруг обзовём резистор как
Q3, то TinyCAD  по-прежнему выдаст R3, обеспечив правильность выбора модели SPICE. Если мы используем
ссылку типа MyRef, то TinyCAD  выдаст RMyRef.  
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Пролог и эпилог SPICE 

Пролог (Prologue) и эпилог (Epilogue) SPICE для каждого символа имеет одинаковый синтаксис в строке
шаблона модели, за исключением того, что вы может использовать только атрибут расширения ($()синтаксис) и
не можете использовать номера выводов (%() синтаксис). 
Пролог и эпилог будет включен только если они не совпадает с любым другим уже включенным. Поэтому вы
можете многократно вставлять любой символ в проект, не опасаясь многократного дублирования пролога с
эпилогом. 
При помощи приоритетов, можно установить порядок, в котором прологи и эпилоги будут вставлены в
выходной файл. Приоритет обозначается числом рядом со строкой шаблона в диалоге Update Library Symbol. 
Пролог с нулевым приоритетом будет включен в файл первым, а затем все остальные прологи в порядке
следования приоритетов от 1 до 9. 
Для эпилога всё происходит наоборот. Т.е. эпилог с нулевым приоритетом будет включен в файл последним, 
перед ним будет вставлен эпилог с приоритетом 1 и так далее до эпилога с приоритетом 9. 
По умолчанию, для пролога и эпилога устанавливается средний приоритет равный 5. 

RUN узел SPICE 

Вкладка Attributes  типичного узла RUN 
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Вкладка SPICE типичного узла RUN 

Обычно SPICE файл содержит не только схему, но и команды для SPICE симулятора. 
Вы можете вставлять эти специальные команды в начале и конце файла с помощью специального SPICE 
символа, который называется узлом Run. Так как этот SPICE не включен в TinyCAD, вам придется создать его
самостоятельно. 
Узел RUN является нормальным символ TinyCAD, за исключением того, что он не имеет выводов и SPICE 
модели. Зато у него есть SPICE шаблоны пролога и эпилога. 
Вы должны установить нулевой приоритет для его пролога и эпилога. Это означает, что его пролог всегда будет
идти первым (при условии отсутствия других узлов RUN), а эпилог последним. 
Этот специальный символ будет распространен на параметры времени прогона и поместит правильный эпилог
в SPICE файл. 
Если вы хотите добавить свою специальную строку в начале файла, просто добавьте её в прологе узла RUN - 
помните она будет распространяться на любой ваш атрибут $(). 
Вы должны поместить один узел RUN на каждую схему и это добавит правильные строки для движка SPICE. 
В своей библиотеке вы можете иметь более одного RUN узла, каждый из которых инструктирует SPICE для
выполнения несколько различных операций, однако, вы не должны размещать более одного узла RUN в одной
схеме. 
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Цепь "0" 
  
Каждый схема SPICE требует наличие цепи с именем 0. В SPICE эта цепь называется узлом и является общим

проводом (землёй) для схемы. Вы должны убедиться в том, что одна из ваших цепей связана с цепью
помеченной как 0. 
В TinyCAD это делается при помощи объекта присвоения имени цепи. Присвоить имя цепи можно одним из
двух способов: 

1. Используя метку цепи (которая выглядит как на панели инструментов). Любая связь с меткой
используется для присвоения соответствующего имени цепи SPICE; 

2. Используйте объект питания (который выглядит как на панели инструментов).   Любая связь с
объектом  питания будет использоваться для присвоения соответствующего имени цепи SPICE. 

Для создания специального символа "0", просто поместите символ питания со значением 0. 

Генерация SPICE файла 

После того как вы выполнили все перечисленные требования для SPICE файла, его генерация становится
простым делом. Для этого зайдите в меню Special и выберите Create Spice Net List... (Создать SPICE файл). 
В диалоге создания SPICE файла отсутствуют какие-то опции. Потому, для этой цели, вы должны использовать
специальный узел RUN. Это дает вам максимальную гибкость генерации SPICE файла. 

Продвинутая генерация SPICE файла с условными операторами 

Для действительно сложного применения SPICE движка TinyCAD вы можете использовать условные операторы
в шаблонах. Существуют три основных типа условных операторов, а именно: 

1. Проверить, является ли атрибут символа определённым; 
2. Проверить, является ли атрибут символа пустой строкой; 
3. Проверить, является ли вывод символ подключенным. 

Для каждого условного оператора, вы можете определить истинные (true string) и ложный (false string) строки. 
Если условие истинно, то макрос будет иметь значение истинной строки и весь макрос будет заменен на
истинную строку, в противном случае макрос будет заменен на ложную строку. 
Вы можете вставлять один условный макрооператор внутри другого. Для этого не требуется какого-то
специального синтаксиса. 
Синтаксис условных операторов: 

?( defined( attributename ), true string, false string ) 
?( not_defined( attributename ), true string, false string ) 
?( empty( attributename ), true string, false string ) 
?( not_empty( attributename ), true string, false string ) 
?( connected( pinnumber ), true string, false string ) 
?( not_connected( pinnumber ), true string, false string ) 

Если вы хотите разместить знак вопроса ("?") в шаблоне, то вы можете добиться этого, помещая перед ним
символ "\". 
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8. Описание меню

Меню File
В меню File, структура которого изображена на рисунке ниже, сгруппированы команды отвечающие за 
операции с файлами, операции импорта/экспорта, описание проекта, а также печать созданных схем. 
Рассмотрим детально эти команды: 

 New или Ctrl+N или  — создать новый проект. При этом открывается окно нового проекта, но те 
проекты, которые до этого были уже открыты, также остаются открытыми;

 Open или Ctrl+O или  - открыть ранее созданный и сохранённый проект для редактирования или 
печати. Открытые ранее проекты также остаются открытыми;

 Close - закрыть окно текущего проекта. Если в проект были внесены какие-то изменения, то будет 
предложено сохранить эти изменения;

 Save или Ctrl+S или  - сохранить текущий проект. При этом сохраняется не только схема, но и все 
настройки сделанные для текущего проекта. Если проект новый, то перед сохранением будет 
предложено присвоить ему имя;

 Save As — действует аналогично предыдущему пункту, но имя файла запрашивается в любом случае;

 Design Details — при активизации этого пункта появляется окно Design Details с вкладками Design и 
Guides: 

◦ Design — здесь можно внести различную информацию о проекте, такую как полное название 
проекта (Title), имя автора (Author), название организации в которой работает автор (Organisation), 
номер версии проекта (Revision), название текущего документа (Document), номер текущего листа 
(Number of sheets) и текущую дату (Date). В отличие от многих подобных программ, страдающих 
излишним снобизмом, вся это информация может вводится как латиницей, так и кириллицей, как 
это показано в примере на рисунке. Информация о проекте отображается в соответствующих 
графах штампа, расположенного в правом нижнем углу листа проекта. Эту информацию можно 
скрыть, если убрать галочку напротив строки "Display Details";

◦ Guides — здесь можно описать буквенно-цифровые координаты, наносимые на листе проекта. 
Видимость координат включается установкой галочки напротив строки "Show design guides".

 Import или Ctrl+I — импортировать и вставить в текущий проект любой другой ранее сохранённый 
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проект.  Используя этот пункт, на листе текущего проекта можно разместить  другой, сохранённый 
ранее, проект. Изображение импортируемого проекта, прорисованное красными линиями, следует за 
курсором мышки и может быть размещено в текущем проекте щелчком её левой кнопки. Щелчок 
правой кнопкой мышки отменяет импорт;

 Save as bitmap — сохранить полное изображение текущего проекта или только выбранную его часть в 
виде графического PNG или EMF файла;

 Print — распечатать проект на принтер. Если размер схемы слишком велик, то её можно распечатать на 
нескольких листах или, выбрав опцию "Fit on a sibgle page", изменить её масштаб для печати на один 
лист;

 Print Preview — посмотреть как проект будет распечатан ещё до того, как данные будут переданы на 
принтер;

 Page Setup - активизирует окно "Set Page Size", позволяющее выбрать размер листа проекта. В области 
окна "Page Size" можно выбрать один из четырех стандартных размеров листа - A4, A3, A2 и A1. Если 
не один из стандартных размеров не подходит, то можно определить нестандартные размеры листа, 
указав в области окна "Size" требуемую ширину (Width) и высоту (Height). Все размеры указываются в 
мм. Кроме выбора размера листа, можно выбрать ориентацию его длинной стороны, которая может 
быть или вертикальной (Portrait), или горизонтальной (Landscape). При необходимости, можно 
оптимизировать размер листа проекта под используемый принтер. Для этого необходимо вызвать 
стандартное окно настройки принтера, щёлкнув левой кнопкой мышки по  кнопке "Printer Setup". В 
окне настройки принтера необходимо выбрать тип принтера, а также желаемый размер листа и его 
ориентацию. После подтверждения настройки принтера будет выбран размер листа определённый 
настройками принтера (Printer Setup). Выбранный размер листа будет сохранён в текущем проекте и 
будет автоматически установлен при последующем его открытии;

 Exit — выйти из программы и удалить программу из оперативной памяти.
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Меню Edit

Undo(отменить)
Этот пункт отменяет последнее действие или последовательность действий, выполненных в проекте. Например, 
вы можете отменить последнюю операцию рисования или отменить последнее удаление.
Вы можете выбрать эту опцию повторно. Это приведет к более отдаленному состоянию проекта.
Противоположным действием обладает пункт меню Redo.

Redo(вернуть)
Этот пункт является противоположностью пункта Undo. Если выбрать Undo, то последнее действие в проекте 
будет отменено. Если после этого вы измените своё мнение, то можете отменить Undo, выбрав пункт Redo.

Cut(вырезать)
Этот пункт позволяет перемещать выбранные части проекта в буфер обмена. После перемещения вы можете 
вновь вставлять их в другую часть проекта снова и снова. Вы также можете вставлять вырезанные объекты в 
другие приложения Windows, такие как Microsoft Word.

Этот пункт меню дублируется кнопкой Cut  на панели инструментов.

Copy(скопировать)
Эта опция позволяет копировать выбранные части проекта в буфер обмена. После копирования вы можете 
вновь вставлять их в другую часть проекта снова и снова. Вы также можете вставлять скопированные объекты в 
другие приложения Windows, такие как Microsoft Word.

Этот пункт меню дублируется кнопкой Copy  на панели инструментов.

Paste(вставить)
Этот пункт позволяет ранее скопированные или вырезанные части проекта вставить в текущий проект.
Как только этот пункт был выбран, вставляемый объект появится и будет привязан к указателю мыши. Чтобы 
вставить его, щелкните левой кнопкой мыши, чтобы отменить вставку, щелкните правой кнопкой мыши.

Copy to...(копировать в ...)
С помощью этого пункта вы можете сохранить только часть текущего проекта. Затем эта часть может быть 
загружен как независимый проект, либо вставлена в другой проект.
Только выбранные объекты будут записаны в выходной файл. В диалоговом окне вам будет предложено ввести 
имя файла для сохранения выбранной части проекта. Помните, что в этом диалоге можно выбрать другой путь 
для сохранения выбранной части проекта.

Zoom In(увеличить)
Увеличить размер чертежа, чтобы показать его более подробно. Тоже самое вы сделать при помощи мыши с 

колесом прокрутки или с помощью инструмента Zoom  на панели инструментов.

Zoom Out(уменьшить)
Показать чертеж с меньшими подробностями. Тоже самое вы сделать при помощи мыши с колесом прокрутки 

или с помощью инструмента Zoom  на панели инструментов.
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Меню Library

Libraries... (библиотеки)

Эта опция выводит на экран диалоговое окно, которое позволяет создавать и редактировать библиотеки.

Список библиотек, в диалоговом окне Library Setup, вызывается при помощи опции Libraries... в меню 
Library. Вы можете добавить (Add) или удалить (Remove) библиотеки этого списка при помощи 
соответствующих кнопок в правой части диалогового окна.
Кнопка Add в диалоге позволяет найти недостающую библиотеку. При нажатии этой кнопки вызывается диалог 
выбора файла. Выберите индексный файл (файлы с расширением .idx), относящейся к библиотеке, которую вы 
хотите использовать. Затем добавьте эту библиотеку в список.
Кнопка Remove удаляет библиотеку из списка, но не удаляет её физически! Выберите библиотеку, которую вы 
хотите удалить, щелкнув по её названию в списке и нажмите кнопку Remove.
Кнопка Edit позволяет: 

 Смотреть и печатать миниатюры символов;
 Добавлять новые символы в выбранную библиотеку;
 Редактировать существующие символы в библиотеке.

Эти операции осуществляются при помощи специального меню Symbol, доступного только при просмотре 
эскизов символа в окне редактирования библиотеки. 
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Меню Symbol

New Symbol (новый символ)
Этот пункт меню добавляет новый символ в текущую библиотеку. После его выбора откроется окно 
редактирования и вы можете приступить к разработке символа в нем. Для сохранения символа в библиотеку 
используйте пункт Save меню File.
Вы можете использовать любой из ранее рассмотренных инструментов для создания нового символа. Внутри 
символа элементы принципиальной схемы (такие как провода или шины) теряют особое значение и все 
нарисованные объекты рассматриваются как аннотации. Например, если вы поместите провод в символ, то он 
не будет рассматриваться как электрическое соединение, когда символ будет помещён в проект. Единственным 
графическим объектом, который не теряет своего назначения, является вывод.
Используйте кнопку Add Symbol Pin (добавить вывод) для вставки вывода в символ.
Новый символ не появится в библиотеке пока не будет сохранен.

Edit Symbol (редактировать символ)
Выберите миниатюру символа в окне редактирования библиотеки, а затем используйте этот пункт меню 
Symbol, чтобы изменить его. После этого символ загружается и становиться доступным для редактирования. 
Смотрите пункт New Symbol для дополнительной информации о редактировании символов.
Отредактируйте символ а затем сохранить его под другим именем. Вы также можете использовать эту опцию 
для копирования символов. 

Delete Symbol (удалить символ)
Выберите миниатюру символа в окне редактирования библиотеки, а затем использовать этот пункт меню, чтобы 
удалить его. Удаление отменить невозможно, однако, у вас есть возможность не сохранять изменения после  
закрытия окна редактирования библиотеки.
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Меню Library в режиме создания/редактирования символа

Set parts per package (установить число секций в упаковке)

Этот пункт меню используется для создания многосекционных 
библиотечных символов. После его активизации появляется 
диалоговое окно, в котором нужно указать количество секций в 
одной упаковке. По умолчанию считается, что каждая 
физическая упаковка содержит одну секцию. Т.е. В одном 
корпусе содержится один резистор, один конденсатор, один 
транзистор и т. д. Секции в упаковке обозначаются буквами 
латинского алфавита. Первая секция буквой A, вторая буквой B, 

третья C и т.д. В окне редактирования для каждой секции отводится отдельная вкладка — Part A, Part B, Part C и 
т. д.
 
Homogeneous Symbol (однородный символ)
Heterogeneous Symbol (неоднородный символ)
Перед созданием символа необходимо решить к какому типу он будет относится, а затем использовать пункты 
Homogeneous(однородные) или Heterogeneous(неоднородные) в меню Library или, при помощи правой кнопки 
мыши, установить эти же пункты на вкладке в нижней части экрана. Эти опции будут работать только до того 
момента, как вы установите количество секций в упаковке.
Затем используйте опцию Set part per package в меню Library или щелчок правой кнопкой мыши по вкладки в 
нижней части экрана. Эта опция позволит выбрать количество секций в упаковке для символа. Используйте 
вкладки в нижней части экрана для редактирования отдельных секций.
Для однородного символа любое редактирование рисунка одной секции будет применяться для других секций. 
В неоднородном символе отдельные секции могут иметь различный рисунок.
Если символ однородный, то при выборе новой секции, которая ещё не была определена, вам будет предложено 

скопировать выводы из текущей секции в новую. 
Выберите Да, если хотите иметь аналогичное 
расположение выводов для каждой секции в 
упаковке. Лучше так и сделать. После того, как 
выводы будут скопированы, вам останется только 
отредактировать их номера. Для этого щелкните 
по нужному выводу  при помощи левой кнопки 
мыши и измените номер в поле Number (номер) 
всплывающего меню Pin Tool Options.

Add Symbol Pin (добавить вывод) 

Кнопка Add Symbol Pin  расположена на панели инструментов и активна только при редактировании  
библиотечного символа.
Вывод символа представляет из себя короткую красную линию с цифровым номером. Конец вывода, 
предназначенный для подключения провода, отмечен маленьким серым квадратиком. Этот конец иногда 
называют “горячим”. Другой конец вывода обычно совмещается с контурной линией символа. Каждому выводу, 
в обязательном порядке, необходимо присвоить уникальный номер (Number) и при необходимости имя (Name). 
Номер вывода соответствует реальному номеру в упаковке(корпусе) компонента, которому соответствует 
символ. Имя, обычно присваивается в соответствии с функциональным назначением вывода.  Имя и номер 
вывода можно сделать невидимыми (скрыть) сняв соответствующую галочку.
На панели  Pin Tool Options можно выбрать ориентацию вывода. Возможные варианта расположения символа 
относительно вывода:

 Up – символ сверху;

 Down – символ снизу;

 Left – символ слева;

 Right – символ справа.

Выводы могут иметь различный внешний вид (Shape) и назначение:

 Normal – нормальный;

 Dot – инверсия;

 Clock – тактирование;

РАДИОЕЖЕГОДНИК – 2013  Выпуск  28                                      ПЕЧАТНЫЕ ПЛАТЫ 

TinyCAD.  Руководство пользователя 



 Dot Clock – тактирование с инверсией;

 Power - питание;

 Hidden - скрытый;

 Cross - перекрестие.

Внешний вид выводов, за исключением Power, является чисто декоративным и абсолютно не влияет на 
содержимое списка соединений. Выводы Power являются специальными и, как следует из их названия, служат 
для подключения питания. Эти выводы отображаются при редактировании символа, но скрыты (по умолчанию), 
когда символ помещается в схему. После того, как символ помещен в схему, выводы Power автоматически 
подключаются к цепям, имеющим такое же как у них название. Поэтому этим выводам необходимо обязательно 
присвоить имя. Выводы Power очень удобно использовать в многосекционных символах, таких как логические 
элементы, например. В этом случае, при размещении отдельных логических элементов, не нужно задумываться 
о подключении питания, которое будет сделано автоматически.
Скрытые (Hidden) выводы, подобно выводам питания, показываются при редактировании символа и скрыты, 
когда символ размещается в схеме. Тем не менее, не смотря на то, что вывод невидим, к нему возможно 
нормальное подключение. Точка подключения легко обнаруживается, если провод оказывается вблизи 
вскрытого вывода.
Тип вывода можно определить в поле Electrical. Возможные типы:

 Input – вход;

 Output – выход;

 Tristate - двунаправленный, с тремя состояниями; 

 Open Collector – с открытым коллектором;

 Passive – пассивный;

 Input/Output -  двунаправленный;

 Not Connected – не подключен.

Типы соединённых выводов анализируются при автоматической проверке правил проектирования. При этом, 
корректное  указание типов позволит избежать ошибок совместного подключения нескольких выводов. 
Например, когда к одной цепи подключено несколько выходов или когда к одной цепи подключены только 
входы и не одного выхода.
Поле Length (длина) позволяет определить длину вывода в единицах кратных 0.2 мм. Поле Number pos
(позиция номера) позволяет установить позицию номера в единицах кратных 0.2 мм. 
После того, как вывод настроен, его можно разместить на символе, щелкнув левой кнопкой мыши. Размещение 
вывода может быть отменено нажатием правой кнопки мыши. При размещении текущего вывода, номер 
последующего автоматически увеличивается на единицу.

Меню Special

Create Net List for PCB Programs... (создание списка 
соединений для платы)
Файл списка соединений содержит информацию о всех 
соединениях в электрической схеме. Все объекты, 
соединенные между собой входят в один список, называемый 
цепью. Под объектами подразумеваются выводы символом, 
где каждый вывод является независимым объектом. Каждой 
цепи присваивается уникальное имя.
Начиная с версии 1.95.15, программа TinyCAD поддерживает 
несколько форматов списка соединений. Оригинальный 
формат TinyCAD дополнен форматами PADS-PCB, Protel и 
Eagle SCR.
Программы проектирования PCB требуют, чтобы в файле 

списка соединений были указаны футпринты. Для этого в символ необходимо добавить атрибут под названием 
Package(упаковка), значение которого соответствует названию футпринта в программе разработки печатной 
платы.
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Check Design Rules...(проверка правил проектирования)
Этот пункт меню позволяет проверить текущий проект на соответствие правилам проектирования.

Проверка правил позволяет выявить грубые ошибки в 
проекте. Например, такие как соединение вместе двух и 
более выходов. При этом проверка не скажет вам будет ли 
работать ваш проект или не будет. Однако, если в дизайне  
имеются ошибки, то этот инструмент позволит их выявить.
После запуска проверки появится диалоговое окно Check 
Design Rules, где каждое проверяемое правило может быть 
включено или выключено перед тестом.
Проверка проекта начнётся после щелчка по кнопке 
Check(проверка). Кнопка Cancel(отменить) позволяет 
отменить проверку. 
После проверки все обнаруженные ошибки отмечаются на 
схеме специальными маркерами в виде красных кружочков. 
Кроме этого, выводится текстовый список ошибок. При 
нажатии на любой элемент списка, соответствующая 
ошибка перемещается в центре окна проекта. А с другой 
стороны, если щелкнуть левой кнопкой мыши по символу 
ошибки в схеме, одновременно будет выбрана 
соответствующая строка в списке ошибок.  
После исправления ошибок можно произвести повторную 
проверку, нажав кнопку Re-check в списке ошибок.
Если ошибки не будут обнаружены, то появится пустой 
список ошибок. Этот список можно закрыть путем нажатия 

на кнопку Close.
Маркеры ошибок можно удалить. Однако это не означает удаление самой ошибки.

Generate Symbol References (генерация позиционных обозначений)
Этот пункт меню автоматически изменяет 
позиционные обозначения символов компонентов в 
проекте. Это  освобождает вас от необходимости 
проделывать эту операцию вручную.
После того, как этот пункт выбран, появится 
диалоговое окно Generate Symbol References, в 
которым предлагаются различные опции для 
настройки процедуры присвоения позиционных 
обозначений. При помощи опций Add References и 
Remove References вы можете добавлять или удалять 
позиционные обозначения, соответственно. Удаление 
позиционных обозначений может быть полезным, 
если вы хотите интегрировать одну конструкцию в 
другую.
При помощи опции All References вы можете 
применить изменения ко всем символам схемного 
проекта. Используйте эту опцию, если вы еще не 
создали конечного устройства на основе своего 
проекта или не передавали копию проекта другим.
Вы можете выбрать опцию Un-numbered References
для того, чтобы применить изменения только к 
компонентам не имеющих позиционных обозначений. 
Это гарантирует, что нумерация будет применена 
только к символам имеющих вопросительный знак '?' в 
позиционном обозначении. Используйте эту опцию, 

если вы вносите изменения в существующий проект и хотите оставить неизменными позиционные обозначения 
присутствующих ранее компонентов.
При помощи опции References matching вы можете применить изменения только к позиционным обозначениям 
совпадающих с указанным. Это относится ко всем позиционным обозначениям, соответствующим указанному, 
даже если раньше это позиционное обозначение было назначено. Используйте эту опцию для нумерации 
определённого типа символов, например конденсаторов, без изменения нумерации любых других символов.
При помощи опции Default start value вы можете разрешить программе использовать стартовое значение 
позиционного обозначения принятое по умолчанию (обычно 1) или же при помощи опции Start at value самим 
определить стартовое значения для позиционного обозначения.
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После того, как вы нажмете кнопку ОК, все выбранные настройки будут применены к проекту. Если была 
выбрана опция Remove References, то все применённые позиционные обозначения будут возвращены к виду с 
вопросительным знаком '?' вместо значения.
Вы можете выбрать Cancel (отмена), чтобы не применять выбранных настроек к проекту.

Create Parts List (создать список деталей)
Этот пункт меню создает список всех компонентов, используемых в проекте. Список сортируется по 
буквенному символу позиционного обозначения, и поэтому все компоненты одного и того же типа перечислены 
вместе.
По существу, это BOM - Bill of material, т. е. список компонентов, которые должны быть куплены для 
изготовления конструкции.
Список компонентов выводится в простой текстовый файл, который можно редактировать и распечатывать, 
используя программу Блокнот.

Меню Options

Меню Options, структура которого изображена на рисунке ниже, содержит следующие пункты: 

 Settings — активизирует окно Settings с вкладками Grid Settings, Auto wire settings и Backap settings:

◦ Grid Settings — на вкладке можно выбрать единицы измерения и режимы отображения 
координатной сетки. В области Ruler Settigs выбирается система измерения, которая может быть 
метрической, если выбран пункт Units in mm или  дюймовой, если выбран пункт Units in inches. В 
первом случае координаты курсора мышки, а также градуировка линеек, в верхней и правой части 
листа, будут представлены в мм, а во втором случае в дюймах. В области Grid Settings можно 
включить отображение координатной сетки, выбрав пункт Show the Grid. Однако сетка может не 
отображаться, если текущий масштаб отображения слишком мелкий. В этом случае нужно просто 
увеличить масштаб, прокрутив колесико мышки от себя или выбрав пункт Zoom Out в меню Edit. 
Выбор опции Snap to Grid позволяет привязать координаты курсора к узлам сетки, что облегчает 
выравнивание объектов схемы, а также упрощает соединение выводов символов. Опции Normal, 
Fine и User grid spacing позволяют выбрать расстояние между узлами сетки. В случае 
использования встроенной библиотеки символов, лучше использовать нормальное  (Normal) 
расстояние между узлами сетки, равное 2 мм или 0.07874 дюймам. Выбор мелкой  (fine) сетки 
позволяет уменьшить расстояние между узлами вдвое, что может быть удобным при создании 
собственных символов, выравнивании позиционных обозначений, номиналов компонентов или 
нанесении на схему комментариев. При необходимости, выбрав опцию User grid spacing, 
пользователь может выбрать другое расстояние между узлами сетки. Это может оказаться 
полезным при рисовании схем и создании символов компонентов в соответствии с стандартами 
ЕСКД;

◦ Auto wire settings — на вкладке можно включить различные автоматические режимы рисования 
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соединений. Параметр Auto-snap wires позволяет включить автоматический захват соединения, а 
так же определить расстояния до другого соединения или вывода компонента, при котором этот 
захват будет происходить. Параметр Auto-drag wires позволяет разрешить автоматическую 
перерисовку соединения, при перемещении символа компонента. Параметр Auto-place junctions
позволяет включить автоматическое формирование символа соединения, если в одной точке 
сходится более двух соединительных проводов;

◦ Backup setting — на вкладке можно установить параметры автоматического сохранения проекта. 
Чтобы разрешить автоматическое сохранение, достаточно поставить галочку напротив параметра 
Automatic backup every и определить периодичность операции сохранения в минутах (minutes).   

 Colours — активизирует диалоговое окно Define colours, которое показывает цвета, используемые для 
отображения различных объектов текущего проекта. В настоящее время функция изменения цвета 
доступна для связей (Wire), соединений (Junction), не подключенных выводов (No connect), имён цепей 
и номеров выводов (Power), шин (Bus), выводов компонентов (Pin) и заднего фона (Drawing 
background). Чтобы изменить цвет для любого объекта, достаточно щелкнуть левой кнопкой мышки по 
текущему цвету и выбрать новый. Чтобы вернуть цвета к первоначальному состоянию, достаточно 
щёлкнуть левой кнопкой мышки по кнопке “defaults”;

 Show Position — включить/выключить отображения текущей координаты курсора мышки;

 Snap to Grid - включить/выключить привязку курсора к узлам координатной сетки. Данный пункт 
дублирует опцию Settings => Grid Settings => Snap to Grid меню Options и является более коротким 
вариантом управления этой опцией. Выбор этой опции приводит к тому, что позиция курсора 
фиксируется по узлам сетки, что облегчает выравнивание объектов. Также это гарантирует, что при 
попытке соединения провода с символом соединение установится правильно. По этой причине 
желательно, чтобы привязки к сетке была всегда включена. В противном случае, при попытке 
подключения провода к символу будет очень трудно совместить провод и точку подключения. В 
результате неточного совмещения пострадает внешний вид схемы, а также не будет осуществлена 
требуемая электрическая связь. С привязкой к сетке эта проблема отпадает и соединение 
осуществляется гораздо проще;

 Repeat Directions — вызывает подменю опций направления нумерации выводов вновь создаваемых 
или редактируемых символов компонентов. Опции Name Increment/Name Decrement определяют 
увеличение/уменьшение цифрового индекса имени (Name) вывода компонента. Опции Pin 
Increment/Pin Decrement определяют увеличение/уменьшение номера вывода (Pin) компонента;

 Toolbars — вызывает подменю управления видимостью элементов на панели инструментов:

◦ File — включение/выключение видимости иконок, дублирующих пункты меню File и Edit; 

◦ Annotation — включение/выключение инструментов рисования линий и ввода текста;

◦ Block — включение/выключение инструментов операций с выделенными блоками; 

◦ Bus — включение/выключение инструментов рисования шин;

◦ Drawing — включение/выключение инструментов рисования схемы м создания новых 
компонентов;

◦ Simbol — включение/выключение инструментальной панели библиотек.
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9. Панель инструментов

Панель инструментов File

На панели инструментов File присутствуют семь иконок, которые дублируют соответствующие пункты меню 
File и Edit:

  (New) или Ctrl+N  — создать новый проект. При этом открывается окно нового проекта, но те 
проекты, которые до этого были уже открыты, также остаются открытыми;

  (Open) или Ctrl+O - открыть ранее созданный и сохранённый проект для редактирования или 
печати. Открытые ранее проекты также остаются открытыми;

  (Save) или Ctrl+S - сохранить текущий проект. При этом сохраняется не только схема, но и все 
настройки сделанные для текущего проекта. Если проект новый, то перед сохранением будет 
предложено присвоить ему имя;

  (Print) — распечатать проект на принтер. Если размер схемы слишком велик, то её можно 
распечатать на нескольких листах или, выбрав опцию "Fit on a single page", изменить её масштаб для 
печати на один лист;

  (Cut) или  Ctrl+X - переместить выбранные части проекта в буфер обмена. После перемещения вы 
можете вновь вставлять их в другую часть проекта снова и снова. Вы также можете вставлять 
вырезанные объекты в другие приложения Windows, такие как Microsoft Word;

  (Copy) или Ctrl+C - копировать выбранные части проекта в буфер обмена. После копирования вы 
можете вновь вставлять их в другую часть проекта снова и снова. Вы также можете вставлять 
скопированные объекты в другие приложения Windows, такие как Microsoft Word;

  (Paste) или Ctrl+V - вставить ранее скопированные или вырезанные части проекта в текущий 
проект. Как только этот пункт был выбран, вставляемый объект появится и будет привязан к указателю 
мыши. Чтобы вставить его, щелкните левой кнопкой мыши, чтобы отменить вставку, щелкните правой 
кнопкой мыши.

Панель инструментов Annotation

На панели инструментов Annotation(аннотации) присутствует пять иконок:

  (Arc)  - чертить дугу, которая представляет из себя одну четвертую часть эллипса. Дуги 
предназначены только для аннотирования и игнорируются всеми специальными инструментами. См. 
раздел "Добавление текста и аннотаций" для полной информации. Чтобы нарисовать дугу, укажите 
начальную точку с помощью левой кнопки мыши. Затем переместите курсор в конечную точку и 
щелкните еще раз левой кнопкой мыши. Если дуга выгнута не в ту сторону, нарисуйте её в обратном 
направлении или выберите другой тип дуги (arc in или arc out) из или контекстного меню, 
вызываемого правой кнопкой мыши. Можно изменить ширину или цвет линии дуги при помощи 
диалога Polygon tool options, который обычно отображается в правом верхнем углу чертежа. Дуги 
могут быть отредактированы как часть многоугольника или ломаной линии;

  (Ellipse) — чертить эллипс, который используется только для аннотирования проекта. Эллипсы 
предназначены только для аннотирования и игнорируются всеми специальными инструментами. 
Возможно рисование только тех эллипсов, которые могут быть заключены в прямоугольник с ребрами, 
параллельными краям листа проекта. Чтобы нарисовать эллипс, вы должны поместить курсор в один из 
углов предполагаемого прямоугольника, охватывающего эллипс ( этот прямоугольник в 
действительности не отображается ). Затем щелкните левой кнопкой мыши. Теперь, как только вы 
переместите указатель мыши, появится эллипс. Когда эллипс примет нужные очертания, снова нажмите 
левую кнопку мыши. Можно изменить ширину или цвет линии эллипса при помощи диалога Polygon 
tool options, который обычно отображается в правом верхнем углу чертежа. Дуги могут быть 
отредактированы как часть многоугольника или ломаной линии; 

  (Lines Polygon) - чертить многоугольники и ломаные линии, предназначенные только для 
аннотирования проекта. По большей части, они игнорируются всеми специальными инструментами. 
Эти инструменты подробно описаны в разделе "Добавление текста и аннотаций";

  (Rectangle) - чертить прямоугольник, который используется только для аннотирования проекта. 
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Прямоугольники предназначены только для аннотирования и игнорируются всеми специальными 
инструментами. Чтобы нарисовать прямоугольник, поместите курсор в один из углов предполагаемого 
прямоугольника. Затем щелкните левой кнопкой мыши. Теперь, как только вы переместите указатель 
мыши, появится прямоугольник. Когда прямоугольник примет нужные очертания, снова нажмите левую 
кнопку мыши. Можно изменить ширину или цвет линии прямоугольника при помощи диалога Polygon 
tool options, который обычно отображается в правом верхнем углу чертежа;

  (Text) - ввести текст, предназначенный только для аннотирования проекта. Не путайте текстовый 
инструмент с инструментом меток, который используется для присвоения имён цепям. Зачастую 
требуется указать инверсию над текстом. Это можно организовать путем размещения символа ` перед 
каждой буквой, которая нуждается в инверсии. Если целое слово должно иметь инверсию, то символ `  
должен стоять перед каждой буквой слова.
Ввод текста осуществляется в диалоговом окне Text Tool Options. По мере ввода,  текст будет 
появляться рядом с курсором мыши в том виде, в каком он будет размещён в документе. В диалоговом 
окне Text Tool Options можно установить шрифт, цвет и выравнивание вводимого текста. 
Переместите курсор мыши в то место, где хотите этот текст разместить и щелкните левой кнопкой 
мыши.
Вы можете отменить ввод текста, щелкнув правой кнопкой мыши. Текст можно редактировать после 
размещения. Для этого просто щелкните левой кнопкой мыши по тексту и измените его в диалоговом 
окне Text Tool Options. Для завершения, щелкните левой кнопкой мыши в другом месте документа или 
нажмите правую кнопку мыши. Размер текста можно изменять при помощи диалога Text Tool Options
или просто щелкнув по нему, а затем при помощи ручек захвата (выглядят как маленькие квадратики) 
перемещать стороны текста, изменяя его размеры и пропорции.

Панель инструментов Drawing

  (Bus) или F10 — разместить шину. Щелкните левой кнопкой мыши в место, где вы хотите начать 
шину. Проведите линию, щелкая в точках излома левой кнопкой мыши. Чтобы завершить шину, 
щелкните правой кнопкой мыши. После этого можете начать новую шину с другой точки. Обычно, при 
изменении направления, формируется второй сегмент шины повернутый на 90º. В этом режиме два 
отрезка шины отображаются одновременно. Тем не менее, только один сегмент размещается после 
щелчка левой кнопкой мыши. Чтобы разместить второй сегмент, вы должны повторно нажать на левую 
кнопку мыши.
Шину можно редактировать, щелкнув по ней левой кнопкой мыши. При этом, перетягивая сегменты, их 
можно проложить под углом, отличным от  90º. Шину можно дублировать при помощи комбинации 
клавиш Ctrl-U;

  (Bus join) или F9, F8 – разместить шинный вход, показывающий подключения провода к шине. 
Существуют два типа шинного входа, которые позволяют подключаться к шине из любого возможного 
направления.
Чтобы разместить шинный вход, нажмите одну из соответствующих иконок на панели инструментов. 
Переместите шинный вход в требуемое место и разместите его щелкнув левой кнопкой мыши. После 
завершения размещения выберите новый инструмент или щелкните правой кнопкой мыши.
Входы шины нельзя изменять, но можно перемещать и удалять;

  (Bus name) или F7 – разместить имя шины, обозначающее её основные свойства. Это может быть 
количество проводников в шине или её имя или и то и другое вместе. Зачастую необходимо иметь 
символ инверсии над буквами имени шины. Инверсию можно вводить размещения символ ` перед 
каждой буквой , которая нуждается в инверсии. Если целое слово должно иметь инверсию, то символ `  
всеравно необходимо ставить перед каждой буквой слова. Ввод имени осуществляется в диалоговом 
окне BusName Tool Options. По мере ввода,  текст имени будет формироваться рядом с курсором мыши 
в том виде, в каком он будет размещён в документе. Переместите этот текст в нужное место шины при 
помощи мыши и щелкните левой кнопкой. Ввод текста можно отменить, щелкнув правой кнопкой 
мыши.
Имя шины можно редактировать после размещения. Для этого щелкните левой кнопкой мыши по 
тексту, который будет редактироваться. На экране появится окно с оригинальным текстом в нем. Теперь 
Вы можете изменять его по мере необходимости. После завершения, щелкните левой кнопкой мыши на 
другом объекте или нажмите правую кнопку мыши.
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Панель инструментов Block

  (Move Block) – Переместить часть проекта. При использовании этой опции, проводные соединения 
не сохраняются. Если вы хотите сохранить соединения, то используйте иконку Drag Block (перетянуть 
блок).
Выберите область, которую хотите переместить, нарисовав вокруг неё прямоугольник выбора. Для 
этого щелкните левой кнопкой мыши с одного края требуемой области, а затем переместите курсор в 
другой край, так чтобы охватить все элементы. После этого нажмите левую кнопку мыши еще раз. 
Выбранная область будет выделена. Теперь можете переместить её в нужное место проекта и 
разместить при помощи левой нопки мыши.
Вы можете отменить перемещение, щелкнув правой кнопкой мыши;

  (Drag Block) - Перетащить часть проекта, сохранив соединений, выполненные при помощи 
проводов . Все провода и ишины, которые частично заходять в область выбора, остануться на месте. 
Соединения проводом с символами будут сохранены. Это позволяет объектам быть перемещённым без 
ущерба для соединений.
Выберите область, которую хотите перетащить, нарисовав вокруг неё прямоугольник выбора. Для этого 
щелкните левой кнопкой мыши с одного края требуемой области, а затем переместите курсор в другой 
край, так чтобы охватить все элементы. После этого нажмите левую кнопку мыши еще раз. Выбранная 
область будет выделена. Теперь можете перетащить её в нужное место проекта и разместить при 
помощи левой нопки мыши.
Вы можете отменить перетаскивание, щелкнув правой кнопкой мыши;

  (Duplicate Block) - Сделать копию части проекта, чтобы разместить её в другом месте проекта.
Выберите область, которую хотите перетащить, нарисовав вокруг неё прямоугольник выбора. Для этого 
щелкните левой кнопкой мыши с одного края требуемой области, а затем переместите курсор в другой 
край, так чтобы охватить все элементы. После этого нажмите левую кнопку мыши еще раз. Выбранная 
область будет выделена. При перемещении мыши вы обнаружите, что оригинал остался на месте, а 
дубликат перемещается вместе с курсором. Разместите копию с помощью левой кнопки мыши.
Вы можете отменить дублирование, щелкнув правой кнопкой мыши;

  (Rotate Block) – Повернуть или зеркально отобразить выбранную область дизайна. Поворачивается 
выбранная область и все соединения. Это позволяет легко исправить ошибку размещении компонента в 
неправильном положении. Для этого щелкните левой кнопкой мыши с одного края требуемой области, 
а затем переместите курсор в другой край, так чтобы охватить все элементы. После этого нажмите 
левую кнопку мыши еще раз. Выбранная область будет выделена, а в диалоговом окне Block Rotate 
Tool Options будут предложены варианты. Чтобы 
повернуть блок по часовой или против часовой стрелки, 
нажмите на кнопку << или >>. Кнопка Flip зеркально 
отразит выбранный блок.
После завершения вращения блока, нажмите левую или 
правую кнопку мыши.

Панель инструментов Editing

  (Edit) – Позволяет редактировать объекты проекта. Вы также можете использовать этот инструмент 
для перемещения и удаления объектов в проекте. После нажатия этой кнопки устанавливается режим 
редактирования и курсор принимает вид стрелки. Если теперь навести курсор на объект и щелкнуть 
левой кнопкой мыши, объект будет выбран для редактирования и окрасится в красный цвет. Свойства 
выбранного объекта можно редактировать в диалоговом меню Tool Options.
Удерживая клавишу Ctrl,   можно выбрать несколько объектов, щелкая по ним левой кнопкой мыши. 
Если объекты расположены вместе, то для их группового выбора удобнее нажать левую кнопку мыши 
и, удерживая её, обвести объекты прямоугольной рамкой выбора. Теперь, чтобы выбрать объекты в 
пределах прямоугольника, отпустите левую кнопку мыши. В отличие от одиночного объекта, свойства 
группы объектов не доступны для редактирования. 
Чтобы закончить редактирование объекта, щелкните правой кнопкой мыши в окне проекта или 
выберите новый объект для редактирования при помощи левой кнопки мыши.
Выбранные объекты можно перемещать. Для этого выберете объект, наведите на него курсор и, 
удерживая левую кнопку мыши нажатой, переместите курсор. Объект будет перемещен вместе с ним. 
Чтобы завершить перемещение, отпустите левую кнопку мыши.
Выбранный объект можно скопировать в буфер обмена, выбрав команду Copy в меню Edit на панели 
меню или в выпадающем меню Edit, которое вызывается щелчком правой кнопки мыши по 
выбранному объекту. После того как объект был скопирован в буфер обмена, его можно вставить в 
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другое приложение (например, Microsoft Word) или обратно в проект, при помощи команды Paste меню 
Edit;

  (Delete) – Удалить выбранные объекты или объект. Процедура выбора объектов характерна для 
интерфейса Windows и описана выше в топике для кнопки Edit;

  (Left) или Ctrl-L – Вращать выбранные объекты или объект против часовой стрелки. Процедура 
выбора объектов характерна для интерфейса Windows и описана выше в топике для кнопки Edit;

  (Right) или Ctrl-R - Вращать выбранные объекты или объект по часовой стрелке. Процедура 
выбора объектов характерна для интерфейса Windows и описана выше в топике для кнопки Edit;

  (Flip) или Ctrl-F – Отразить выбранные объекты или объект по горизонтали. Процедура выбора 
объектов характерна для интерфейса Windows и описана выше в топике для кнопки Edit;

  (Junction) или F3 – Установить соединение вручную. По умолчанию, соединения устанавливаются 
автоматически и их ручная установка не доступна. Чтобы включить ручную установку соединений, 
нужно открыть диалог Settings при помощи команды Options->Setting->Auto Wire settings и убрать 

флажок напротив Auto-place-junctions. Теперь, чтобы сделать соединение, нажмите кнопку , затем 
наведите курсор на то место, где вы хотите его разместить и щелкните левой кнопкой мыши. Чтобы 
завершить размещение выберите другой инструмент или щелкните правой кнопкой мыши. Соединение 
нельзя изменить, но его можно переместить или удалить;

  (Label) или F1- Присвоить имя цепи. Метка указывает к какой цепи принадлежит провод, 
проходящий по ней. Любые два провода с одинаковой меткой принадлежат к одной цепи и 
электрически связаны между собой. Использование меток может оказаться полезным, когда элементы, 
подключенные к одной и той же цепи, находятся далеко друг от друга на схеме или одна точка схемы 
должна быть соединена с большим числом других. Зачастую требуется указать инверсию над текстом 
метки. Это можно организовать путем размещения символа ` перед каждой буквой, которая нуждается в 
инверсии. Если целое слово должно иметь инверсию, то символ `  должен стоять перед каждой буквой 
слова. Ввод текста осуществляется в диалоговом окне Label Tool Options. По мере ввода текста, он 
будет появляться рядом с маленьким прямоугольником, символизирующим собой точку подключения 
метки. Переместите этот прямоугольник с помощью мыши, наведите его на требуемый провод и 
установите, нажав левую кнопку мыши. Если текст метки в конце имеет номер то, после размещения 
метки, этот номер автоматически увеличится. Ввод метки можно отменить, щелкнув правой кнопкой 
мыши. Метку можно изменить после размещения. Для этого щелкните левой кнопкой мыши по тексту 
метки. В результате появится окно Label Tool Options, в котором можно отредактировать текст метки. 
После завершения щелкните левой кнопкой мыши в пустой области проекта или нажмите правую 
кнопку мыши. Размер и пропорции текста метки можно редактировать, выбрав его, а затем при помощи 
ручек захвата (выглядят как маленькие квадратики) переместить стороны прямоугольника выбора, 
изменяя размер и пропорции текста;

  (No connect) или F5 – этот инструмент позволяет указать,  что символ, провод или элемент питания 
не подключен ни к чему иному и не должны быть связаны ни с чем. В противном случае, если какой-то 
вывод символа компонента будет не подключен, после проверки правил проектирования будет 
генерироваться сообщение об ошибке. Чтобы избежать этой ошибки, отмечайте любые неиспользуемых 
выводы, указывая, что они не подключены намеренно. Чтобы отметить не подключенный вывод, 
выберите этот инструмент, затем переместите его указатель на требуемое место в проекте и щелкните 
левой кнопкой мыши. После завершения размещения выберите новый инструмент или щелкните 
правой кнопкой мыши. Знак отсутствия соединения нельзя изменить, но можно переместить или 
удалить;

  (Power) или F4 - Используется, чтобы показать 
цепи питания в проекте. Все объекты питания должны 
иметь название, соответствующее их напряжению 
(например, 5V , GND, 0V и т.д.). Объекты питания с 
одинаковым названием считаются соединёнными друг 
с другом, даже если они представлены разным 
внешним видом. Некоторые символы автоматически 
подключаются к источнику питания без видимого соединения (например, 7400, даже в отсутствии 
видимого подключения, автоматически подключается к VCC и GND). При использовании таких 
символов , вы должны убедиться, что используете те же названия цепей питания, какие указаны в 
символах. В противном случае символ будет не правильно подключен к источнику питания. Размещать 

объекты питания в вашем проекте , выберите  на панели инструментов. Затем в диалоговом окне 
Power Tool Options выберите ориентацию объекта питания, его форму и имя. Затем разместите объект 
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питания,  щелкнув левой кнопкой мыши. Обеспечивается широкий диапазон форм объектов питания (5 
видов). Кроме этого вы можете использовать любое название. Над буквами названия можно указать 
инверсию, подобно тому, как это делается для текста и меток. Т.е. путем размещения символа ` перед 
каждой буквой, которая нуждается в инверсии. После размещения объектов питания щелкните правой 
кнопкой мыши или выберите новый инструмент. Объект питания можно изменить после размещения. 
Для этого щелкните по нему левой кнопкой мыши. В результате появится окно Power Tool Options, в 
котором можно изменить его название, ориентацию и форму. После завершения щелкните левой 
кнопкой мыши в пустой области проекта или нажмите правую кнопку мыши. Объект питания можно 
переместить или удалить.

  (Wire) или F2 – провод используется для осуществления электрических соединений в схеме. Если 
вы хотите использовать такие функции, как проверка правил проектирования или формирование списка 
соединений,  использовать провода для осуществления соединений в схеме. Если же вы, для 
соединений точек на схеме, используете ломаные линии вместо провода, то эти инструменты работать 
не будут! Щелкните левой кнопкой мыши в том место, где вы хотите начать провод. Перемещайтесь 
туда, где вы хотите его закончить и ещё раз щелкните левой кнопкой мыши. После этого сегмент 
провода будет размещен и новый сегмент будет начат с последней точки. При желании вы можете 
тянуть провод вместо того чтобы щелкать и перемещать. В этом случае просто тяните провод левой 
кнопкой мыши от начальной точки до конечной. Если конечная точка представляет собой вывод 
символа, провод или объект питания, провод будет автоматически привязан к нему и оборвётся в этой 
точке. Находясь поблизости, провод будет автоматически привязываться к выводу символа или другому 
проводу. Если в этот момент щелкнуть левой кнопкой мыши, провод подключится и оборвётся. Вы 
можете отключить эту функцию при помощи диалога в меню Options. При касании, повод будет 
автоматически подключаться к символу или другому проводу. Чтобы остановить прокладку провода и 
начать её с новой точки, нажмите правую кнопку мыши. Повторный щелчок правой кнопкой мыши 
вызовет контекстное меню Edit. Обычно провод изменяет направление под углом 90º. В этом режиме 
два отрезка провода отображаются одновременно. Тем не менее, только один сегмент будет размещён 
после щелчка левой кнопкой мыши. Вы должны щелкнуть еще раз, чтобы расположить оба сегмента 
провода. Провода нельзя изменить, но можно переместить или удалить.

 (Zoom) или Z - позволяет увеличить внешний вид проекта. После выбора этого инструмента, вы 
можете  увеличить размер изображения, щелкнув левой кнопкой мыши , или уменьшить его, щелкнув 
правой кнопкой мыши. При увеличении масштаба, положение курсора определяет будущий центр окна.

Совет - Используйте колесо прокрутки для изменения масштаба отображения
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ПАЯТЬ ПРОСТО
МЫ ПОКАЖЕМ КАК ЭТО ДЕЛАТЬ

МИТЧ АЛЬТМАН

(делился опытом)

ЭНДИ НОРДГРИН

(рисовал комикс)

ДЖЕФФ КИЙЦЕР

(верстал)

распространять всюду!

переводил МИХАИЛ САННИКОВ

http://mightyohm.com/blog/2011/04/soldering-is-easy-comic-book/
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УМЕНИЕ ПАЯТЬ
ЭТО КРАЙНЕ ПОЛЕЗНЫЙ НАВЫК.

кроме того, ЭТО ПРОСТО!
правда, правда

пайка это еще и ИНТЕРЕСНО!

если вы научитесь паять, то СМОЖЕте
ДЕЛАТЬ С ЭЛЕКТРОНИКОЙ ВСЕ.

а это уже само по себе круто.

есть много способов и техник пайки. расскажу,
как это делаю я.

ПОЕХАЛИ!

ЭТО ПАЯЛЬНИК.
его жало нагревается достаточно для 

того, чтобы расплавить приопой 

(который, вообще-то, является металлом)

это около 200 градусов

СОВЕТ 1 (из 3х):
не хватайте раскаленное жало 
голыми руками. ничем хорошим 
это не закончится.

в цен
тре ча

сто б
ывает

 

полос
ть с к

анифо
лью

(это д
ревес

ная с
мола

 схож
ая 

с той
, кото

рую испо
льзую

т для 

натир
ания 

смычк
ов ск

рипок
)

ЭТО ПРИПОЙ.
чаще всего он состоит из сплава олова и свинца.

Stannum (Sn) и Plumbum (Pb)

мы используем паяльник чтобы плавить 
припой и соединять токопровоядщие 
элементы.

когда припой нагревается, 
канифоль в нем начинает 
плавиться.

то же самое 
чуть позже 
происходит и с 
самим припоем

канифоль наносится на детали 
которые требуется спаять. она 
очищает их, тем самым позволяет 
соединить более качественно.

наилучший припой для электроники

канифоль и состоит на 60% из олова, а на 
40% из свинца.

содержит

известн
ую как 

“флюс”

существуют т.н. “бессвинцовые” припои. они содержат 
токсичные химические соединения и их не так легко 
использовать, как свинцовые. бессвинцовые припои быстрее 
портят жало вашего паяльника. если вы вынуждены 
использовать бессвинцовый припой, то не вдыхайте 
возникающие во время пайки пары.

СОВЕТ 2 (ИЗ 3Х):

свинец ядовит. Он попадает на 
кожу когда вы контактируете с 
припоем, поэтому мойте руки после 
того как закончили паять!

если вы не будете мыть руки после пайки, свинец может 
проникнуть в ваше тело где будет оставаться в мозгу до 
конца вашей жизни. если его скопится достаточно, то вы 
сойдете сума и потеряете всех ваших друзей. поэтому по 
окончании пайки вымойте руки! и берегите своих друзей.
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любое электрон
ное устр

ойство

состоит 
из элект

ронных к
омпонент

ов 

соединенных в
месте.

для того чтобы устройство работало правильно, 
мы должны обеспечить контакт там, где 
он необходим и исключить его там, где 
его быть не должно.

есть много способов соединить электронные 
компоненты друг с другом. самый простой 
из них -- печатная плата

“печатка”, 
или 

просто

“плата”

Печатная плата 
обеспечивает 
простое соединение 
компонентов за 
счет контактных 
площадок для 
каждого из них

если вы внимательно посмотрите на любую 
плату, то увидите линии соединяющие одни 
контактные площадки с другими. эти линии 
называются дорожками.

все электронные компоненты имеют 
собственные контакты:

такие контакты называют выводами 
или ножками

у большинства контактных площадок есть отверстие в 
центре. в это место продеваются выводы компонентов 
обеспечивая тем самым соединение с платой.

если вы проденете все выводы компонентов 
в нужные отверстия и при этом 
обеспечите их правильную ориентацию, 
а так же качественный монтаж при помощи 
паяльника и припоя,

некоторые можно 
запаять задом 

наперед!

то ваше электронное устройство заработает! 
все благодаря тому, что теперь контакт есть там, где 
он должен быть и при этом его нет там, где его быть 
не должно.

настало 
время чт

о-

нибудь спаять
!
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начнем с резистора.

резисторы имеют два вывода и (в отличие от таких 
компонентов, как диоды у которых различают “плюс” и 
“минус”) нет никакой разницы, какой из выводов на какую 
площадку вы припаяете.

на печатных платах чаще всего есть подсказки, которые 
объясняют, какую деталь куда устанавливать и нужно ли 
ее ориентировать.

из-за того что слово “resistor” начинается с “r”, на 
печатных платах используют именно эту маркировку для их 
обозначения и цифру для нумерации. например “r3”

для того чтобы припаять резистор, сначала нужно найти 
тот, который обеспечивает сопротивление, указанное в 
описании проекта над которым вы работете.

теперь согните две 
ножки резистора почти 
у самого его корпуса:

проденьте их сквозь 
плату в отверстия 
контактных площадок.

вам нужно установить резистор 
так, чтобы он плотно прилегал к 
поверхности платы

(иногда для этого нужно 
аккуратно потянуть за 
ножки с обратной стороны 
платы)

в большинствее случаев компоненты устанавливаются 
через отверстия с верхней стороны платы (той, на которой 
напечатаны подсказки) и припаиваются к нижней.

теперь нужно перевернуть плату, для того чтобы мы могли 
припаять ножки к площадкам.

когда будете переворачивать 
плату, вам придется придерживать 
резистор пальцем, для того чтобы 
он не выпал из отверстий.

затем с обратной стороны платы нужно 
разогнуть ножки примерно на 45 градусов. 
это позволит компоненту оставаться на 
месте, когда вы будете его паять.

ПОЛУЧИЛОСЬ? ОТЛИЧНО!

как я уже говорил, паяльник 
нагревается достаточно сильно, для 
того чтобы расплавить металл. из-за 
этого раскаленное жало начинает 
очень быстро окисляться. если проще, 
то при включенном паяльнике оно 
становится грязным просто 
находясь на воздухе!

появляющиеся на жале окислы плохо 
проводят тепло, поэтому их нужно 
удалять с жала прежде, чем вы 
соберетесь что-то запаять. без них 
жало будет равномерно распределять 
тепло, а качество и удобство 
пайки станут гораздо выше.

вот почему нам необходима влажная губка:
для удаления окислов с жала достаточно 
просто аккуратно вытереть его о губку, 
периодически поворачивая.

после того, как жало приобретет серебристый цвет и, 
возможно, даже заблестит, можно начинать паять. не 
забывайте чистить жало перед пайкой каждого 
компонента! (оно действительно быстро окисляется)

когда жало сияет и блестит, оно обеспечивает 
качественную пайку.

ТЕПЕРЬ ДАВАЙТЕ ПАЯТЬ!

возьмите паяльник в руку так, как 
вы держите шариковую ручку.

другой рукой возьмите проволоку припоя.
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прикоснитесь очищенным жалом 
одновременно к контактной площадке 
и ножке компонента, который хотите 
припаять.

удерживайте паяльник в таком состоянии 
около секунды. таким образом, все 
спаиваемые части хорошенько прогреются.

затем подайте 1-3 мм. 
припоя под жало.

не нужно подавать припой на жало сверху, иначе 
весь он на нем и останется. мы добиваемся 
того, чтобы припой равномерно растекся по 
контактной площадке и ножке резистора,
обеспечив тем самым их качественное соединение.

(printed circuit board, или “печатная плата”)

припой не будет плавиться, до тех пор пока не коснется 
раскаленного жала. зато сразу после этого у вас 
появится возможность быстро растопить от 1 до 3 мм.

теперь уберите припой.

очень важно после подачи припоя задержать 
жало на контактной площадке еще примерно 
на секунду. за это время припой сам равномерно 
распределится по контактной площадке и ножке резистора.

теперь уберите паяльник и визуально проверьте вашу 
идеально ровную пайку.

ВИДИТЕ, КАК ПРОСТО!

имейте ввиду, что припой застывает очень быстро. 
на это уйдет буквально секунда, после чего вы сможете 
перерйти к следующей точке пайки.

дым, который вы 
видите во время 
пайки, это испарения 
канифоли.

они содержат 
химические соединения 
вдыхать которые не 
желательно.

вы можете аккуратно дуть 
на плату во время пайки, 
чтобы эти испарения не 
попали в ваши легкие.

если вы 
пользуетесь 
бессвинцовым 
припоем, то 
испарения будут 
более опасными. 
обязательно 
работайте с ним 
только в хорошо 
проветриваемых 
помещениях и не 
вдыхайте дым.

теперь можно убрать паяльник обратно в 
подставку.

кое-кто утверждает, что веселье заканчивается, когда 
паяльник падает вам на колени. подставка позволяет 
безопасно и надежно держать раскаленный паяльник 
на столе.
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как же в итоге отличить 
хорошую пайку от 
плохой?

пайку можно назвать 
хорошей, если припой 
полностью покрывает 
контактную площадку 
и обтекает ножку со 
всех сторон.

а еще 

застыв
ший 

припой
 

образу
ет 

ровный
 

бугоро
к.

если на запаянной 
площадке виднеется 
сквозное отверстие или

спайка получилась 
слишком плоской

значит вы подали недостаточно 
припоя, для того чтобы обеспечить 
качественное соединение.

если это произошло, просто повторите всю процедуру 
(вычистите жало, прогрейте компоненты в течение секунды, 
подайте пару миллиметров припоя и подержите жало еще 
секунду, дав тем самым припою растечься) и проблема 
исчезнет.

если вы подали слишком много припоя, то, 
скорее всего, над контактной площадкой вместо 
бугорка образовалась целая гора, которая 
перетекла на плату и могла задеть другую 
контактную площадку. а это значит, что 
контакт появился там, где его быть не 
должно. такое случается.

в этом случае просто нагрейте образовавшуюся шишку, 
поместив жало между спаявшимися площадками и 
расплавьте скопившийся там припой

затем резко стукните платой по столу так, 
чтобы расплавленные излишки припоя просто скатились 
с нее.

спайка должна пропасть. если после 
этого на плате останутся капли 
застывшего припоя их можно убрать 
ногтем.

для этого пригодятся защитные очки

на са
мом д

еле м
ежду изб

ытком
 

припо
я на 

конта
ктных

 площ
адках и

 

его не
достат

ком е
сть ог

ромны
й 

запас
 удовлет

ворит
ельны

х 

вариа
нтов. 

это о
дна из

 прич
ин по

 

котор
ым па

ять пр
осто.

качественно 
запаяны!

эти тоже 
ничего.

некоторые любят запаивать сразу несколько 
компонентов после того, как установили их в плату.

я предпочитаю устанавливать и запаивать по 
одному компоненту за раз. это проще, 
чем юлить паяльником между частоколом 
ножек и выводов.

кроме того, так у меня меньше 
шансов пропустить ножку и забыть 
ее запаять.
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после того, как вы запаяли все выводы 
компонента, настало время удалить 
излишки.
это необходимо для того, чтобы торчащие 
выводы не загибались и не контактировали 
с другими выводами, деталями или 
плошадками.

если это произойдет, то контакт 
появится там, где его быть не 
должно. помните?

для того чтобы избавиться 
от выводов, мы используем 
малые кусачки.
одна их сторона имеет плоскую, 
хорошо заточенную кромку, 
а другая -- глубокий паз.

держа заточенной стороной вниз, поднесите 
кусачки к выводу, прицелившись чуть выше 
бугорка припоя. сожмите ручки и режущие 
кромки с щелчком перережут ножку...

которая 
моментальн

о 

превратитьс
я 

в снаряд 
прямиком 
летящий вам 

в глаз!

совет 3 (из 3х): всегда 
придерживайте откусываемый вывод 
одной рукой.

если откусываемый вывод слишком короткий, для того чтобы 
за него можно было взяться, но при этом слишком длинный, 
чтобы его оставлять на плате,
то после того как вы 
прицелитесь кусачками, 
просто накройте его 
ладонью

и кусайте.

это позволит уберечь ваши и чужие глаза и при этом сохранить весь мусор в одном месте.

для
 это

го 

при
год

ятс
я защитные очки

если это станет привычкой, вы всегда будете в безопасности

существуют компоненты (например, микросхемы, 
или кнопки) чьи выводы настолько коротки, 
что их не требуется откусывать.

не бойтесь ошибаться. все ошибки 
можно исправить (просто некоторые 
исправить сложнее, чем другие).

на своих ошибках мы учимся.

и если припаивать компоненты просто, то для 
того чтобы их выпаивать обратно 
нужно много практиковаться. 
совершая ошибки во время пайки, вы получите 
эту практику.
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чем больше вы будете паять, тем быстрее 
овладеете разными трюками и приемами, 
которые значительно упростят для вас 
процесс.

тем не менее, почерпнув 
знания из этого комикса, 
прямо сейчас вы уже 
готовы к тому, чтобы 
паять что угодно!

если вам понравилось паять и вы намеряны 
продолжать, то наверняка захотите купить хорошие 
инструменты. но вам не обязательно тратить 
на них кучу денег.

вы можете купить хороший 
паяльник примерно за 
600 рублей.

а подставка для 
него с держателем 
губки и самой губкой 
обойдется вам 
примерно в 250

если вы всерьез задумали увлечься пайкой, просто 
собираетесь много паять, или планируете паять по-
настоящему мелкую электронику,
то, вероятно, вам приглянется приличная паяльная 
станция (в которой уже есть подставка и губка). такая 
будет стоить в районе 1 500 рублей.

еще вам понадобятся 
хорошие кусачки, 
которые стоят 200
рублей.

500 грамм хорошего припоя 
в катушке обойдутся примерно 
в 500 рублей. этого количества 
вам хватит на долгие годы.

я бы
 рек

омен
дова

л 

испо
льзо

вать
 оло

вянн
о-

свин
цовы

й пр
ипой

 

соот
ношение

м 60/40 с 

доба
влен

ием 
кани

фоли
.

вот, в общем-то, и все, что вам нужно
возможно, вам так же окажутся полезны длинногубцы (около 200 р.), 
стрипперы для зачистки проводов (300 р.) и защитные очки (100 р.)

распространять всюду!

делился опытом митч альтман
http://cornfieldelectronics.com

рисовал комикс энди нордгрин
http://log.andie.se

верстал джефф кийцер
http://mightyohm.com

переводил михаил санников
http://pixelkit.ru
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Митч Альтман,  

Джефф Кийцер 
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